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1 About this Book

This book describes various configuration settings and tasks that make an
openCRX administrator's life easier.

openCRX is the leading enterprise-class open source CRM suite. openCRX is
based on openMDX, an open source MDA framework based on the OMG's
model driven architecture (MDA) standards. This guarantees total openness,
standards compliance, a state-of-the-art component-based architecture, and
virtually unlimited scalability.

1.1 Who this book is for

The intended audience are openCRX administrators.

1.2 What you need to know with this book

This book describes some of the settings and configurations an openCRX
administrator can use to control the behavior of openCRX.

1.3 Tips, Warnings, etc.
We make use the following pictograms:
Information provided as a “Tip” might be helpful for various reasons:

time savings, risk reduction, etc. - it goes without saying that we
L advise to follow our guides meticulously.

meticulous \muh-TIK-yuh-luhs\, adjective:
Extremely or excessively careful about details.

You should carefully read information marked with “Important”.

Ignoring such information is typically not a good idea.
Imporiant

Warnings should not be ignored (risk of data loss, etc.).

W
arninn
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2 Prerequisites

This guide assumes that you have access to a properly installed instance of
openCRX 2.12.0 (for installation instructions, please refer to the guides
available from http://www.opencrx.org/documents.htm).

You can either follow the openCRX Server Installer documentation
(http://www.opencrx.org/server.htm) or you can do a manual installation of
openCRX following the installation guide for TomEE.



http://www.opencrx.org/server.htm
http://www.opencrx.org/documents.htm
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3 Security

In this chapter we will present a high-level overview of openCRX security and
discuss a few important issues.

We do not recommend learning about security with mission critical
"'} data. Backup your data before you make changes if you are not

Waminu  certain what the consequences are! The risk of you being locked out
is real and the resources required to fix broken security settings
can not be overestimated!
The default settings should work for virtually all users; the probability
of getting yourself into trouble by changing default settings should
not be underestimated. Read and understand at least the basics
of openCRX security BEFORE you make any changes.

3.1 Introduction

3.1.1 Basic Concepts and Conventions

e Each “real user” is represented by a Subject (e.g. "Guest”). Subjects are
managed by the openCRX Root administrator (admin-Root).

e Each subject has an Application Login Principal (also called login id).
Application login principals are managed by the openCRX Root
administrator (admin-Root).

e Each application login principal is assigned to a subject (e.g. principal
“guest” is assigned to subject “"Guest”) and allows a “real user” to login.

e A “real user” can have one or more additional segment login principals.
The Segment Login Principal has typically the same name as the
application login principal (e.g. “guest”) and grants a “real user” login
access to a segment. Segment login principals are managed by openCRX
segment administrators (e.g. admin-Standard for the Segment
Standard).

e Each “real user” who has access to a segment (i.e. has a segment login
principal) has (in addition to the segment login principal) a segment user
principal, e.g. “guest.User”. The Segment User Principal is required to
assign objects to an Owning User. Each “real user” also has a Principal
Group, e.g. “guest.Group”.

e Each segment has a corresponding realm to manage Principals:
The application login principals are stored in the realm Default.
The segment login principals for segment <segment name> are
stored in the realm <segment name> (e.g. principals for the segment
Standard are stored in the realm Standard).
Each segment has a segment administrator principal
(admin-<segment name>) (e.g. admin-Standard for the segment
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Standard).

The following figure shows the situation after the initial setup of openCRX
(assuming you installed openCRX Server or followed the installation guide for
Tomat 6):

Security Realms

LR R B
L

Default (Login Realm) Root Standard

Administrators Administrators Administrators

Users Users Unassigned
Unspecified
sers

Login Principals Login Principals

grant acoess o grant acoess o
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Ml cp=nCRY Application Segment Root Login Principals

. . . grant access o

. admin-Root admin-Root Segment Standard
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: I |

. guest | I guest I guest
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. User Principals

L]

. == admin-Root. User User Principals
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L

. I guest.User | guest.User
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L] 1 _l------------------------
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. Subjects ot

. L L]
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: 2
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: 3!
[} 1}

. | e
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. | Guest s
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Figure 1: Security Realms, Principals and Subjects after Initial Setup

Summarizing the above:

e there is a realm for each segment (e.g. a realm Standard corresponding
to the segment Standard)

e the realm Default acts as login realm; it contains all principals who are
allowed to login to the openCRX application; PrincipalGroups in this
realm are only used to configure Granted Roles by inheritance (in
addition to configuring them directly in the appropriate grid).

e there is a subject for each “real user” and all principals of a user are



http://www.opencrx.org/opencrx/2.4/tomcat-6/openCRX_Installation_Tomcat-6.html
http://www.opencrx.org/opencrx/2.4/tomcat-6/openCRX_Installation_Tomcat-6.html
http://www.opencrx.org/server.htm
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assigned to the same subject; this allows openCRX to find all principals
of a user (--> role selection drop down)

The segment administrator (e.g. admin-Standard) creates principals and User
home pages with the operation createUser():

e Each segment login principal has a home page in the corresponding
segment (qualifier of principal and home page must match!).

e Each segment login principal is correlated with a contact. This correlation
is for example required to find all activities and contracts assigned to the
logged in principal.

Realm Standard User Homes Contacts

Principal Groups

Login Principals

grant acosss o
Segment Standard

guest | JLIEST - Guest
User Principals

Realm XYZ User Homes Contacts

Principal Groups

Login Principals

grant acoess o
Segment Standard

il il
joe == e +=r2=| Toe Dios
User Principals

Figure 2: Segment Administration

managed by Administrator

of Segment XYZ

While each “real user” (typically) has 1 application login principal only, “real
users” may have multiple segment login principals (e.g. because a “real user”
is allowed to access multiple segments or because a “real user” is allowed to
access a particular segment in different roles like Head of Sales or CFO).

Available segment login principals are listed in the so-called Role Drop Down:
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Role Drop Down with

Application Login Principal Segment Login Principal(s)

.guest
guesti@Standard '.—

guesti@Standard %
admin-Standardi@Standard

opencrx

Figure 3: Role Drop Down with list of available Segment Login Principals

3.1.2 Permissions / Access Control

The openCRX security framework makes a clear distinction between
Ownership Permissions (permissions granted on a particular object) and
Model Permissions (permissions granted on a particular model element). As
the latter are not implemented (yet) we only talk about Ownership Permissions
in this guide.

Ownership permissions are used to control browse/delete/update access to
openCRX objects by Users and UserGroups (i.e. Ownership access control).
Every openCRX object is a SecureObject. The following figure shows an extract
from the UML model (if you are interested in all the details and the formally
correct and complete specifications you should refer to the latest openCRX UML
models):



http://www.opencrx.org/documents.htm#Doclatestuml
http://www.opencrx.org/documents.htm#Doclatestuml
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= SecureObject
secureObject owningUser B Usmer
I owner : string
o accesslevelBrowse : code [0.4 SecureObjectHasOwningUser [0.1]
= accessLevellpdate : code ®
= accessLevelDelete : code
& setOwningUser( inout in : SetOwningUserParams ) : ModifySecureObjectResult
& addOwningGroup( inout in : ModifyOwningGroupParams ) : ModifySecureObjectResult secureObject owningGroup =
@ removeOwningGroup( inout in : ModifyOwningGroupParams ) © ModifySecureObjectResult = PrincipalGroup
@& removeAlOwningGroup( inout in : RemeveAllOwningGroupParams ) © ModifySecureObjectResult
& setAccesslevell inout in: SetAccesslevelParams ) : ModifySecureObjectResult [0.4 SecureObjectHasOwningGroup [0.1
& checkPermissions( in : CheckPermissionsParams ) : CheckPermissionsResult
@ replaceOwningGroup( in : ModifyOwningGroupsParams ) : ModifySecureObjectResult
owner[0]: name of object owner Read access to an object and object creation requires sufficient
owner[1]: name of primary group access levels granted by the accessLevelBrowse and
accessLevellpdate of the parent object. Typically the access levels
Storing the owner names in a list allows efficient queries of the form 'owner IS_IN [<=owne! are retrieved from the direct composite parent. An implementation
name:=, <group names=J. should allow to configure the parent object which grants the access
(level -1, level - 2, ). The reference accessGrantedByParent points
accessLevel to the parent object used to determine
0-NA accesslevelBrowse and accesslevelUpdate.
1 - private
2 - basic (all users member of primary group)
3 - deep (all users member of primary group recursively)
4 - global
mode:
0 - local
1 - recursive =] Q =] [ @ @ = S A =T e R |

referenFitter:
list of reference names. If list is empty all composite referenced objects are processed.

Figure 4: openCRX UML Model - Class Diagram SecureObject

If you see N/P in a reference field instead of a more meaningful
value you probably do not have browse access to the respective

T object (N/P stands for No Permission)
If you see N/A in a reference field instead of a more meaningful
value the object cannot be retrieved (N/A stands for Not Available);
Tin

maybe the object was deleted or the respective provider is not
accessible/available.

The most important security attributes of an object X are discussed below:
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e Owning User: this user "owns" object X; the Owning User can always
browse/delete/update object X (unless the access level is set to 0 [in
which case nobody has access — probably not a desirable situation]).

e Owning Groups: these groups might enjoy privileged treatment for
browsing/deleting/updating object X depending on the relevant access
level settings.

e Access Granted by Parent: this attribute is set by configuration and
refers to the parent object that grants access to object X.

e Browse Access Level: this setting determines which users/user groups
are granted browse access to direct composite objects of object X [i.e.
who can view/inspect direct composite objects of object X (including all
their attributes)].

It is a common misconception that browse access level of an
object X controls browse access to this object X - please read
T the above definition carefully!

e Delete Access Level: this setting determines which users/user groups
are granted delete access to object X and all its composite objects
(recursively!) [i.e. who can delete object X and all its composite objects
(recursively!)].

e Update Access Level: this setting determines which users/user groups
are granted update access to object X [i.e. who can change object X; this
includes adding composite objects to object X].

Eanars Charts | | Options 5]'51—:!'1'
F;rltiry: #rizifopenmds:org.opencry. kernel. home 1/ provider/C R segmentf $tandard/userH ome/admin- Standard
:T*r;ate: at: 322008 6:14:34 AM Modified at: WZH 008 6:49:50 PM
Created by admin-Root Modified by admin-Standard
Fhrlr; user: admin-5Standard.User Browse acoess level: [3] deep [group members recursively)
Access granted by parent:  User HGHEP!QEE' Updste scocess level [#] basic [group members)
Delete scocess level [2] basic (group members)
cat Owning Groups
L |:| Namsa = Uisar Group = Disabied = Dsscription = Mamiber of Principal Groups = Grantsd Roks =
I Administrators Standard\WAdministrators Unspecified

Figure 5: System attributes of an openCRX object as shown in the GUI

The following access levels are available to control which users/user groups
are granted permission to browse/delete/update a particular object X:
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Access Level

0 - N/A

1 - private
2 - basic
3 - deep

4 - global

Meaning
Nno access
access is granted if the user is owning user of object X

access is granted if at least one of the following conditions is
true:

(@) the user is owning user of object X
(b) the user is member of any of the owning groups of object X

(c) any of the owning groups of object X is a subgroup** of
any group the user is member of

access is granted if at least one of the following conditions is
true:

(@) the user is owning user of object X
(b) the user is member of any of the owning groups of object X

(c) any of the owning groups of object X is a subgroup** of
any group the user is member of

(d) any of the owning groups of object X is a subgroup** of
any supergroup* of any group the user is member of

all users are granted access

* Owning group Gsyper iS @ supergroup of an owning group G if every user who
is member of G is also member of Gsyper

** 0Owning group Gsyw is @ subgroup of an owning group G if every user who is
member of Gsuw is also member of G

3.1.3 Default Principal Groups

The figure on the right shows the
openCRX default principal groups
and their memberships:

« Unassigned

e Public

e Administrators

e Users

. Unspecified I:l

Flgur'e 6: Default Prlnclpa/ Groups Legend: "A"is member of Principal Graup "B"

Unspecified
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3.1.4 The SQL approach to understanding security

If you are familiar with SQL, the following approach to understanding security
might be helpful. Let's put ourselves into the role of the AccessControl Plugin;
accessing an object (read mode) results in a SELECT statement as follows:

SELECT * FROM T WHERE owner IN (p1, p2, ....)
e owner is a column that is present in all (multi-valued) tables
XACCOUNT_, xADDRESS_, etc.) and it contains a list of principals who
are permitted to access the respective object in read-mode

e thesetP = {pl, p2, ...} is calculated by the AccessControl Plugin before
accessing the object and it corresponds to the principals who are
assigned to the current user based on the object's AccessLevel as shown
in the following table:

Access Level SetP = {p1, p2, ...}
0 - N/A P= {}
1 - private P= P

where

P, =  {all groups directly assigned to the principal p}
2 - basic P = Pp + Pupper

where
P, =  {all groups directly assigned to the principal p}

Puper = {all groups that contain at least one group
contained in P,}

3 - deep P = Pp + Pupper + Plower
where
P, = {all groups directly assigned to the principal p}

Puper = {all groups that contain at least one group
contained in P,}

Power = {all groups contained in Pypper}

4 - global the where-clause "WHERE owner IN (p1, p2, ....)" is not
required, i.e. the SELECT statement reduces to

SELECT * FROM T

You can mark PrincipalGroups as “"Base group” to better control the

: inclusion of PrincipalGroups with Access Level 3.
n
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3.2 Activating Security

Security (including Access Control) is not just a fancy add-on, rather it is an
integral part of openCRX; openCRX Access Control is always activated.

The openCRX security provider manages all security data and provides access
control services for all requests through the openCRX API. Hence, you can rely
on openCRX access control even if you write you own clients or adapters for
openCRX.

The only “hardening” you might want to do is the one described in the

. following chapter: set browse access level to 3 for non-Root segments.
n

3.3 Default Settings

Default access level settings for non-Root segments (e.g. segment Standard)
after a clean install are as follows:

Browse Access Level: 4 - global
Update Access Level: 3 — deep

Delete Access Level: 1 - private

OBJECT_IDr - | ACCESS_LEVEL_BROWSE = | ACCESS_LEVEL_UPDATE 2 | ACCESS_LEVEL DELETE =
accounts/CRM/Standard 4 3 1
activities/CR¥Standard 4 3 1
adming/CRx/FA oot

buildingz/CR*./Standard 4 3 1
codes/CRX/Root 4 2 2
codes/CRX/Standard 4 3 1
contracts/CRX/Standard 4 3 1
depotz/CR¥/Standard 4 3 1
docz/CRX/Standard 4 3 1
forecastz/CR¥/Standard 4 3 1
homez/CRX/Standard 4 3 1
models/CRx./Standard 4 3 1
products/CR¥AStandard 4 3 1
uomsz/CR/R oot 4 2 2
uomsz/CR/Standard 4 3 1
wiork floves/ CRx AStandard 4 3 1

Figure 7: Table OOCKE1_SEGMENT after default installation

Due to the setting access_level _browse = 4 (global) any user with access
to a particular segment is allowed to browse top level objects (i.e. any
user can browse all accounts, all activities, all documents, etc.).

These default settings are suitable for test environments and deployments in

smaller companies/teams with a generous access policy; for most real-world

applications, however, it is more appropriate to set access_level _browse = 3
(deep) for non-Root segments. You can do this by changing the values in the
column access_level_browse from 4 to 3 (table OOCKE1_SEGMENT).
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After this change, the table OOCKE1_SEGMENT will look as follows:

OBJECT_ID = | ACCESS_LEVEL BROWSE= | ACCESS_LEVEL_UPDATE = | ACCESS_LEWEL DELETE =
accounts/CRF/Standard 3 3 1
activities/CR*/Standard 3 3 1
adminz/CR*/Root

Figure 8: Table OOCKE1_SEGMENT after modification

Segment security settings are loaded during the initialization of the
openCRX servlet. Hence, if you change settings you must redeploy

Imporiant o CRX for the new settings to become active.

3.4 Security Settings of New Objects

New objects are by default created with the following security settings:

Browse Access Level: 3 - deep
Update Access Level: 2 - basic
Delete Access Level: 2 - basic

Access Granted by Parent in general: Parent object as modeled

exceptions: there are some select exceptions, but
they are all pre-configured

Owning User: User who is creating the object

Owning Groups: Primary User Group of the user who is
creating the object and (meaning as well as)
Owning Group(s) of the parent object of the
new object (except Users, see below).

Please note that the User Group Users (e.g. Standard\\Users) is not
added to the list of Owning Groups of newly created objects unless

mportant  +he creating user's Primary User Group is equal to Users.

By default, a user's primary user group is <user>.Group. This group
is created automatically when the segment administrator runs the
wizard User Settings from a user's homepage (see chapter 4.1
Creating Users — Overview).

Imporiant

Please note that a User's Primary User Group can be set by the
segment administrator with the operation Create User . To change an
existing user's primary group, the segment administrator simply
executes the operation Create User again with a new parameter for
primary user group.

Imporiant

In the context of activity management there are various operations
that set/change the Owning Groups of objects based on the settings
of an assigned Activity Creator or assigned Activity Group and not
based on the settings of the user who executes the operation.
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3.5 Checking Permissions

You can check security permissions on any SecureObject with the operation
Security > Check Permissions. Provide the principal name as a parameter. The
following figure shows the result of the operation on a user's homeage:

My Homepage @ Accounts  Activities Pipeline » |
) @ User Homepages - Guest, Joe O - My Homepage

File Edit Find View Actions Security Wizards

Has read permission:
Has update permission:
Has delete permission:
Membership for read: *

Membership for update:  Standardiguest.User
Standard:guest

Membership for delete: Standard:guest.User
Standardiguest

Figure 9: Result of Check Permissions

The meaning of the above result is as follows:

Has read permission: principal can browse this object
[] principal cannot browse this object
Has update permission: principal can modify/update this object
[J principal cannot modify/update this object
Has delete permission: principal can delete this object
[] principal cannot delete this object
Membership for read: principal has read permission if the intersection of

the resulting list of groups and the list of owning
groups of the respective SecureObject is not
empty

Membership for update: principal has modify/update permission if the
intersection of the resulting list of groups and the
list of owning groups of the respective
SecureObject is not empty

Membership for delete: principal has delete permission if the intersection
of the resulting list of groups and the list of

owning groups of the respective SecureObject is
not empty
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3.6 Login Procedure

The openCRX login procedure consists of 2 levels:

3.6.1 Apache Tomcat / Application Server Login

The Apache Tomcat / application server login procedure depends on various
parameters:

e Servlet container (Apache Tomcat, JBoss, BEA WLS, IBM WAS, etc.)
e configuration of Apache Tomcat / application server

m file-based realm (e.g. tomcat-users.xml for Tomcat)

m DB-based realm (e.g. DataSourceRealm Tomcat)

m LDAP-based realm (e.g. INDIRealm for Tomcat; see also chapter 18.4
Tomcat w/ openCRX and LDAP-based Authentication)

m company-specific / custom-tailored realms

Please note that even though openCRX might be involved in managing some of
the above-mentioned realms (e.g. DB-based realm) the login procedure is not
really under control of openCRX. As a consequence, many login problems are
related to incomplete/faulty configuration settings of the servlet container.

Detailed documentation about the many Realms supported by Apache
Tomcat is available at
Tio http://tomcat.apache.org/tomcat-7.0-doc/realm-howto.html

3.6.2 Segment Login

Access to segments is managed/controlled by the ObjectInspectorServiet. The
included DefaultRoleMapper identifies all Segment Login Principals of a given
Subject and grants access to the respective segments through the Role Drop
Down:

Role Drop Down with

Application Login Principal Segment Login Principal(s)

I.guest
guesti@Sstandard '.—

guesti@Standard L\\S
admin-5Standardi@5Standard

Figure 10: Role Drop Down with list of available Segment Login Principals

opencrx

It is possible to deploy user-specific implementations of the DefaultRoleMapper
so that you can adapt the segment login procedure to your requirements.



http://tomcat.apache.org/tomcat-7.0-doc/realm-howto.html
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3.6.3 Disabling Login

Please refer to the chapter "Disable/Deactivate Users”.

3.7 Resetting Security

If you get the setting of Update Access Level wrong you may not be
) able to change the respective object from the GUI anymore (and that
Waminu  includes the security settings of that object!). For example, the only
way to recover from setting Update Access Level to 0 - N/A for a
particular object is to edit the data directly in the database!

It is simply not possible to disable openCRX Security.

If you (or one of your users) managed to screw up the security settings in a
major way you might be forced to reset all security settings to a well-defined
state. Not an easy task - and it typically involves a lot of manual work.

Educate your users about openCRX security. You might also consider
disabling some of the more powerful operations and/or security
T attributes in the default GUI.
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4 Managing Users

Read through the chapter Basic Concepts and Conventions (Security)
before reading this chapter. It is quite helpful to have a good

T understanding of the terms Subject, Application Login Principal,
Segment Login Principal, User, etc. before you start reading here.

4.1 Creating Users - Overview

Even though you can create users with a variety of methods, “behind the
scenes” the following steps are always required to create a new openCRX user:

Who Steps
Roo_t administrator e create a new Subject
admin-Root = set the qualifier to the desired login id

e create a new Principal in the realm Default

(--> Application Login Principal)

m set the qualifier to the desired login id

m link this Principal to the Subject created
in the previous step

m make this Principal member of the
appropriate Principal Group(s), e.qg.
Users

Segment administrator e create a new Contact

admin-<SegmentName>
e create a new User

m link this new User to the Contact
created in the previous step

m the Segment Login Principal is created
automatically

m the userhome is created automatically

e run the wizard Edit > User Settings from
the new user's homepage

Newly created user e run the wizard Edit > User Settings
(to create the user's private objects)

Depending on how you create a new user, some of the above steps might be
taken care of by a wizard. If you want to have full control over the user
creation process, however, then you can certainly create new users following
the above instructions step by step.

Have a look at Figure 1: Security Realms, Principals and Subjects after Initial
Setup and Figure 2: Segment Administration to see how this all fits together.
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4.1.1 Create Users as Segment Administrator

The Segment administrator can create new users with the following steps:
e Login as Segment administrator (e.g. admin-Standard)
e Create a contact for the new user

e Click on the (potentially hidden) tab [User Homepages]:

W Home Manage Accounts o Manage Activities | Bales =
M User Homepages > admin-Standard, - Home &3 products

1]
File Edit Find View Actions Security Wizards

*Contacts General Options System

Contact: admin-5tandard,
n
Alerts Reminders 7 z\":: Workflows
= . User Home
W a ES [0 E3 % E *a : page-s* 5

F]’guré 11: New user guest — step 1

 Next you select the operation Actions > Create User... which allows
you to create and initialize a new user:

M Home (1 Manage Accounts & Manage Activities | Sales =

W User Homepages

L
Edit WView Actions Security Wizards

Create User...
b arte ‘I"D:". -..d-E"i...hll
Figure 12: New user guest — step 2

o Type the new user's principal name (e.g. guest) into the field Principal
name, use the Lookup Inspector or the auto-completer to fetch values
for Contact and Primary user group (unless you have a good reason to
provide a user group, leave Primary User Group empty and openCRX will
automatically create a user group with name <principal name>.Group),
and then type a password (e.g. opencrx) into the fields Initial password
and Password again:

Create User b
Principal name: guest
Contact: guest, [guest,] Q,
Primary user group: Q,
Initial password: ~ seses
Password again: @~ ssses

OK || Cancel

Figure 13: New user guest — step 3
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o Status O indicates that the user guest was created without errors:

Status: 0
Status message:
Created UserHome: guest, [Edit]

Figure 14: New user guest — step 4

« Next we navigate to the homepage of the newly created user guest by
clicking on the icon as show below:

User Homes

bl =1 HOMEE Actions  View

Il _| Contact = Primary User Group = E-mail subject prefiz =
B Guest, joe O Users [CRY:Standard]

‘h“_ admin-Standard, Administrators [CRX:Standard)

Figure 15: New user guest - step 4

» Please note that we are still logged in as admin-Standard (as shown in
the header of the application), but we are looking at the homepage of
the user guest. Execute the operation Edit > User Settings:

admin-Standard@5Standard

opencrx

en_Us

D Home (1 Manage Accounts 4 Manage Activities %] Sales =
M User Homepages = Guest, Joe O - Home
1]
File Edit Find WView Actions Security Wizards
Edit

User Settings..

*Conta kJ General| Options || System *

i Manage Accounts
‘ ":‘:::“ = Contact: Guest, joa O

Fidu}e 1"6: New user guest — step 5
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Tin

This will start the wizard User Settings. You can configure various
settings with this wizard. At a minimum you should probably set the
timezone and enter the new user's e-mail address. Once you're done
you can click the button [Save]. The wizard will then create a bunch of
objects and finalize the initialization of the user guest:

User Home Subscriptions
Timezone:2‘9 Europe;’Zur?ch Y Is Active Creation ReNp?::}erno'lr‘l_nt Removal
UL EusnpeZusich h Account Modifications: o = = =
ztm: settings on logoff: - Activity Follow Up Modifications: o - - -
Sne-I:::I;ﬂaiI subject prefix: J[zig:;::n%:fde]ncmmg (B O e T o - - =
Web access URL: http://demo.opencrx.orgopencrx-core-CRX | Alert Madifications: ~ S = =

Root Menu Alert Modifications (Jabber): ] - = ]

Root Advanced Simple Alert Modifications (Twitter): - - - ]

Manage Accounts: ol o il Booking Modifications: ) o = -
Manage Activities: il il v Competitor Modifications: ! ] = -
Sales: v W 4 Compound Booking Modifications:  w/ = = =
Products: ;f‘ ;a‘ ;“ Invoice Modifications: i = = =
Depots: f o o Lead Modifications: il = = =
Folders & Documents: ol il v Opportunity Modifications: ) - - -
Buildings: !‘ il v Organization Modifications: v ] - ]
Budgets & Targets: = ! il Product Modifications: g‘ = = ]
UOMs: = of o Quote Modifications: i = = =
LUOMs (Root): = ) il Reminder Modifications (Alert): - - = o
Codes: =i ] SalesOrder Modifications: K - - ]
Workflows: : ;f ;‘ Timer Madifications (Alert): ] = -
User Homepages: - o o
Security Realm: = ! o
Security Policy: = o o
Show max items in top navigation: 4
Show top navigation sub-levels: o
Grid default alignment is wide: wf

Hide workspace dashboard:
Scroll header:

Save || Close

Figure 17: New user guest — step 6

Click [Cancel] to leave the wizard.

The wizard User Settings creates a user group <username>.Group,
in the above case guest.Group. The primary user group of the user
guest was automatically set to this new user group guest.Group.

If you want to change the primary user group to anything else or if
you ever must reset a user (lost password, etc.), you can re-execute
the operation Create User as admin-Standard at any time.

If you want to reset a user without changing the user's password, you
can simply leave the password fields empty when recreating the user.

Logoff as admin-Standard and login as the newly created user (guest in
our example)

Execute the operation Edit > User Settings and click [Save]. This time
(i.e. when executed by the newly created user) the wizard User Settings
creates various user-specific/private objects.
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4.1.2 Import Subjects and Application Login Principals

Creating large numbers of subjects/principals by hand can be quite a tedious
job. If you prepare a text file containing the appropriate information in the file
format as outlined below, the Root administrator (admin-Root) can use the

operation Actions > Import Login Principals to create Subjects and Application
Login Principals automatically.

0 e n c r admin-Root@Root Logaff admin-Root
X Root

p en_USs QO Save Settings

" Administration uomMs Codes &f Security Realm Security Policy Security Subjects

+ Administration

Edit Wiew Actions Wizards

Create / strator. ..
Import Login Principals..
*Workspaces L ions

Default o 3, HONE Mew Edit Actions WView

I Name = Description =

WarkflowController

Twitter

Figure 18: Operation Actions > Import Login Principals (admin-Root)

Listing 1: File Format Subjects and Application Login Principals

Subject;<subject name>;<subject description>

Principal;<principal name>;<principal description>;<subject name>;<groups>

Listing 2: Example File Subjects and Application Login Principals

Subject; joe;Doe, Joe

Subject;mark;Ferguson, Mark
Subject;peter;Lagerfeld, Peter
Principal;joe;Doe, Joe;joe;Users,Administrators
Principal;mark;Ferguson, Mark;mark;Users
Principal;peter;Lagerfeld, Peter;peter;Users
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4.1.3 Import Users

Similarly to importing Subjects and Application Login Principals from a file you
can also import Users from a file. If you prepare a text file containing the
appropriate information in the file format as outlined below, the Segment
administrator (admin-<SegmentName>) can use the operation Actions >
Import Users to create Users automatically.

M User Homepages

Edit WView Actions Security Wizards
*Contacts :

er Homes
-3

Qi
Manage Ac

3, HOMNE Actions  View

Contact = Primary User Group = E-mail subject prefix = Web access URL =
Guest, joe O Users [CRXE:Standard) http:/fdemo.opencri.on
3 M admin-Standard, Administrators [CRX:5tandard] http:/fdemo.opencri.on

Figure 19: Operation Actions > Import Users (admin-Standard)

Listing 3: File Format Users

‘User;<principal>;<account alias>;<account full name>;<primary group>;<password>[;<groups>[;<email>[;<timezone>]]]

Parameter Description
<principal> required, name of principal
<account alias> at least one value per user must be provided, i.e. either the alias name

<account full name> of the contact, or then the full name

<primary group> optional, default is <principal>.Group

<password> required, clear text value

<groups> optional, comma separated list of memberOf principal groups,
the user is made a member of each provided principal group

<email> optional e-mail address, e.g. joe@opencrx.org

<timezone> optional time zone, e.g. Europe/Zurich

Please note that a “-” value (a dash without the quotes) means empty in the
context of a user file. Example: if you don't want to explicitly define a primary
group, put a dash - the importer will then create the default primary group
<principal>.Group.

Listing 4: Example File Users

User;joe;JD;Doe, Joe;Users;2%3j0d.IT;MGMT, SALES
User;mark;Fergi;Ferguson, Mark;Users;maFeé&.3-;MGMT
User;peter;-;Lagerfeld, Peter;-;PlF*;ReGal;SALES

Contacts are not created automatically; existing Contacts are first
searched by <account alias>. If no matching account alias is found,
Contacts are search by <account full name>. If still no matching
account is found, the UserHome is not created.

Users are only imported/created if the referenced Principals exist.

Important
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4.2 Disable/Deactivate Users

There are various ways of disabling/deactivating users. To fully understand
your options it is helpful if you are familiar with the openCRX Login Procedure.

4.2.1 Disable Users at the level Tomcat /Application Server

Depending on the configuration of your application server you can disable
users at that level. For example, if you rely on file-based realms, you can
simply remove users from the file tomcat-users.xml (with Apache Tomcat) or
users.properties (with JBoss) to prevent access to openCRX. If you block
access at the level Tomcat / application server such users are locked out from
accessing any application and any openCRX segment. However, as the servlet
container's login procedure is not entirely controlled by openCRX you might
have to consult the documentation of your respective servlet container (e.qg.
Tomcat or JBoss) or ask your administrator for details.

4.2.2 Disable Users at the level openCRX

The segment administrator (e.g. admin-Standard) can prevent a user from
accessing a particular openCRX segment by either disabling the respective
Segment Login Principal or by deleting it altogether. Disabling is the preferred
option to prevent access temporarily. If a user has multiple Segment Login
Principals you must disable all of them to prevent access to the openCRX
application.

3 Security Realms = Standard > guest - Principal

1]
Edit WView Wizards
*Contacts General | System *

ik
A CODLAndS Prin cig

hNamae: guest Disabled: el
Subject: Guest, joa O Q, Description: Standardy\guest
= A
*Support
= Last lagin at: 2/13/2012 9:55:02 AM &%

Save| |Cancel
1

Figure 20: Disabling of Segment Login Principal guest by admin-Standard

You should not delete a particular Subject as long as it is referenced
by any Principal. Otherwise you'll end up with “dangling” Subject

Importamt  ~corences.
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5 Deployment Scenarios

openCRX supports a multitude of deployment scenarios.

5.1 Typical Deployment Scenarios

The following table lists some of the pros and cons of the most common
openCRX deployment scenarios. Please note that the list is by no means

complete:

3-Tier with Tomcat/OpenEJB

mTomcat engine extended by
openEJB (lightweight EJB 3.0
implementation) so that EARs
with EJBs and WARs can be
deployed

msimple setup and management
(Server Installer)

mlimited scalability and availability
(no clustering)

mhighest performing 3-Tier
deployment with full
transaction service

Tomcat/OpenEJB*

Browser openCRX/core EAR

openCRX
GuI

(Servlet)
openi DX

g-ther
openCRX '
Provider

[iata base

Figure 21: 3-Tier with Apache Tomcat / OpenEJB

4-Tier with Tomcat/OpenEJB

mMultiple Tomcat engines
extended by OpenEJB and
fronted by load balancer
(subsequent session requests
are sent to the same Tomcat
instance)

mdatabase cluster
mgood scalability and availability

mhigh performance 4-Tier
deployment with full
transaction service

http/https
Load Balancer*

Multiple Instances
Tomcat/OpenElB

openC AX/core= EAR

openC AKX
GUI
Beralet)

opentiK

openC AKX
Prowider

Browser

openC AX/core EAR

openC KX
GUI
Be=relet)

opentilK

openC AKX
Prowider

3-Tier with AppServer

mJ2EE-compliant Application
Server (JBoss is supported
out of the box)

mSimple setup and management
(one application server)

mlimited scalability and availability
(no clustering)

mTransaction Service

Application Server

Browser openCRX/core EAR

openCRX
GUI
(Servlet)

openMDX

openCRX
Provider

Figure 23: 3-Tier with J2EE-compliant Application Server

ms ...
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4-Tier with Clusters

mdemanding setup (four and
more application servers)

mmultiple security zones for
highest security (Internet,
DMZ, Intranet)

mmaximum availability
mfully fault tolerant
munlimited scalability
mTransaction Service

Servlet Engine(s) /
Application Server(s)

Browser
N openCRX/core EAR

openCRX
Ul
(Serviat)

Internet O Z

Application Server(s)
openCRX/core EAR

openCRX
P rowider

Intranat

Figure 24: 4-Tier with Clustered Application and DB Servers
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5.2 Multi Entity Deployment Scenarios

The open source MDA platform openMDX supports a multitude of deployment
scenarios and persistency configurations. The most common multi entity
deployment scenarios are discussed in the following sections.

5.2.1 Multiple Data Segments in a single DB

The setup “"Multiple Data Segments in a single DB” provides adequate security
for many use cases and is relatively easy to manage. As all the data is stored
in a single database, however, security configuration mistakes (e.g. principals
linked to the wrong subject, etc.) might lead to situations where a user is
granted access to the data of a particular company/client that should not be
accessible (please note that human error is the real root cause here, not a
malfunction of openCRX). Furthermore, this setup is hot recommended if users
can get direct access to the database, e.g. with third party reporting tools as
those tools typically bypass the openCRX API (and hence openCRX security)!

Data
Segment
Company #1

Data
Segment
Company #2

Data
Segment
Company #N

—

e

B 0O0CKE1_ACCESSHISTORY

B OOCKE1_ACCESSHISTORY_

B OOCKE1_ACCOUNT

B 00CKE1_ACCOUNT_

B OOCKET1_ACCOUNTASSIGHMENT

B OOCKET_ACCOUNTASSIGNMENT_

B OOCKET1_ACTIMITY

B OOCKET_ACTIMITY_

B 0O0CKE1_ACTIVITYCREATOR

B OOCKET1_ACTIMITYCREATOR_

B OOCKE1_ACTIMITYEFFORTESTI

B O0CKE1_ACTIMITYEFFORTESTI_

B OOCKE1_ACTITYFOLLOWUPR

B OOCKET1_ACTRATYFOLLOWUP_

B OOCKET1_ACTRATYGROUP
H‘@iEEEKE'I_.&CTWITYGHDUP_

Figure 25: Multiple Data Segments in a single DB

Detailed instructions on how you can create and configure new segments are
provided in the installation guide for Tomat 6.
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5.2.2 Multiple DBs

The highest level of security is provided by setting up a dedicated database for
each entity so that data sets of the various entities are physically separated:

Database
Company #1

T
e ——

B O0CKE1_ACCESSHISTORY

B 00CKE1_ACCESSHISTORY_

e OO0CKE1_ACCOUMT

B O0CKE1_ACCOUNT_

B O0CKE1_ACCOUMTASSIGMMENT
B O0CKE1_ACCOUMTASSIGHMENT_
B DOCKE1_ACTITY

B OOCKE1_ACTIMITY_

B O0CKE1_ACTITYCREATOR
B O0CKE1_ACTMITYCREATOR_
B O0CKE1_ACTWITYEFFORTESTI
B O0CKE1_ACTMWITYEFFORTESTI_
B O0CKE1_ACTIWITYFOLLOWJP
B OOCKE1_ACTRATYFOLLOWLUPR_
B D0CKE1_ACTIMITYGROUF

B O0CKE1_ACTIMITYGROUP_

—

_——-—"'-r'

Database
Company #1

[
F—

B OOCKE1_ACCESSHISTORY

B O0CKE1_ACCESSHISTORY_

B OOCKE1_ACCOUNT

B OOCKET_ACCOUNT_

B OOCKE1_ACCOUMTASSIGMMENT
B OOCKET_ACCOUMNTASSIGHMENT_
B O0CKE1_ACTIMITY

B OOCKET_ACTIMITY_

B OOCKET_ACTIVMITYCREATOR
B 00CKE1_ACTIMITYCREATOR_
B OOCKET_ACTIMITYEFFORTESTI
B OOCKET_aCTIMITYEFFORTESTI_
B OOCKE1_ACTRATYFOLLOWUPR
B OOCKE1_ACTRATYFOLLOWUR_
BB 00CKE1_ACTIMITYGROUR

FE OOCKE1_ACTIMTYGROUP_

Figure 26: Dedicated DB for each Entity

——

5.3 openCRX Custom Applications

Information about openCRX custom projects is available from the openCRX
wiki, e.g. http://sourceforge.net/p/opencrx/wiki/Sdk211.CustomProject/
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6 Workflow Controller and Servlets

With the Workflow Controller the openCRX Root administrator (admin-Root)

can enable/disable various servlets (configured in web.xml) included in the

openCRX distribution. This chapter gives an overview over the currently

available servlets and explains how to start/stop them.

You can access the Workflow Controller by navigating to the URL
http://127.0.0.1:8080/0opencrx-core-CRX/WorkflowController

or starting the Workflow Controller Wizard as shown in the figure below:

admin-Roat@Roat Logaff admin-Root

opencrx Root

en_US Save Settings

#* Administration UoMs Codes of Security Realm Security Policy Security Subjects

~ Administration

L]
Edit WView Actions Wizards
openCRX Workflow Controdler, ..

openCRX IMAPF Server...
*Workspaces Loaging Config .3-\.-.-

Figure 27: Acces;c,-ir_lg the openCRX Workflow Controller

You should connect to the Workflow Controller with http. If you
use SSL-secured connections to start/stop servlets you must ensure
Imporiant  +hat your server's certificate is available in cacerts.

The following figure shows the Workflow Controller of openCRX 2.12.0:

' Demo - Administration - Ad... T D demo. opencrx, org/opencr. .

C' | @ demo.opencrx.org/opencrx-core-CRX/WorkflowControler/

openCRX Workflow Controller CRX

Pause
Active
IndexerServiet/executePprovider=CEX & segment=5tandard Turmn
SubscriptionHandler/execute Tprovider=CRE & segment=S3tandard Tuwm Off
WorlflowHandler/execute Tprovider=CEX &segment=S8tandard  Tum Off

%

Inactive

Figure 28: openCRX 2.12.0 Workflow Controller

Please note that access is granted to the openCRX Root administrator
(admin-Root) only. Hence, if you see the openCRX login screen

o instead of the Workflow Controller you must first login as Root
administrator. Also, ensure that openCRX is properly initialized before
you connect to the Workflow Controller.
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Tin

The first time the Workflow Controller is started it will create a default
configuration:

# Administration UoMs Codes ) Security Realm Security Policy Security Subjects
Administration = WeorkflowController - Component Configuration

File Edit WView Security Wizards

*Workspaces General System
Default
Marme: WorkflowController
Description:
Properties
W g, HOENEE Mew Edit Actions View
I+ _ Mame = Description =
b cerverlRL Server URL

ik SubscriptionHandler CRX.Standard. autostart  SubscriptionHandler autostart

Ll SubscriptionHandler. CRX.5tandard. pingrate SubscriptionHandler pingrate

ab IndexerServiet. CRX.Standard autostart IndexerServiet autostart
&b WorkflowHandler CRY.Standard. autostart WarkflowHandler autostart
&  WorkflowHandler CR¥.Standard. pingrate WarkflowHandler pingrate
Ll Indexerserviet.CRX.5tandard.pingrate IndexerServiet pingrate

Figure 29: Default Configuration of WorkflowController

If you ever need to recreate this default configuration, you can do so
with the following steps:
e stop the WorkflowController

e delete the Configuration with the name WorkflowController

e start the WorkflowController

You can manually start (stop) servlets that are managed by the Workflow
Controller by clicking on “Turn On” (“Turn Off”). Please note that you can
control servlets of each segment individually. For example, if you created a
segment “"OtherSegment” in addition to the segment “Standard” you can
start/stop servlets of the segment “"OtherSegment” without interfering with the
servlets of the segment “"Standard”.
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6.1 Workflow Controller Configuration

In addition to configuring the Startup option of the Workflow Controller you can
also configure various options related to the servlets managed by the Workflow
Controller. The configuration of the Workflow Controller is available to the
openCRX Root administrator (admin-Root) by navigating to the tab
[Administration] and then clicking on the icon of the WorkflowController:

admin-Roat@Roat

opencrx . Root

Lagoff admin-Roat

Save Settings

#* Administration UoMs Codes =) Security Realm Security Policy Security Subjects

~ Administration

]
Edit WView Actions Wizards

*Workspaces Configurations
Default izl = I IS Mew Edit Actions View
I¥l Mame = Description =
WaorkflowController
* ICal5erviet

CalDavserviet
Figure 30: openCRX Administration — WorkflowController

In case you create the WorkflowController configuration manually, please note
that both name and qualifier are equal to the string WorkflowController.

6.1.1 Startup Configuration in web.xml
You can start the Workflow Controller manually by navigating to the URL
http://127.0.0.1:8080/0opencrx-core-CRX/WorkflowController

or starting the Workflow Controller Wizard. However, it is also possible to start
the Workflow Controller automatically by activating the corresponding option
in the file web.xml:

Listing 5: web.xml - auto startup of the Workflow Controller

<!-- WorkflowController -->

<servlet id="WorkflowController">
<servlet-name>WorkflowController</servlet-name>
<servlet-class>org.opencrx.kernel.workflow.servlet.WorkflowControllerServlet</servlet-class>

<!-- activate if WorkflowController should be initialized at startup-->
<load-on-startup>10</load-on-startup>
</servlet>

With the value of load-on-startup (10 above) you can control the

order of starting up servlets in case there is more than one servlet.
Tin
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6.1.2 ServerURL

Adapt the value of serverURL to your environment:

Administration UOMs Codes Security Realm  Security Policies  Security Subjects

Administration = WorkflowController - Component Configuration

File Edit Wiew Security Wizards

General | | System | [*

MName: WorkflowController

Description:

Properties

1 a W= Mew Edit View

I¥ [] Hame & Description = Domain = String walue =
Ll IndexerServlet TR Standard . autostart IndexerServiet sutostart true

b IndexerServlet. TR Standard pingrate IndexerServiet pingrate 2

Ll SubsoiptionHandler CRX Standard autostart  SubsoriptionHandler autostart true

ik SubsoiptionHandler CRX. Standard . pingrate  SubsoiptionHandler pingrate 2

a0 \WorkflowHandler CRX. Standard. autostart WorkflowHandler autostart trus

ab C >

& corverlJRL Server URL http:/1127.0.0.1 :EDBD.-':}p—Eﬂ-::x—mH:—EHK]

Figure 31: Workflow Controller Configuration — serverURL

6.1.3 Handler pingrate and autostart

Use pingrate to define the interval (in minutes) between successive calls of
the respective handler and autostart (true/false):

Administration UOMs Codes Security Realm  Security Policies  Security Subjects

Administration = WorkflowController - Component Configuration

File

Edit WView Security Wizards

General || System *

MName: WaorkflowController

Desoiption:

Properties |

L 2 mENE Mew Edit View

1M [] Name & Description = Domain = String value =

Ll IndexerServlet. CRO{ Standard. autostart IndexerServlet autostart true

ab IndexerServiet. CRX. Standard pingrate IndexerServiet pingrate 2
SubsoiptionHandler CRX. Standard .autostart  SubsoriptionHandler autostart true
SubsoiptionHandler TR 5tandard . pingrate  SubsoiptionHandler pingrate 2
WordlowHandler CFL. Standard . autostart WordflowHandler autostart true

a8 WordflowHandler CRX. Standard. pingrate WorkflowHandler pingrate 2

ab

serverlJRL

Server URL

http://127.0.0.1:8080/opencre-core-CRX

Figure 32: Workflow Controller Configuration — pingrate and autostart
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6.2 Serviet IndexerServiet

The openCRX IndexerServlet updates index entries (used for keyword/index
based search) by indexing all objects which do not have an IndexEntry newer
than the modification date of the object. The IndexerServlet creates an index
by invoking the operation updatelndex() on the object to be indexed.

Please note that indexing can put some heavy load on your database

server. Hence, you might consider turning off (or at least lowering the
Tin frequency of calling) the IndexerServlet during busy hours.

If you are looking for a way to define advanced schedules for calling

the openCRX indexer you might consider cURL in combination with a

scheduler provided by your operating system (e.g. Scheduled Tasks

on Windows, cron on Linux).

With curl, calling the indexer boils down to calling curl with the

appropriate URL as a parameter. The following example shows how to

call the indexer for the provider CRX and the segment Standard:

curl "http://localhost:8080/opencrx-core-CRX/IndexerServlet/execute?
provider=CRX&segment=Standard"

6.3 Serviet SubscriptionHandler

The openCRX SubscriptionHandler is the backbone of the openCRX Subscribe /
Notify Services. The Subscription Handler does not require any configuration by
the openCRX administrator other than setting the pingrate and autostart
options, i.e. it is designed to work “out of the box”.

Turning on the SubscriptionHandler of a particular segment is required if you
want that segment to provide Alerts, E-mail Notifications, witter Updates
(see chapter 12.1 Twitter) and XMPP (Jabber) Messages to its Users. The
polling frequency can be set by the Root administrator (see Figure 32:
Workflow Controller Configuration — pingrate and autostart).

The SubscriptionHandler checks openCRX audit entries on a regular basis and
- if matching Subscriptions exist — executes the Workflow Process referenced
by the Subscription using Userhome.executeWorkflow().

Userhome.executeWorkflow() — implemented by the openCRX plugin - creates
an entry in Userhome.wfProcessInstance (accessible through the grid Workflow
Process Instances). Synchronous workflows are executed immediately,
asynchronous workflows are left alone (the Servlet WorkflowHandler is
specialized in dealing with asynchronous workflows - see below for details).
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6.4 Serviet DocumentScannerServiet

The DocumentScannerServlet scans a file system directory and its subdirs for
files and maps them to openCRX Documents and DocumentFolders. The
DocumentScannerServlet is configured in the file web.xml as follows:

Listing 6: DocumentScannerServlet - init-param for WorkflowController

<!-- init-param for WorkflowController -->
<init-param>
<param-name>path[3]</param-name>
<param-value>/DocumentScannerServlet</param-value>
</init-param>

Listing 7: DocumentScannerServiet — Servlet Declaration

<!-- DocumentScannerServlet -->
<servlet id="DocumentScannerServlet">
<servlet-name>DocumentScannerServlet</servlet-name>
<servlet-class>org.opencrx.application.document.DocumentScannerServlet</servlet-class>
</servlet>

Listing 8: DocumentScannerServiet — Mapping

<servlet-mapping>
<servlet-name>DocumentScannerServlet</servlet-name>
<url-pattern>/DocumentScannerServlet/*</url-pattern>
</servlet-mapping>

The servlet can be configured as admin-Root by adding entries to the
WorkflowControll configuration (see chapter 6.1 Workflow Controller
Configuration). The following options are supported:

« scanDir: directory to be scanned for documents

« urlPrefix: Document revisions are created of type Resourceldentifier.
The url of the resource identifier is set to urlPrefix + current directory
name within scanDir + document name

e groups: List of principal groups. owningGroup of all created objects is
set to the specified list of principal groups

« upload: if set to true, successfully uploaded documents are removed
from the directory

All options are multi-valued, i.e. can optionally have an index suffix [0]..[9]. All
options must be prefixed with {Provider name}.{Segment name}., e.g.
CRX.Standard.scanDir or MyProvider.MySegment.urlPrefix.

The openCRX administrator can set the pingrate and autostart options;
alternatively, you can call it servilet with cron/cUrl.
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6.5 Serviet WorkflowHandler

The openCRX WorkflowHandler is responsible for executing WfProcessInstances
based on asynchronous WfProcesses like:

e org.opencrx.mail.workflow.ExportMailWorkflow

e org.opencrx.mail.workflow.SendMailNotificationWorkflow

e org.opencrx.mail.workflow.SendMailWorkflow

The execution frequency can be set by the Root administrator (see Figure 32:
Workflow Controller Configuration — pingrate and autostart).

Please note that the WorkflowHandler is required for outbound E-Mail

Services.
Tin

The WorkflowHandler executes Workflow Process Instances that have not been
executed yet.

The first time the WorkflowHandler is started it will create various

default Workflow Processes:
Tin : .
N Home [ Manage Accounts £ Manage Activities | Sales =
Ld Workflows
File Edit View Actions Security Wizards

Ll Workflow Processes | Topics

il e Acoounts ol =1 HOENEE Mew Edit Actions View

: f I+ | Mame & Priority = Is synchro

" | 7 org.opencre.application.twitter SendDirectMessageWarkflow 0 v

. = A8 orgopencrxkernel workflow PrintConsale 0 v
‘S:Jppurt 2 org.opencrx.kernel workflow. SendAlert ] v

: 7 arg.opencre.mail.workflow.ExportMailWarkflow ]

f i:fs::s:.ss s org.opencrmaill. workflow ExportMailWarkflow ]

P Bugs + Fs.sr."ss i org.opencr.mall. workflow. SendMailNotificationWarkflow ]

Activities 7 arg.apencri.mail.workflow. SendMailWorkflow 0

Figure 33: Default Workflow Processes created by WorkflowHandler

If you ever need to recreate these default Workflow Processes, you
can do so with the following steps:
e stop the Servlet WorkflowHandler
e delete the Workflow Processes that were originally created by
the WorkflowHandler (or at least the ones that still exist)
e start the Servlet WorkflowHandler

All WfProcesses with undefined/unknown runtime length should be
defined as asynchronous. This is particularly true for WfProcesses that

Importalt  might block. The default setup ensures that blocking WfProcesses
cannot block openCRX.




openCRX Admin Guide - Version 2.12.0 Workflow Controller and Servlets

6.6 Serviet MaillImporterServiet

A sample configuration (which you need to adapt to you own environment) of

the MaillmporterServlet is contained in
TOMCAT_HOME/apps/opencrx-core-CRX/opencrx-core-CRX/WEB-INF/web.xml

You also need a ComponentConfiguration named MaillmporterServlet. The
following configuration options (String Properties) are supported:

e <provider>.<segment>.mailServiceName

e <provider>.<segment>.deleteImportedMessages

e <provider>.<segment>.mailbox

A sample ComponentConfiguration looks as follows:

Name Description String value
CRX.Standard.mailServiceName Mail service name in web.xml /mail/provider/CRX
CRX.Standard.deleteImportedMessages Delete imported messages false
CRX.Standard.mailbox Mailbox name INBOX

To activate the servlet, you also need to add the relevant entries to the
WorkflowController (see chapter 6.1 Workflow Controller Configuration).

6.7 Trouble Shooting Servlets

All the openCRX servlets controlled by the Workflow Controller log their actions
to the server log file (e.g. TOMCAT_HOME\log\catalina.<date>.log). The
following log file extract shows, for example, that the three Servlets Indexer-
Servlet, SubscriptionHandler, and WorkflowHandler seem to be working fine:

Listing 9: Servlets managed by Workflow Controller log to server.log

20:25:18,388 INFO [STDOUT] Tue Mar 04 20:25:18 CET 2008: Indexer CRX/Standard
20:27:18,400 INFO [STDOUT] Tue Mar 04 20:27:18 CET 2008: SubscriptionHandler CRX/Standard
20:27:18,400 INFO [STDOUT] Tue Mar 04 20:27:18 CET 2008: WorkflowHandler CRX/Standard

openCRX Exceptions (like NullPointers, etc.), however, are still logged to the
application log file as configured during the installation.

It is always worth checking whether the Workflow Handlers actually are active;
they must be started by the Root administrator. You can find out by connecting
to the Workflow Controller (see Figure 28: openCRX 2.12.0 Workflow
Controller).

After restarting the application server all servlets managed by the
WorkflowController are inactive, i.e. the Root Administrator must
Tin explicitly turn them on again (if desired) unless the respective
servlet's autostart option is set to true in the WorkflowController's
configuration and the WorkflowController's Startup option is set to
true in the file web.xml. The servlets do not automatically resume
the state they were in before the application server was shut down.
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7 Subscribe / Notify Services

openCRX features a powerful event subscription and notification service:

Step 1
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including Action(s) _ ‘EJ
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0
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Tipic pats patiem wro@openmadeong.apen rc ke el sccourt ] providen U segment s aooount s
Lebay by parfare
II:_ Ly = = ! fmed = Uas Brgtvary =
=T GG Seanera kerrel wigrk fgrw Tendsalen
B
—:‘" Hama OF L O el weoi Fricty [
i wynchronoe =
Wax dreires
Dergorpins San gt
Step 2
User = - ® ACCOUNE MOCIRCAN0N Aler - SUbSCHpNoN
subscribe to Topic e —
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Cogorphon Eweswl type
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.w-e ol ey 82 el o iy 50
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Ko of fter 13 Walue o SRer B2
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Step 4 Y T ran
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e performs Topic Action(s)
Step 5 {e.g. create Alert or send E- mail Notification)
User
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Figure 34: Event and Notification Service

Once a topic is created, openCRX users can subscribe to it. Users manage their
subscriptions individually on their UserHomes (with the Wizard UserSettings or
by editing their subscriptions manually). If a topic has subscribed users and a
monitored event occurs then the predefined actions are performed. If the
action is set to - for example - creating an alert for subscribed users, then
each subscribed user will receive an alert on the UserHome.

Please note that event and notification services depend on the Servlet
SubscriptionHandler, i.e. you must turn on the openCRX
Subscription Handler for the respective segment with the Workflow
Controller, otherwise Topic Actions are not executed, i.e. no Alerts will
be created and E-mail Notifications will not be delivered.
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Subscribe / Notify Services

Furthermore, outbound E-Mail Services must be configured (see
chapter 8.1 Install and Configure Mail Resource and E-Mail Services)

and you must activate the Workflow Handler (see chapter 6.5 Servlet
WorkflowHandler) to receive E-Mail Notifications.

The openCRX distribution includes quite a few default topics (see Figure 35:
Standard Topics included in the openCRX distribution) to get you started:

e Topic Account Modifications sends an alert to subscribed users
whenever an account is modified.

e Topic Activity Follow Up Modifications sends an alert to subscribed

users whenever a Follow Up of an Activity is modified.

e Topic Alert Modifications sends an e-mail notification to subscribed
users — assuming outbound e-mail services are configured correctly -
whenever an Alert is created/modified.

Please note that newly created Segments do neither contain Workflow
Processes nor Topics (i.e. the respective grids are empty). Both

Workflow Processes  Tepics

) = HOMEE Mew Edit Actions View

I+ | Mame &
Account Modifications
Activity Fallow Up Modifications
Activity Madifications
Alert Modifications
Alert Modifications (Twitter)
Booking Madifications
Competitor Modifications
Compound Booking Madifications
Invaice Madifications
Lead Modifications
Opportunity Modifications
Organization Madifications
Product Madifications
Quote Modifications
Reminder Maodifications (Alert)

SalesOrder Modificatians

Actions to perform =
arg.opencre kernel. warkflow. SendAlert
org.opencre.kernel. workflow. SendAlert

org.opencre kernel.workflow. SendAlert

org.opencre.mail. workflow. SendMailNotificationWorkflow

org.opencreapplication.twitter. SendDirectMessageWarkflow

arg.opencri kernel.workflow. SendAlert
org.opencre kernel.workflow. SendAlert
arg.opencry kernel. warkflow. SendAlert
org.opencre.kernel. workflow. SendAlert
arg.opencri kernel.workflow. SendAlert
org.opencre kernel.workflow. SendAlert
arg.opencry kernel. warkflow. SendAlert
org.opencre.kernel. workflow. SendAlert
arg.opencri kernel.workflow. SendAlert
org.opencre kernel.workflow. SendAlert

arg.opencry kernel. warkflow. SendAlert

Workflow Processes and Topics can be created by the segment
administrator with the wizard Segment Setup.

Figure 35: Standard Topics included in the openCRX distribution

Users can easily custom-tailor their subscriptions with filters and by selecting
event types like Object Creation, Object Replacement, and Object Removal.
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7.1 Example Subscription — Account Modifications

In this example we will create a subscription to the standard Topic Account
Modifications for the user “guest”.

e Login as guest, and execute the operation Edit > User Settings to start
the respective wizard. Check both “Is Active” and “Creation” as shown

below:
Subscriptions
Notify an
Is Active Creation Replacement Remowval
Account Madifications: W W

Activity Fallow Up
Madifications: -
Activity Modifications:

Alert Madifications:

Alert Madifications (Twitter):

Figure 36: Create a new Sul_ascriptic_)n

e Click the button [Save] to store your settings.

Please note that the Root administrator must start the Subscription

Handler - otherwise you will not get any Alerts/Notifications.
Important

7.2 Example Subscription - Activity Assignment Changes

With the following steps you can create a subscription to activity assignment
changes:

e nhavigate to your Userhome and create a new Subscription
e populate the fields as follows:

Name: Activities assigned to me
Description: (any description you like)
Active: checked

Event type: (leave empty)

Topic: select Activity Modifications

Name of filter #0: assignedTo
Value of filter #0: copy the Identity of the respective user's homepage

e save your subscription

To locate the identity of a user's homepage, you can navigate to the respective
homepage and inspect the tab [System]. The pattern is as follows:

xri://@openmdx*org.opencrx.kernel.homel/provider/<providerName>/segment/<SegmentName>/userHome/<principal>

e. g . Xri://@openmdx*org.opencrx.kernel.homel/provider/CRX/segment/Standard/userHome/guest
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7.3 Example Subscription with Filtering

In combination with openCRX security the subscription filter feature enables
you to provide highly specific subscriptions. Imagine the following situation:
there are 2 Activity Trackers DivisionA:ProjectX and DivisionA:ProjectY
and some of your users are interested in receiving notifications related to
activities of ProjectX only, whereas some users want to receive notifications
related to activities of ProjectY only. A third group of users wants to receive
notifications from both projects. Such a situation could be handled as follows:

e create a PrincipalGroups DivisionA.ProjectX and DivisionA.ProjectY

e assign PrincipalGroup DivisionA.ProjectX to ActivityTracker
DivisionA:ProjectX; like this new activities assigned to this Tracker will
also be assigned the PrincipalGroup DivisionA.ProjectX

e assign PrincipalGroup DivisionA.ProjectY to ActivityTracker
DivisionA:ProjectY; like this new activities assigned to this Tracker will
also be assigned the PrincipalGroup DivisionA.ProjectY

e an Activity Modification subscription of a user wanting notifications
related to ProjectX and ProjectY would look as follows:

Activity modification alert - Subscription

Gansral

Mame: Activity modification alert Active:
Drescription: Project’ only Event type: =l
Tapic: Activity modification alert .

i

Name of filter #]: Value of filter #0: Standard:Divisiond Projectd =

owner Standard:DivisionA.ProjectB

Figure 37: Create a Subscription with Filters

Enter the name of the attribute (owner in our example) into the name
field and then enter the value(s) to match into the value field (in our
case Standard:DivisionA.ProjectX and Standard:DivisionA.ProjectY)

Multiple values of a named filter are combined with OR.

mporiam~ Multiple named filters are combined with AND.
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7.4 RSS Feeds

New alerts are also available as RSS feeds. Users can subscribe to their news
feed directly from their homepage:

@ - c el l: _It: http: //demo.opencrx.orgfopencrx-core-CRY/ || .7 - @'

|5ul:usn:ri|:ue to this page... |
1

guest@Standard oo gues
L=

opencrx

Save Settings

My Homepage | Accounts Activities Pipeline »

g @t User Homepages = Guest, Joe O - My Homepage

7.5 Trouble Shooting Notification Services

The following table lists some of the common issues and how to fix them:

Problem Solution

The grids Workflow | mverify that the Segment Administrator created Workflow
Processes and/or Processes and Topics with the wizard Segment Setup

Topics are empty. | gclick the filter button B to see all rows without filtering
(maybe you defined a default filter in the past?)

I started the mverify that you started the correct Subscription Handler
Subscription (each segment has its own Subscription Handler)

Handler but I never| g4in case you upgraded to a new version of openCRX and
receive any Alerts /| forgot to delete Workflows and Topics provided by
Notifications openCRX, stop the Subscription Handler, delete
Workflow Processes and Topics, recreate Workflow
Processes and Topics with the wizard Segment Setup,
and then start the Subscription Handler again

m check the openCRX log files to find out whether
bad/corrupt data might be causing problems (e.qg.
NullPointer Exception during Workflow execution)

I receive Alerts mverify that JavaMail is properly installed and the mail
triggered by my service properly configured (see chapter 8.1 Install and
Subscriptions but Configure Mail Resource and E-Mail Services for more
no Notification information)

E-mails m verify your e-mail settings (see E-mail Services)

mverify that the Servlet WorkflowHandler of the
respective segment is actually turned on
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8 E-mail Services

Please note that we have no intention to duplicate mail server (MTA) or
mail client (MUA) functionality in openCRX as there are lots of excellent
products available (Open Source and commercial). It is our goal, however, that
openCRX integrates with all the major products that adhere to the
major standards and support standard protocols like SMTP, POP3, IMAP,
etc. This ensures that you can continue to use your favorite mail server (gmail,
postfix, Zimbra, etc.) and your favorite mail client (Thunderbird, Outlook, etc.).

Installation of JavaMail is required if you want to make use of E-mail

Services (see chapter 8.1.1 Installation of JavaMail).
Imporiant

The following figure shows the possible flows of mail messages between
openCRX, mail server, and mail client as it is supported with openCRX 2.12.0:

Browser

ObjectInspectorServiet

Upload E-Mail Wizard IMAP ExporttMail § SendMail

Wizard FetchE Mail Servlet Workflow N WorkHow

Mail Client
+ Thunderbird
+ M3 Qutloolk

+ Evalution )

i3

POP3 f POP3S f IMAP f IMAPS

Mailbax ... Mailbayx audit

Mail Server

Figure 38: Flow of e-mail messages between openCRX, MTA and MUA

In this chapter we will first guide you through the required installation and
configuration steps before we discuss various important use cases.
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8.1 Install and Configure Mail Resource and E-Mail Services

The following chapters explain how to install JavaMail and how to configure the
Java mail service and various in- and outbound E-mail services.

Please note that E-Mail Services depend on JavaMail (i.e. JavaMail
must be installed) and outbound E-Mail Services depend on the

Imporiant o ylet WorkflowHandler of the respective segment being turned on.

8.1.1 Installation of JavaMail

Detailed installation instructions are provided at the JavaMail home:
http://java.sun.com/products/javamail/FAQ.html

And here is the short version:
e Download JavaMail (at least version 1.4.3) from
http://java.sun.com/products/javamail/downloads/index.html
e Put mail.jar (or javax.mail.jar) into the directory TOMCAT_HOME\Ilib
e If you have an installation based on our Server Installer, remove
geronimo-javamail_1.4_mail-*.jar, which is part of the

i original TomEE distribution and replace it with mail.jar.

8.1.2 Mail Resource for openCRX on Apache Tomcat

8.1.2.1 Add resource definition(s) to openejb.xml / tomee.xml

Open the file TOMCAT_HOME\conf\openejb.xml (with TomEE v1.0 it is called
tomee.xml) and add (or modify) the mail resource definition. Typically you
would add one (smtp) mail resource definition per provider for outgoing mail
and one mail resource definition for each segment that requires the

MaillmporterServlet. Below are some sample files which you can use as a
starting point (adapt the m to your own environment):

Listing 10: File openejb.xml/tomee.xml — mail resource outgoing mail

<Resource id="mail/provider/CRX" type="javax.mail.Session">
mail.transport.protocol smtp

mail.smtp.user [edPuEENRIEL
mail.smtp.password [edBuEHNERIIICY oo clifebae
mail.smtp.starttls.enable [hgss

mail.smtp.ssl.trust H
mail.smtp.auth [SasE
JUEERRESS (i olsloldlllnai]l server name or ip address|
mail.smtp.port P&
juEE RS Yol lln o reply@opencrx.org
mail.debug et
</Resource>

Please note that the above mail resource definition for provider "CRX"” will
apply to all segments (including “Standard”) of that provider.
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Make sure that you set mail.from to a reasonable value as this value
might be used in outgoing mails (see also chapter 8.2.2 Outgoing
Imporiant  £_m3i]'s FROM value).

If you set the option mail.smtp.ssl.trust to “*” then any smtp server
will be trusted, even if you didn't import its certificate into your
keystore. It is probably a good idea to replace * with the name of
your mail server, e.g. mysmtp.mydomain.com.

The following mail resource definitions apply to the segment “"Standard” (of the
provider “"CRX") and show default configurations for the various mail protocols
supported by mail.jar (pop3, pop3s, imap and imaps):

Listing 11:File openejb/tomee.xml — mail resource incoming mail POP3

<Resource id="mail/CRX Standard" type="javax.mail.Session">
mail.store.protocol |dejek
mail.pop3.host WESREECINaTN AN E (I-Hel okl oRi-Tole bty
mail.pop3.port MKV
mail.pop3.auth [Hasts
mail.pop3.user (o dRUEERERIEE
mail.pop3.password [chedRiEERRREEI-hall el t-Icitlofae
mail.debug

</Resource>

Listing 12:File openejb/tomee.xml — mail resource incoming mail POP3S

<Resource id="mail/CRX Standard" type="javax.mail.Session">
mail.store.protocol |sejekls
mail.pop3s.host WEEREETahalotiul el Noli-oleha Yt
mail.pop3s.port EES
mail.pop3s.auth [SasE
mail.pop3s.user [GPdUEENERIELT]
mail.pop3s.password [cheqRuERNNRIIIS eI ohae!

mail.debug
</Resource>

Listing 13: File openejb/tomee.xml — mail resource incoming mail IMAP

<Resource id="mail/CRX Standard" type="javax.mail.Session">
mail.store.protocol pBuEle
USRS Elolslolidlinail server name or ip address|
mail.imap.port KK
mail.imap.auth [hasE
mail.imap.user [GedPuEENERIELYs
mail.imap.password [ dBuERNERIEIhalorTiit{e}ae
mail.debug

</Resource>

Listing 14:File openejb/tomee.xml — mail resource incoming mail IMAPS

<Resource id="mail/CRX Standard" type="javax.mail.Session">
mail.store.
mail.imaps.
mail.imaps.
mail.imaps.
mail.imaps. _
mail.imaps.password [cheRuEERNRIIIChalle -t it olae
mail.debug

</Resource>

Additional information about configuration options of JavaMail is available from
the JavaMail home: http://www.oracle.com/technetwork/java/faq-135477.html
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8.1.2.2 Mail Resource in web.xml

In the file web.xml in the directory <Tomcat Install

Dir>\apps\opencrx-core-CRX\opencrx-core-CRX\WEB-INF you must uncomment the following
section to activate outgoing mail:

Listing 15: Uncomment mail resource definition (outgoing mail) in web.xml

<!-- Wizards, Workflows (e.g. MailWorkflow), etc. can use mail resources.
Configure a mail resource for each used mail resource.

-—>

<resource-ref id="mail opencrx CRX">
<res-ref-name>mail/provider/CRX</res-ref-name>
<res-type>javax.mail.Session</res-type>
<res-auth>Container</res-auth>

</resource-ref>

Please note that the res-ref-name must match the id of the
respective mail resource definition in the file openejb.xml.

imaortant (tomee.xml since TomEE v1.0).

The following steps are only required if you want to activate incoming mail (i.e.
MaillmporterServlet) for a particular segment (e.g. “Standard”):

e add mail resource definition to web.xml:

Listing 16: add mail resource definition (incoming mail) in web.xml

<!-- incoming mail for provider CRX segment Standard -->

<resource-ref id="mail opencrx_ CRX_Standard">
<res-ref-name>mail/CRX Standard</res-ref-name>
<res-type>javax.mail.Session</res-type>
<res-auth>Container</res-auth>

</resource-ref>

e add a path entry for the MaillmporterServlet to the WorkflowController
section in web.xml:

Listing 17: add path name of MaillmporterServiet to web.xml

<!-- WorkflowController -->

<servlet id="WorkflowController">
<servlet-name>WorkflowController</servlet-name>
<servlet-class>org.opencrx.kernel.workflow.servlet.WorkflowControllerServlet</servlet-class>

<init-param>
<param-name>path[3]</param-name>
<param-value>/MailImporterServlet</param-value>
</init-param>
<!-- activate if WorkflowController should be initialized at startup -->
<load-on-startup>10</load-on-startup>
</servlet>
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add the class name of the MaillmporterServlet to web.xml:

Listing 18: add class name of MaillmporterServiet to web.xml

E-mail Services

<!-- IndexerServlet -->
<servlet id="IndexerServlet">
<servlet-name>IndexerServlet</servlet-name>
<servlet-class>org.opencrx.kernel.workflow.servlet.IndexerServlet</servlet-class>
</servlet>
<!-- MailImporterServlet -->
<servlet id="MailImporterServlet">
<servlet-name>MailImporterServlet</servlet-name>
<servlet-class>org.opencrx.application.mail.importer.MailImporterServlet</servlet-class>
</servlet>

add the servlet mapping of the MaillmporterServlet to web.xml:

Listing 19: add servlet mapping of MaillmporterServiet to web.xml

<servlet-mapping>
<servlet-name>IndexerServlet</servlet-name>
<url-pattern>/IndexerServlet/*</url-pattern>

</servlet-mapping>

<servlet-mapping>
<servlet-name>MailImporterServlet</servlet-name>
<url-pattern>/MailImporterServlet/*</url-pattern>

</servlet-mapping>

See also chapter 6.6 Servlet MaillmporterServlet for important
information about the MaillmoprterServlet.

Imporiant

Restart Tomcat for these changes to become active. Please note that additional
steps are required to fully configure the MaillmporterServlet (see chapter

8.3.4 Inbound E-mail with MaillmporterServlet).

If you want to enable TLS/SSL connections to your mail server (smtp,
pop3s, imaps) you must either set the value of mail.smtp.ssl.trust
in openejb.xml (tomee.xml) or you must import the mail server's

public key into the file cacerts of your JRE:

Listing 20: Importing certificate into keystore cacerts

‘keytool -keystore cacerts -import -storepass changeit -file mailserver.cer
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8.2 Outbound E-mail

8.2.1 Outbound E-mail Configuration

openCRX users can configure e-mail accounts on their homepage indicating
where they would like to receive e-mail notifications (e.g. generated by
subscriptions):

e Click on Home and select the grid Tab Service Accounts (you might have
to click on [>>] to expand the hidden grid tabs).

e Next you click on the creator menu New > E-Mail Account to create a
new E-mail Account:

tions Service Accounts| Pending / Completed Workflows
e 2, HIOEEE Mew Edit Actions View
e
I+ Active = Default = |-J E—Malﬁ.c{oum L'E =

Figure 39: Create a new E-Mail Account — step 1

e Now you can configure your E-Mail Account for outbound e-mail service:

General | 5

Active: il Default: il
Namea: user@mycompany .com

Description:

Reply address: noreply @ mycompany.com

Outgoing Mail Service:
Incoming Mail Service: ||
Save| Cancel

Figure 40: Create a new E-Mail Account — step 2

The various fields have the following meanings:
m Name: enter your e-mail address

m Reply address: is also used for the From field (leave empty to use
the value of the segment admin's E-Mail Account)

s Default: check if this is your default e-mail address (notifications
will only be sent to your default e-mail address)

s Outgoing Mail Service: |leave empty (unless the default
configuration does not suit you; the default name of the mail
service is /mail/provider/<provider> )

= Incoming Mail Service: leave empty (unless the default
configuration does not suit you; the default name of the mail
service is /mail/<provider>_<segment> )
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If a user does not define the name of the mail service in
his E-Mail Account settings the default name
/mail/provider/<provider>/segment/<segment> is used;
if there is no resource with this name the fallback name
/mail/provider/<provider> is used (and if this name does
not exist either, then an error is logged).

Tin

Click the button | Save  to commit the new E-Mail Account. The grid
Service Accounts contains an entry for the new E-Mail Account:

Reminders Service Accounts

HOEMEE Mew Edit

sl 4, ) )

Actions  View
Il Active = Default = Name ¥ Description =
"'_) W o UsSer@Emycompany.com

Figure 41: Create a new E-Mail Account — step 3

On your Homepage you can provide additional information related to
E-Mail Notifications:

Options | | Systemn

ail Optians

E-mail subject prefix: [CRX:Standard) Web access URL: http://demo.ope...

Usér Settings
Figure 42: E-mail subject prefix and Web access URL

The meaning of the two fields is as follows:

= E-mail subject prefix: enter a string that might help you identify
or filter e-mails from your openCRX server (optional, i.e. you can
also leave this empty) - the entered string is prepended to the
subject line of generated e-mails.

m Web access URL: enter the URL of the openCRX instance at hand,
e.g. http://opencrx.yourdomain.com/opencrx-core-CRX; if entered
correctly, generated e-mails will contain URLs that allow you to
connect to your openCRX server with a single click.

You can easily test your e-mail settings if you create a subscription for Account
Modifications (see Example Subscription — Account Modifications) and then
work through the following steps:

create a new account (e.g. a new contact)

navigate to your Homepage and check whether you actually received an
alert related to the newly created account

next click on the Grid Tab Pending / Completed Workflows on your
homepage (unhide it by clicking on [>>] if it is not visible)

there should be (at least) two entries (you might have to sort the column
Started on to locate recent entries):
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o org.opencrx.kernel.workflow.SendAlert (which generated the Alert)

o org.opencrx.mail.workflow.SendMailNotificationWorkflow (which was
responsible for sending the E-mail Notification)

e click on the icon of the respective grid icon to inspect the corresponding

Workflow Process object

the grid Action Log Entries contains the message body of the e-mail that
was sent or an error message if the workflow failed (please note that
even if you see a "timeout" error message the e-mail might have been
sent; timeouts are typically caused by e-mail servers with high latency -
try sending out notifications through a mail server that is responsive).

8.2.2 Outgoing E-mail's FROM value

The openCRX Workflow Handler uses the mail.from value in the file
openejb.xml / tomee.xml (see chapter 8.1.2.1 Add resource definition(s) to
openejb.xml / tomee.xml).

If mail is sent as an openCRX user, the FROM value of outgoing e-mails is
determined as follows:

Important

if the user has configured an E-Mail Account for outbound e-mail service
and the value of Reply Address is set (see chapter 8.2.1 Outbound
E-mail Configuration, Figure 40: Create a new E-Mail Account - step 2),
then this value is used; otherwise

if the segment administrator has configured an E-Mail Account for
outbound e-mail service and the value of Reply Address is set, then
this value is used; otherwise

if the mail.from value in the file openejb.xml / tomee.xml (see
chapter 8.1.2.1 Add resource definition(s) to openejb.xml / tomee.xml)
is set, then this value is used; otherwise

the value noreply@localhost is used

Please note that many mail servers reject incoming mails if the
hostname contained in an e-mail's FROM value cannot be resolved.
(and FROM: noreply@Ilocalhost is very likely to cause delivery issues).
Hence, ensure that at least the value in openejb.xml / tomee.xml
makes sense.

8.2.3 Export E-mails

Please refer to chapter 9.5 Mailstore / IMAP.
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8.2.4 Send E-mails directly from openCRX
Any openCRX E-Mail Activity can be sent as e-mail directly from openCRX:

Browser

ObjectInspectorServiet

SendMailWorlkflow

Internet

SMTP

Mailbax ...

Mail Server

Figure 43: Send E-Mail from openCRX - Overview

The idea behind this functionality is less that you will use openCRX as a mail
client (MUA), rather the SendMailWorkflow is an important element of the
openCRX campaign management functionality. E-Mail Activities of type
“E-Mails” are controlled by the Activity Process E-mail Process. Send E-Mail
Activities to all recipients by executing the operation Actions > Follow Up and
then selecting the Transition Send as mail as shown below:

‘w 10007396 : Re: Update API; v1.24 - E-mail

s

Transition: i Bend as mail R
Follow wp title:
Follow wp tesxt:

| C(Rlﬂ:mJ

F/:_(_,v-u};e' 44: Send E-Mail from openCRX with Actions > Follow Up

Please note that the transition "Send as mail” is only available after

the Transition “Assign” has been executed.
Important

Media attached to E-Mail Activities are sent as e-mail attachments.
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8.2.5 Send E-mails as Attachments to your Mail Client

Any openCRX E-Mail Activity can be sent to your mail client as an attachment.
The idea behind this functionality is that you might want to put some finishing
touches on an e-mail before you actually send it from your mail client (MUA):

Browser

ObjectInspectorServiet

BExportMailWorkflow

Mail Client

POP3 f POP3S / IMAP / IMAPS

Mailbox ...

Mail Server

Figure 45: Send E-Mail as Attachment from openCRX — Overview

E-Mail Activities of type “"E-Mails” are managed by the standard Activity
Process E-mail Process, i.e. they can be exported to the user's default mail
account by executing the operation Actions > Follow Up and then selecting the
Transition Export as mail attachment:

@ 10007396 - Re: Update API; v1.24 - E-mail

P

Transition: iExport as mail attachment { W
Follow wp title:
Follow wp text: [

o e ]

Figbre 46: Export E-Mail from openCRX with Actions > Follow Up

Please note that the transition “Export as mail attachment” is only

available after the Transition “Assign” has been executed.
Imporiant

Exported messages are sent as attachments to the user's default mail
address. See Outbound E-mail Configuration for details.

Media attached to E-Mail Activities are sent as e-mail attachments.
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8.2.6 Send E-mails to Fax-/SMS-Gateways

The SendMailWorkflow supports mail gateways if you set the attribute gateway
of the respective e-mail activity. The gateway address is used for addresses
which are not of type EmailAddress. For example, in the case of a phone
number, the address is converted to an e-mail address as follows:

e take the address (e.g. phoneNumberFull in case of phone numbers)

e remove any characters other than digits and letters

A\Y 14

e convert “+” (plus sign) to (underscore)

e append domain part of gateway address

Example: if the domain address of an e-mail activity is set to the email address
noreply@fax-gateway.opencrx.org, the the phone number +41 (44) 111-2233
is converted to the email address _41441112233@fax-gateway.opencrx.org.

This conversion feature allows you to mix e-mail addresses and phone
numbers in member lists of address groups. Depending on the recipient's type
of addresss the SendMailWorkflow will either send an e-mail to the listed
e-mail address as is (e-mail address) or first convert the recipient's phone
number to an e-mail address so that the resulting e-mail can be handled by
your fax-/sms-gateway.

If you are looking for reliable fax software, you might want to look

o into Hylafax+ http://hylafax.sourceforge.net/ (Linux only).
n
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8.3 Inbound E-mail

Instead of offering platform-specific plugins for a multitude of mail clients like
MS Outlook, MS Outlook Express, Thunderbird, Eudora, EIm, etc. openCRX
features a platform-neutral IMAP adapter. The advantages are obvious:
e works with any IMAP client, or doesn't even require a mail client at all
e no installation of plugins required, i.e. you can get this to work on your
company's laptop regardless of how “hardened” the system is
e supports single message import and bulk import
e imports headers, body, and attachments
e automatically creates links to sender and recipient(s) if the respective
e-mail addresses are present in openCRX

In addition to the IMAP adapter there is also the possibility to import e-mails
(previously saved as eml files) with a wizard (see Inbound E-mail with Wizard
Upload E-Mail) or with the MaillmporterServlet (see Inbound E-mail with
MaillmporterServlet).

8.3.1 Inbound E-mail with IMAP Adapter

The openCRX IMAP adapter is well-suited to import e-mails from your mail
client (MUA) into openCRX. Importing an e-mail into openCRX is as easy as
dragging/dropping it on an openCRX IMAP folder in your mail client.

Please refer to chapter 9.5 Mailstore / IMAP for information on how to

setup/configure the openCRX IMAP adapter and your mail client.
Tin

Assuming you have configured your mail client to connect to the openCRX
IMAP adapter and subscribed to the relevant folders (openCRX Activity Groups)
you can import an e-mail message into openCRX as follows:

e in your e-mail client (e.g. Thunderbird, Outlook, ...) drag/drop the mail
to be imported to the desired openCRX IMAP folder (must be a folder
with a related activity creator that can actually create e-mail activities)

If you move an e-mail message from a non-openCRX IMAP folder to
) an openCRX IMAP folder and the target folder does not have a valid

Waminu  F_Mail Activity Creator defined, openCRX will not be able to create an
EMailActivitiy in that folder. Due to the move operation the message
is deleted from the source folder and your e-mail message is lost.
Hence, it is good practice to copy (and not move) e-mails to openCRX
IMAP folders. Only after verifying that the EMailActivitiy was actually
created by openCRX in the target folder should you delete (if
necessary) the message from the source folder.
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o openCRX will either create a new EMailActivity or update an already
existing EMailActivity with links to sender and recipients

Since openCRX v2.9.1, unknown e-mail addresses are created as
composites of the segment administrator, e.g. admin-Standard.

Tin

The IMAP adapter features some advanced import functionality that helps you
import mail messages and automatically link them with new or already existing
activities including creation of follow ups. This functionality is quite powerful in
the context of e-mail based support and incident management. Let's look at a
simple example:

e Yyou receive an e-mail asking for help with one of the gadgets you sell:
7 Christoph Mueller <christoph.mueller @crixp, com =

subiect Help! SuperGadget does not boot anymore ‘( 16:31
o products@crixp.com _ = other actions ~

Please help!
Regards,
Joe

r'.l
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e create a new incident in your openCRX support system:

Home  Accounts | Activities | Sales Products Folders & Documents
& Activities = 10009555: SuperGadget does not boot anymore - Incident

File Edit WView Actions Security Wizards

General || Details || System

Mame: SuperGadget does not boot anymore
Activity number: 10009555

o reply to the support e-mail and add # <activity number> to the subject
line (where <activity number> is the activity number of the newly
clreated incident, e.g. 10009555 in our example):

Subject: | Re: Help! SuperGadast does not boot anymure #10009555 I

»

Dear Joe:

Thank vou for your inguiry. We have opened a new support reguest
and your reference number iz #10009555.

Pleaze provide u=s with answers to the following questions =0 that
we can identify the prmblem:| [v]

e once you've sent your reply message you can import it (with drag/drop)
into the appropriate openCRX IMAP folder; the IMAP adapter will do the
following:

- create a new EMailActivity corresponding to your reply message
complete with attachments and links to sender/recipient

- link the existing incident #10009555 with the newly imported reply
message (i.e. EMailActivity) and then add the message body of the
reply message as a follow up to the incident #10009555:

Invalved Accounts || Assigned Groupd Linked To Jinbound Links

e a HNEE New Edit View

I Hame = Description = Type — Linked activity =

#  #10009558: SuperGadget doss not boot EF‘:;"‘I’E"E] relates to 10002558: Re: Help! SuperGad
Assigned Resources Effort Estimates Work and Expense Records  Votes

e a ¥ I 7 New Edit View

1M [] Name = Description = Resource = Resource o
¥ ol Mueller, Christoph  SuperGadget does not boot anymore (Mueller, Christoph) Mueller, Christoph 0

Follow Ups

e a HHOEE View

M [ Transition Info Title / Text
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If you import all the e-mails related to this support case you will have the
complete history of your exchange with the client available as follow ups in
your incident #10009555.

If you prefer, the IMAP adapter can even create new activities upon importing

e-mails. All you have to do is provide the necessary information in the subject
line of wrapper message. You can build a wrapper message by creating a new

e-mail message and then adding the e-mail(s) to be imported as attachments;
the subject line of the wrapper message is interpreted by the IMAP adapter.

If the subject line starts with "> " the message is treated as wrapper message.
All attachments are treated as mime messages which are imported instead of
the message itself. The subject line of the wrapper message has the following
form:

> @<email creator name> [#<activity creator name or activity#>] <subject>
Separate e-mail creator name, activity creator/numer and subject

with at least 2 space characters to make sure the parser can correctly
T identify the information provided.

Example subject lines:
> @E-mails #10009555 log file with exception
> @E-mails #GadgetASupport does not boot
> @E-mails #10009555 log file with exception
> @E-mails #10009555 log file with exception

This allows the user to specify the email creator and an optional activity
creator or an activity number. If an activity creator is specified, an activity is
created (name = subject, detailed description = body) and the imported
email(s) are linked with this activity using linkToAndFollowUp(). If an activity
number is specified than the imported email(s) are simply linked with this
activity using linkToAndFollowUp().

8.3.2 Inbound E-mail with Wizard Upload E-Mail

If you only want to import the occasional e-mail message you can save such
messages as eml files (Thunderbird) or msg files (Outlook) and import them
with the Wizard Upload E-Mail as follows:

e nhavigate to any ActivityCreator that supports creation of E-mail Activities
(i.e. Activities of type E-Mail), e.g. [Activities] > [Activity Creators] and
then select the creator E-Mails
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o start the wizard Upload E-Mail

Home  Accountis | Activities | Sales Productsz Depois
» Activities = E-Mails - Activity Creator

File Edit WView Actions Security Wizards

Upload E-Mail ..
General | | Details | System e al
Dazhboard...
Mame: E-Mails
Activity type: E-Mails

e choose the eml/msg file containing the e-mail to be imported and then
click the button [Save]

o if the import of the e-mail is successful you will be taken to the imported
e-mail automatically

The wizard also supports imports with a wrapper message with the same
functionality as the IMAP adapter if you launch it from the tab [Activities] (see
chapter 8.3.1 Inbound E-mail with IMAP Adapter).

MSG-Files (produced by MS Outlook) sometimes do not contain
SMTP-addresses, but rather they contain X.500-addresses. If the
respective X.500-address is assigned to an account in openCRX that
also has an SMTP-address, then the wizard automatically converts the
address to the SMTP-address. In all other cases the wizard asks you
to enter the SMTP-address that should be used as a mapping target:

Tin

E-malil
File: Choose Files | AW Direktw..ansicht msg
o AW Direktwahl Case Detailansicht.msg
E-mail address: | 'lou=Exchange Administrative Group (FYDIBOHF235PDLT)cn=Recipients/cn=

Save Cancel

8.3.3 Inbound E-mail with Wizard FetchEMail.jsp

The wizard FetchEMail.jsp can Hoet server.mail.com

retrieve e-mails from a mail Protocol imap 5
store interactively; supported ™ —

are the standard protocols R ... ...

pop3, pop3s, imap and imaps.  maxmessages to import 10

Activity Creatar: Default v

You can call the wizard from the
Activity Segment or any Activity
Creator.

OK || Close

The following parameters can be set:
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Host IP address or host name of openCRX Server

Examples: localhost, 127.0.0.1, myCrxServer.myCompany.com, etc.
Protocol choose from imap, imaps, pop3, pop3s
Port default ports: 143/imap, 993/imaps, 110/pop3, 995/pop3s
User user name to access mailstore
Password password to access mailstore

Max Messages |maximum number of messages to retrieve

Activity Creator |reference to activity creator for new e-mail activity
(if not specified, the default e-mail creator will be used)

Alternatively, you can automate importing of inbound e-mail by setting up a
cron job and have curl call the wizard WizardInvoker.jsp with the appropriate
parameters, e.g.

curl "http://127.0.0.1:8080/0opencrx-core-CRX/WizardInvoker.jsp?
wizard=/wizards/en_US/FetchEMail.jsp&provider=CRX&segment=Standard
&xri=xri://@openmdx*org.opencrx.kernel.activityl/provider/CRX/segment/Standard
&user=admin-Standard&password=pw_crx&para_0=Command=0K
&para_l=host=mail.mycompany.com&para_2=protocol=imap&para_3=port=143
&para_4=user=joe@opencrx.org&para_5=password=joespw&para_6=messageCount=10
&para_7=activityCreatorXri=xri://@openmdx*org.opencrx.kernel.activityl/provider/CRX/
segment/Standard/activityCreator/LASV1EAOIR1EO200JQG1L4NMI" &> /dev/null

Please note that the above command is on a single line (formatting was added
for readability purposes only). Also, you have to adapt the parameters of the
above call to your environment.
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8.3.4 Inbound E-mail with MaillImporterServlet

The following figure shows an overview of how you can import e-mails from
your mail client (MUA) into openCRX:

MaillmporterServiet

Mail Client ~ Untitled - Message (Plain TEH]E]@

! Fle Edit WView Insert Format

t:=15end || Accounts ~ | [ < |

. import@company. com
zend e-mail to be aaiRITaET,

imparted as an F e
attachment to an HhIee
emnvelope mail

3

Attach... = test message (2 KB}

Y

POP3 / POP3S f IMAP f IMAPS SMTP

Mailbox import

Mail Server

Figure 47: Import E-Mails from Mail Client

The whole setup is quite straightforward; in a first step you configure the
MaillmporterServlet so that it fetches e-mails from a mailbox, e.g. named
“import”. Optionally, you can create a custom-tailored Activity Creator to
handle imported E-mails exactly the way you like, but in most cases the
provided Default E-mail Creator is sufficient. To import an e-mail message
from your mail client into openCRX, you create a new message to be sent to
your importer mailbox, e.g. by entering import@company.com into the TO field
of the new message. Optionally you can specify the name of the Activity
Creator in the Subject of the new message. Next you attach the message(s)
to be imported to that new message (yes, you can attach multiple e-mail
messages and if those messages contain attachments themselves they will also
be imported) and send it off. Once delivered to the appropriate mailbox (called
“import” in our example) the MaillmporterServlet will fetch it from there and
then import the messages attached to that envelope message.

This process works for messages in any of your mail client's folders, e.g.
Inbox, Outbox, Sent, Trash, etc.
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See chapters 8.1.2.1 (Add resource definition(s) to openejb.xml / tomee.xml)
and 8.1.2.2 (Mail Resource in web.xml) for details on activating/configuring the
MaillmporterServlet the MaillmporterServlet. With the following steps you can
configure the MaillmporterServlet:

e log in as openCRX Root administrator (admin-Root)
o start the wizard openCRX Workflow Controller:
Administration Codes UOMs Security Realm Security
+* Administration

Edit View Actions Wizards

openCRX IMAP Server...

Configurations openCRX Workflow Controller...

P ogging figuration... Ed
Dashboard. ..

|#] |:| Hame =

o start the MaillmporterServlet (click on the respective “Turn on”);
alternatively you can also enter the following URL into your browser to
trigger the MaillmporterServlet:
http://<server>:<port>/opencrx-core-CRX/MaillmporterServlet/execute?provider=CRX&segment=Standard

« with the first invocation the MaillmporterServiet will automatically create
a new Component Configuration name MaillmporterServlet (login as
admin-Root and navigate to [Administration] > [Configurations])

) /* Administration

Edit View Actions Wizards

Configurations
L. Q HOMEE New
I D Hame =

MaillmporterServiet

e nhavigate to this automatically created Component Configuration and
create a new String Property with the name
<provider>.<segment>.mailServiceName
and the value
mail/<provider>_segment

For example, create a new String property (as shown below) with name
CRX.Standard.mailServiceName and value mail/CRX_Standard:
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Administration | Codes UOMs  Security Realm  Security Policies  Security Subjects
Administration = MaillmporterServlet - Component Configuration
Edit View Security Wizards

General  System

Name: MaillmporterServiet

Description:

Properties|  #

2] Q HONEE Mew Edit View

L I:‘ Name & Description = String wvalue = Boolean walu
ab CRX Standard. mailServiceName maill CR¥_Standard

There is no need to delete default entries as they are ignored
as soon there exists an entry with the same name without the
Tl suffix “.Default”,

Example:
Once you created the property CRX.Standard.mailServiceName

the property CRX.Standard.mailServiceName.Default will be
ignored.

Test your settings by sending an e-mail to the account specified in the steps
above (import@company.com). Attach the message to be imported to this
“envelope” e-mail (please note that the attached e-mail only is imported by the
MaillmporterServlet):

1 E-Mail - Message (Plain Text) -JoEs

i Fle Edit Wiew Insert Format Tools  Actions  Help

i i=4%end | Accounts ~ | [ S | [, | T Attach as Adobe PDF | ¥

import@company.com

Subject: E-Mailz

Attach... =] test message

any Text but not empty

Figure 48: Envelope E-Mail with attached E-Mail to be imported

Please note that neither Subject nor message body should be empty.
Use the subject to pass the name of the Activity Tracker you want the
imported e-mail to be assigned to (by default imported e-mails are
assigned to the Activity Tracker E-Mails).

Once the Workflow Controller triggers the MaillmporterServiet you will see the
debug output of the servlet on the console (or Tomcat's catalina.log):



mailto:import@company.com

openCRX Admin Guide - Version 2.12.0 E-mail Services

Listing 21: Debug Output of MaillmporterServiet

:57,810
:57,826
:58,654
158,654
:58,670
158,670
:58,701
:58,717
:58,748
:58,748
258,779
:58,842
:58,889

INFO
INFO
INFO
INFO
INFO
INFO
INFO
INFO
INFO
INFO
INFO
INFO
INFO

[STDOUT]
[STDOUT]
[STDOUT]
[STDOUT]
[STDOUT]
[STDOUT]
[STDOUT]
[STDOUT]
[STDOUT]
[STDOUT]
[STDOUT]
[STDOUT]
[STDOUT]

DEBUG: setDebug: JavaMail version 1.3.3
DEBUG POP3: connecting to host "mail.company.com", port 995, isSSL true

S:

+OK Dovecot ready.

C: USER XXXXXXXX

nNnOoOnaonaonQwn

+0OK

PASS XXXXXXXX
+OK Logged in.
STAT

+OK 1 3204
NOOP

+0K

TOP 1 O

+0OK

Tin

If the MaillmporterServlet successfully imported your test mail it will be
attached to the Activity Tracker E-Mails. Navigate to Activities > Activity
Trackers and then click on the icon of E-Mails:

Accounts

5

i Actions

Trackers

W
L]

4 Manage Activities Folders & Documents
Security Wizards
Categories Milestones  Activities
9, AOOMEE Mew Edit
Name =
E-Mails

Figure 49: Activity Tracker E-Mail is created automatically

By default, all imported e-mails are attached to the Activity Tracker
E-Mails - you should also see the successfully imported test mail in the

grid Activities

Navigate to the newly imported e-mail to load it into the Inspector.

The mail importer will automatically link imported e-mails with
corresponding objects (if they exist in openCRX) and create various
additional useful objects:

e-mail address of sender --> Sender

e-mail addresses of recipients --> Recipients
e-mail headers --> Notes

e-mail attachments --> Media

openCRX includes an Activity Creator Default E-mail Creator and an
Activity Tracker E-Mails. The latter is referenced in the grid Activity
Groups of the former:
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Tin

Home  Kontakte | Activities Pipeline Products Depots »
§ Activities = Default E-Mail Creator - Activity Creator

File Edit WView Actions Security Wizards

General | Details || System

Hame: Default E-Mail Creator iCal type:
Activity type: E-Mail=s

De=cription:

Activity Groups

Edit

L D Name Welcome Description

" E-Mailz

Figure 50: Activity Creator Default E-mail Creator

By default, the MaillmporterServlet applies this Activity Creator to
newly imported e-mails (which is the reason why they are shown in
the grid Activities of the Activity Tracker E-Mails).

You can easily change the contents of the grid Activity Groups so that
newly imported e-mails will be attached to different Activity
Tracker(s). It is also possible to create additional Activity Creators
with different behavior (just make sure that these Activity Creators
create Activities of type E-Mails). With the the subject line of your
envelope e-mail you can indicate which Activity Creator should be
used to import your e-mail. If you omit the subject line the Default
E-mail Creator is used.

Once the MaillmporterServlet works as desired you can switch off the
debugging output in the respective resource definition of the file
openejb.xml /tomee.xml (see chapter 8.1.2.1 Add resource
definition(s) to openejb.xml / tomee.xml).

E-mail Services
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8.4 Use openCRX as an E-mail Archive/Audit Tool

openCRX can easily keep track of all your e-mail traffic, inbound and/or out-
bound.

The following figure shows a configuration where the mail server puts a copy of
each received message (inbound traffic) and all sent messages (outbound
traffic) into the mailbox audit; configuring such audit accounts can easily be
done with most Mail Transport Agents (MTAs) like gmail, postfix, etc. With the
appropriate configuration (see Inbound E-mail), the MaillmporterServlet can
import all messages from that audit mailbox and attach it to an Activity Tracker
of your choice:

MaillmporterServiet

Internet

POP3 / POP3S / IMAP / IMAPS

inbound outbound
traffic traffic

Mailbox ... Mailbox audit

Mail Server

Figure 51: E-Mail Audit — import all inbound/outbound e-mail messages
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8.5 Trouble Shooting E-mail Services

The following table lists some of the common issues and how to fix them:

Problem

Solution

openCRX does not
initiate TLS session
with mail server

It seems that JavaMail sometimes does not (even try
to) establish a TLS session when connecting to a mail
server (smtp) if the certificate of the mail server has
not been imported into the keystore (e.g. cacerts). If
the mail server requires TLS for authentication (e.g.
SASL) and authentication is required to relay messages
such failure to establish a TLS session will prevent
openCRX from properly sending outbound mail.

If you intend to use TLS/SSL to secure the
connection to the outbound e-mail server

Tin (smtp) we recommend you import the mail
server certificate into the keystore.

Listing 22: Importing Certificate

cd $JAVA HOME/lib/security

keytool -import -alias <dom> -file <name>.cer -keystore cacerts

Replace <dom> with the domain of the mail server
(e.g. mail.company.com) and <name> with the name
of the certificate file.

As a quick fix you can also try to set the following
option in openejb.xml / tomee.xml:
mail.smtp.ssl.trust *
If you know the name of your mail server, you should
replace “*” by that name, e.g.
mail.smtp.ssl.trust mail.mycompany.com

I receive Alerts
triggered by my
Subscriptions but no
Notification E-mails

m verify that JavaMail is properly installed and the mail
service properly configured (see chapter 8.1 Install
and Configure Mail Resource and E-Mail Services for
more information)

m verify your e-mail settings (see E-mail Services for
details)

mverify that the Servlet WorkflowHandler of the
respective segment is turned on
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Cloud Services

9 Cloud Services

openCRX features the following cloud services:

Type of Service Standard Service Provider

Contacts LDAP openCRX/core (native provider ldap)
VCF/vCard openCRX/core (native provider vcard)
CardDAV openCRX/core (native provider carddav)
ActiveSync openCRX/core (native provider airsync)

Calendar FreeBusy openCRX/core (native provider ical)
iCalendar (ICS) |openCRX/core (native provider ical)
CalDAV openCRX/core (native provider caldav)
ActiveSync openCRX/core (native provider airsync)

E-Mail IMAP openCRX/core (native provider imap)
ActiveSync openCRX/core (native provider airsync)

Documents WebDAV openCRX/core (native provider webdav)

News/Messages RSS openCRX/core (native provider news)

XMPP (Jabber)

openCRX/core (Smack)

For information about over-the-air (OTA) synchronization of PDAs, mobile
phones, pads, etc. with openCRX please refer to chapter 10 openCRX AirSync
Server (ActiveSync compatible).

9.1 Directory Service / LDAP

openCRX provides LDAP Server functionality (get more information about
LDAP or read what Wikipedia has to say about LDAP). In a nutshell this means
that you can use any LDAP client to connect to openCRX and view openCRX
accounts. openCRX LDAP supports SSL. Here is how to connect:

Host IP address or host name of openCRX Server
Examples: localhost, 127.0.0.1, myCrxServer.myCompany.com, etc.

Port 1389 (note that the LDAP standard port is 389); if your LDAP
client supports SSL (Thunderbird does, MS Outlook does not), you
can enable SSL for increased privacy/protection. With SSL enabled
you might want to change the port from 1389 to 1689

BaseDN ou=filter/[filter name],ou=Persons
Example: ou=filter/All Accounts,ou=Persons

BindDN <principal>@ <segment name>
Example: guest@Standard
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http://www.igniterealtime.org/projects/smack/index.jsp
http://en.wikipedia.org/wiki/RSS
http://en.wikipedia.org/wiki/ActiveSync#Exchange_ActiveSync
http://en.wikipedia.org/wiki/Internet_Message_Access_Protocol
http://en.wikipedia.org/wiki/ActiveSync#Exchange_ActiveSync
http://en.wikipedia.org/wiki/CalDAV
http://en.wikipedia.org/wiki/ICalendar#Free.2Fbusy_time_.28VFREEBUSY.29
http://en.wikipedia.org/wiki/ActiveSync#Exchange_ActiveSync
http://en.wikipedia.org/wiki/VCard
http://en.wikipedia.org/wiki/LDAP
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9.1.1 Configuring the openCRX LDAP Port

The openCRX LDAP port is by default set to 1389 (to avoid conflicts with other
LDAP daemons listening on the LDAP standard port 389). You can change this
configuration in the file web.xml located in
opencrx-groupware-CRX.ear\opencrx-ldap-CRX.war\WEB-INF\

Look for the param-name port.

If you build your own EARs you can change the openCRX LDAP port in your
project's file build.properties (Idap.listenPort) or directly in your build.xml.

9.1.2 Enabling SSL Support for LDAP
With the following steps you can enable SSL support for LDAP:
« Create cert and key with OpenSSL (e.g. server.key, server.crt)

o Convert cert and key to PEM format using OpenSSL.:
Key: openssl rsa -in server.key -out server-key.pem -outform PEM
Cert: openssl x509 -in server.crt -out server-cert.pem -outform PEM

e Use a Java Keytool which allows you to a) create a keystore, b) import a
certificate, c) import a private key. The following tools allow you to easily
manage Java keystores:

- Portecle: http://sourceforge.net/projects/portecle/
KeyTool IUI: http://yellowcatl.free.fr/keytool_iui.html

o Add the following init-param tags to the web.xml of the LDAPServiet
(but don't forget to adapt the values according to your environment):

Listing 23: init-param tags required to enable LDAP SSL

<init-param>
<param-name>sslKeystoreFile</param-name>
<param-value>/var/ssl/keystore. jks</param-value>

</init-param>

<init-param>
<param-name>sslKeystoreType</param-name>
<param-value>JKS</param-value>

</init-param>

<init-param>
<param-name>sslKeystorePass</param-name>
<param-value>changeit</param-value>

</init-param>

<init-param>
<param-name>sslKeyPass</param-name>
<param-value>changeit</param-value>

</init-param>

to avoid confusion, you might also want to change the port from 1389
(LDAP for openCRX) to 1689 (LDAPS for openCRX) - see chapter 9.1.1
Configuring the openCRX LDAP Port for information on how to do that.



http://yellowcat1.free.fr/keytool_iui.html
http://sourceforge.net/projects/portecle/
http://www.openssl.org/
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9.1.3 LDAP Configuration of Thunderbird

The following steps are required to configure Thunderbird 3 for LDAP:
e start Thunderbird and select the menu Tools > Options
e select Composition and select the tab Addressing
e check Directory Server and click on the button Edit Directories

Options
H & pgEE = ¢ D

General Display Compasition Security Attachments Advanced Lightning
General | Addressing | speliing

Address Autocompletion
When addressing messages, look for matching entries in:

Local Address Books

]

Automatically add outgeing e-mail addresses to my: | Collected Addresses [V]
Figure 52: Thunderbird LDAP Configuration

in the dialog window LDAP Directory Servers click on the button Add

populate the Directory Server Properties dialog as follows (the example
entries are assuming the openCRX Server is at localhost, the provider is
CRX and the Segment is Standard, connecting with Username guest):

Field Entry Example

Name any name you like local-CRX.Standard [All Accounts]
Hostname host name or IP address localhost

Base DN ou=filter/[filter name],ou=Persons |ou=filter/All Accounts,ou=Persons
Port number |1389 1389

Bind DN <principal>@<segment name> guest@Standard

click OK to accept
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9.1.4 LDAP Configuration of MS Outlook

The following steps are required to configure MS Outlook 2007 for LDAP:
e start Outlook and select the menu Tools > Account Settings
e click on the tab Address Books

e populate the Add/Change E-mail Account dialog as follows (assuming the
openCRX Server is at localhost, connecting with Username guest):

Server Name | localhost

This server... check “This server requires me to log on”

User Name <principal>@<segment name>, e.g. guest@Standard
Password <enter your openCRX password for user guest>

click on the button More Settings and select the tab Connection

enter a display name (of your choice) and verify that port is set to 1389

select the tab Search

in the field group Search Base click on Custom and populate as follows:

Custom ou=filter/All Accounts,ou=Persons

-,

Microsoft LDAP Directory

Connection | Search
Server Settings
Search timeout in seconds: 10

Spedify the maximum number of entries you

wish to return after a successful search: 100

Search Options

Search base:
ou=filter/all Accounts,ou=Persons

Example:
cn=users,dc=exchange,dc=microsoft,dc=com

[ Ok, H Cancel ]

Figure 53: MS Outlook LDAP Configuration

e click OK, Next, Finish, and Close to conclude the configuration
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9.2 openCRX vcard Serviet

The openCRX vcard servlet does for accounts what the openCRX ical servlet
does for activities: it makes them available to third-party clients who access
the openCRX server with the http protocol.

9.2.1 Account Selectors

openCRX can map sets of accounts to a vcard file (a sequence of vcards). The
resulting vcard file can be imported and/or processed by vcard-enabled clients
like Outlook, Thunderbird, etc. At this time, account filters are the only
supported account selectors. Account filters support reading and updating, but
not creating of accounts (R=read, U=update):

Set of Accounts RUC vCard Selector

Account Filter RU accounts?id=<provider>/ <segment> /filter/ <account filter name>&type=vcf

VVCF Selector Examples:

accounts?id=CRX/Standard/filter/All+Accounts&type=vcf
accounts?id=CRX/Standard/filter/Accounts+with+missing+or+broken+vCard&type=vcf

Use the openCRX Wizard “"Connection Helper” to generate valid VCF
Selectors. You can start the wizard from your homepage:

Home Accounts Activities Pipeline Products Depots »

Tin

W User Homepages = Guest, - Home

File Edit Find View Actions Security

*Explore
Work/Expense Report...

rch Connection Helper: AirSync [ Calendar / vCard. ..

unts Timeline. . %
b arch o
Al Addrezzes =

Choose the resource role “Contact” and the selector type “Saved
Search - Accounts” and then select the desired saved search:

7

1]

Al Accountz =

B N
i

Resource
Role of resource: Contacts

Selector type: Saved Search - Accounts
Saved Search - Accounts: All Accounts

WCARD Collection s

http:/fdemo.opencrx.orgfopencre-veard- CR¥ accounts?id=CR¥/Standard/ filter/All Accounts&type=vcf

9.2.1.1 Connecting MS Outlook to the openCRX vcard servlet

Detailed instructions on how to connect MS Outlook are available from
http://www.opencrx.org/opencrx/2.4/0Outlook_ICS_VCF_adapter.htm



http://www.opencrx.org/opencrx/2.4/Outlook_ICS_VCF_adapter.htm
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9.2.1.2 Connecting Thunderbird to the openCRX vcard serviet

A Thunderbird add-on (supporting TB3 and newer) is available that enables
you to map Thunderbird address books to openCRX account selectors:

http://www.opencrx.org/opencrx/2.10/Thunderbird_Contacts_Add-on.htm

4

Write

L

Properties

4 +
Mew Contact Mew List

Address Books Mame

Impc;rt

X

Export Delete

- | Email

Aaron Thunderbird Aaronsen aaron2@host.invalid

I}/ Personal Address Book
)/ CRIXP_134_All_Accounts

&) dema (TB)
i)/ Collected Addresses

Jeff Thunderbird Dude
Roger Thunderbird Rabbit
Tim Thunderbird Jones
Tim Thunderbird Jones Jr.

r.rabbit@testhusiness. com
tim. jones @business. com
tim. jones @business. com

o =

Organization Wark Phone

Rabitts Clock Shop AG  +41 (78) 685-1235
CRIXP Corp. +41 (44) 508-9999
1000050 +41 (44) 5059999

) Edit Contact for Tim Thunderbird Jones

Contact | Private | Work | Other

ZIP/Postal Code:

Address: | [Mr.][Joe Guest][cfo CRIXF Corp.][Technoparkstr, 1]
City: | Zirich
State/Province: | ZH
Country: | Switzerland [CH]
Web Page: | http://www.opencrx.org/
Birthday: | 14-04 (%] 2002 | or |7
Contact URL:  Click here en the "E::[% pur =

8005

(04 l [ Cancel

9.3 openCRX carddav Servlet

openCRX provides CardDAV Server functionality (get more information about
CardDAV from Wikipedia or check out the RFC).

Once a user has created a Card Profile he/she can connect to openCRX with
any CardDAV client to retrieve/manage contacts.

See http://www.opencrx.org/faq.htm#CardDAVClients for a list of clients

tested with openCRX.



http://www.opencrx.org/faq.htm#CardDAVClients
http://tools.ietf.org/html/rfc6352
http://en.wikipedia.org/wiki/CardDAV
http://www.kingsmountain.com/ldapRoadmap.shtml
http://www.kingsmountain.com/ldapRoadmap.shtml
http://www.opencrx.org/opencrx/2.10/Thunderbird_Contacts_Add-on.htm
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9.4 Calendaring

9.4.1 Calendar as a Set of Activities

openCRX supports a wide range of types of activities, including E-Mails, Tasks,
Meetings, Phone Calls, etc. Even though all activities are kept in a flat structure
(think of a box containing activities), openCRX offers a multitude of ways to
structure, filter, and group activities:
e activities can be assigned to activity groups, which enables you to
group them by Tracker, Category, and Milestone
e activities can be filtered with predefined filters (e.g. activities filtered
to a user's homepage, activities filtered by resource) and user-defined
ActivityFilters (either at a global level or at the level of an activity group)

To fully understand the power of this approach, consider a large project X (e.q.
building a power plant) with millions and millions of activities. With openCRX, a
project is typically mapped to an activity tracker (e.g. all activities of project X
are assigned to the activity tracker Project X). As a large project is often times
structured, i.e. broken down into subprojects, milestones, etc., let us assume
that the respective subset of activities related to a milestone of Project X is
assigned to an activity group Milestone 2. With openCRX, it's a single click and
you can browse all the activities assigned to Milestone 2, or you can view all
these activities in a calendar application like Sunbird or MS Outlook:

Figure 54: openCRX Activity Groups / openCRX Activity Filters

It goes without saying that different users have different needs. It is also quite
natural that the needs change over time. With openCRX, it is easy to deliver as
there are virtually unlimited possibilities to slice and dice the universe of
activities. For example, instead of pulling a set of activities based on their
assignment to activity groups, there are many use cases where one would like
to define a filter to define a subset of activities. On the one hand, openCRX
features lots of default filters, on the other hand, there are powerful tools to
define custom filters virtually any way you like. For example: an auditor might
be interested in all activities involving a particular subcontractor, another user
could be interested in browsing through all the meetings related to Project X.
Hence, in the context of calendaring it helps if you think of a calendar as a set
of activities, nothing more and nothing less.
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9.4.2 Calendar Selectors (ICS and CalDAV)

openCRX can map each of the above-mentioned set of activities to a calendar.
Depending on the mapping, the resulting calendar can be presented in various
formats, e.g. ICS calendar, Free Busy calendar, XML file, Timeline, etc. Some

typical ICS calendar selectors are listed below (R=read, U=update, C=create):

Set of RUC ICS Calendar Selector

Activities

Tracker RUC | activities?id=<provider>/<segment>/tracker/<name>&type=ics

\__ Filtered RUC | activities?id=<provider>/<segment> /tracker/ <name> /filter/ <filter name>&type=ics

Category RUC | activities?id=<provider>/<segment>/category/<name>&type=ics

\__ Filtered RUC | activities?id=<provider>/<segment>/category/ <name> /filter/ <filter name>&type=ics

Milestone RUC | activities?id=<provider>/<segment>/milestone/ <name>&type=ics

\__ Filtered RUC | activities?id=<provider>/<segment>/milestone/ <name> /filter/ <filter
name>&type=ics

Global Filter RU activities?id=<provider>/ <segment> / globalfilter/ <activity filter name>&type=ics

Homepage RU activities?id= <provider>/ <segment>/userhome/ <home qualifier>&type=ics

Resource RU activities?id=<provider>/ <segment>/resource/ <resource name>&type=ics

Birthdays bdays?id=<provider>/ <segment> /filter/ <account filter name>&type=ics

Anniversaries R anniversaries?id=<provider>/ <segment> /filter/ <account filter name>&type=ics

Dates of Death |R datesofdeath?id= <provider>/ <segment> /filter/ <account filter name>&type=ics

Tin

Use the openCRX Wizard “Connection Helper” from your Homepage to
generate valid Calendar Selectors:

| Home M1 Manage Accounts £ Manage Activities ¥| Sales &3 products
% User Homepages > Guest, Joe O - Home

]
File Edit Find View Actions Security Wizards

Segment Setup...

Create Work/Expense Record...
*Contacts General Options 1 ok /Expense Report
! i e L= L] B
3 Msnzoe Accounts .’fa'ags GLUI Permissions...

=

B
ts Lustomer Lare...

vk e SOntAeE: Connection Helpjg. ArSync/CalendarivCarW
* A 5 Timeline. .. i
= Accounts (disabled) Alerts || Reminders | || Show Calendar Weekly. ..
Choose the option “Calendar” and then make your selections:
Resource
Role of resource: Events / Tasks
Based on: Home
Home: Guest, Joe O [guest]

CalDwy EventCollections

http/fdemo.opencrx.org/opencrx-caldav- CR¥CR¥/Standard/homefguest

CalDwy Task Callections

http/fdemo.opencra.org/opencrx-caldav- CR¥CRX/Standard/homefguestVTODO

ICAL Calendars

http/fdemo.opencra.org/opencrx-ical-CR¥/activities?id=CR¥/Standard/homelfguest&type=ics&max=500&disable d=false
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CalDAV calendar selectors look as follows (R=read, U=update, C=create):

Set of RUC CalDAV Calendar Selector

Activities

Tracker RUC | <provider>/<segment>/tracker/<name>

\__ Filtered [RUC | <provider>/<segment>/tracker/<name> /filter/ <filter name>

Category RUC | <provider>/<segment>/category/<name>

\__ Filtered |RUC | <provider>/<segment>/category/<name> /filter/ <filter name>

Milestone RUC | <provider>/<segment>/milestone/<name>

\__ Filtered |RUC | <provider>/<segment>/milestone/<name> /filter/ <filter name>

Global Filter | RU <provider>/ <segment>/globalfilter/ <activity filter name>

Homepage |RU <provider>/<segment>/userhome/ <home qualifier>

Resource RU <provider>/ <segment>/resource/ <resource name>
CalDAV calendar selectors return either only VEVENT items or only
VTODO items - it is not possible for a CalDAV collection (by design) to

Importalt  ~ontain both types at the same time. By default, openCRX returns
VEVENT items, if you want to get VTODO items, you can append the
suffix */VTODO"” to the above CalDAV calendar selectors. Example:
 VEVENT only: <provider>/<segment>/tracker/<name>
« VTODO only: <provider>/<segment>/tracker/<name>/VTODO
Also note that this behavior of CalDAV calendar selectors is different
from the behavior of ICS calendar selectors. The latter can return
both types of items, i.e. VEVENT and VTODO, as a reply to the same
request, whereas the CalDAV calendar selector can only return
either VEVENT or VTODO (by design of the CalDAV protocol, i.e.
this is not a choice made by the openCRX developers).
One of the consequences is that if you work with CalDAV you need to
define 2 calendars per selector with clients like Sunbird or Lightning
(one calendar for VEVENT and one for VTODO), whereas you only
need to define 1 calendar if you work with ICS (because it contains
both VEVENT and VTODO items).
Use the openCRX Wizard “Connection Helper” from your Homepage to

= generate valid Calendar Selectors:
n

Home Accounts Activities Pipeline Products Depots »
W User Homepages = Guest, - Home

File Edit Find Wiew Actions Security Wizards

Segment Sstup

*Explore Create Work/Expense Record...
WorkiExpense Report...
T Al Accounts . SEarch Connection Helper: AirSync | Calendar / wCard. ..
Acocounts Timeline. %
i o Search Dashboard. ..

" All Addressez =
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The wizard can also build URLs for CalDAV calendar collections (iPhone, etc.):

Set of RUC CalDAV Calendar Collection Selector

Calendars
Collection RUC | <provider>/<segment>/user/ <principal name>/profile/ <profile name>

Exam ple . http://demo.opencrx.org/opencrx-caldav-CRX/CRX/Standard/user/guest/profile/MyCals

By default, at most 500 activities (VEVENT or VTODO) are returned
per request by the ical (caldav) servlet. You can increase that limit by

Imporiait 55 admin-Root) creating component configurations with name and
qualifier ICalServilet (CalDavServlet, respectively) and then
adding a String property named maxActivities with the desired
value, e.g. 5000 as shown below:

Administration UQMs Codes Security Realm Security Policies
« Administration

Edit View Actions Wirards

Configurations

+ EOEE Mew Edit View
M ] Name =
orkdlowConiroller
M ICalServist
B | o EEEE Mew  Edit
M L] NHame - Description =  Domain = String value
®  mexAddivities 5000

i |
M Mame =

ah mpBxA ctivities

CalDavSarviaet

. i I I O Mew Edit \
Description = Domain = String valus
5000



http://demo.opencrx.org/opencrx-caldav-CRX/CRX/Standard/user/guest/profile/MyCals

openCRX Admin Guide - Version 2.12.0 Cloud Services

9.4.3 ActivityTracker/-Creators <username>~Private

Each openCRX user has a private Activity Tracker <username>~Private (e.g.
guest~Private for the user named guest) and several private Activity Creators:

<username>~Private (to create Incidents)
<username>~Private E-Mails (to create E-Mail Activities)
<username>~Private Meetings (to create Meetings)
<username>~Private Tasks (to create Tasks)

Activities created with one of the above Activity Creators are
automatically assigned to the respective user's Activity Tracker
<username>~Private and security is set such that only the
respective user can read/write such activities.

Tin

See also chapter Error: Reference source not found Error: Reference source
not found for information on how to manage privacy at the event-level.

9.4.4 Mapping of Activities to Calendar Events and Tasks

Both the openCRX ical servlet and the openCRX caldav servlet map openCRX
activities to calendar events (VEVENT) and tasks (VTODO) as follows based on
the openCRX activity class and the iCal type at hand:

openCRX Activity Class iCal Type Mapped to

* (any) VEVENT VEVENT
* (any) VTODO VTODO
Incident Automatic VEVENT
Meeting Automatic VEVENT
Sales Visit Automatic VEVENT
Task Automatic VTODO
Phone Call Automatic VEVENT
E-Mail Automatic VEVENT
Mailing Automatic VEVENT
Absence Automatic VEVENT
External Activity Automatic VEVENT

The openCRX AirSync Adapter uses a different mapping (see chapter

10.2 Mapping of openCRX Objects to AirSync Objects for details).
Tin

Hence, all openCRX activities correspond to either calendar events (VEVENT) or
tasks (VTODO). An openCRX activitiy's iCal representation is stored in the iCal
attribute:
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1t 1000100 : Presentation XYZ - Incident

File Edit View

iCal:

BActions  Security

[ BEGIN:VCALENDAR

PRODID:AOPENCREANONSGML Version 1/EN
WERSION:2.0

BEGINVEVENT

UID; cBeffall-eb54-11dc-20b1-dbS5e55asca
CLASS.PUBLIC

DTSTART. 200280306 T200000Z2
DTEND:20030308T220000Z
DUE,WALUE=DATE. 55951231
LAST-MODIFIED: 20080306TO081221Z
LOCATION:crx Headquarter

DTSTAMP 20080306T081 2212
DESCRIFTION:new widget

SUMMARY Presentation X' Z & #1000100
PRIORMY:2

ENDXWVEWENT

L ENDAWCALENDAR

Figure 55: An openCRX activity's iCal representation

In the openCRX standard GUI the same activity is presented as follows:
*t 1000100 : Presentation XYZ - Incident

File Edit View

Name:

Activity number:
Dezcription:
Azzigned to:
Mizcellaneous #1:
Mizcellansous #2:
Mizcellaneous #3:

Activity type:
Last Tranzition:

Proces=s =tate:
mchdent Mansgement
Reporting account:
Reporting contact:

Customer =atizfaction:

Location:

Detailed description:

BAetions Security

Presentation XYZ State:

1000100 Pricrity:

new widget Severity:
guest, Scheduled start:

Scheduled end:

Scheduled end (original):

Due by:
Bugs + Features % complete:
A=zs=ign Actual =tart:
In Progress Actual end:

Incident type:

admin-5Standard, Incident origin:
MiA Reproducibility:

crx Headquarter i= all day event:

X

E Open

[4] Urgent
Ni&
3612008 9:00:00 PM
J6/2008 11:00:00 PM

12/31/9999 1:00:00 AM

20
3612008 9:11:49 AM

NiA
NiA
NiA

Figure 56: An openCRX activity in the standard GUI
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9.4.4.1 Conversions between VEVENT and VTODO

Many calendar applications differentiate between events (entries in a calendar
with well-defined start and end date) and tasks or to-dos (entries in a task list
with a well-defined due date). openCRX also supports this distinction and can
even convert activities from VEVENT to VTODO and vice versa without loss of
information. To convert an openCRX activity from one type to the other, edit
the activity and change the value of the iCal type dropdown:

iCal type: : Automatic iv]
iCal: Automatic

VEVENT %

VTODO

BEGIN:VEVENT
UID:fdb9330a-a774-11dc-93d1-a9d3ecf236d9

Figure 57: iCalendar conversion between VEVENT and VTODO

9.4.5 Calendaring / Free Busy

Free Busy is part of the iCalendar standard (RFC 2445) for calendar data
exchange (see also Wikipedia). Many calendar clients rely on this information
for group scheduling. openCRX can derive free busy information on-the-fly
from the respective activities; as most clients do not support authentication
the default configuration of the openCRX ical servlet does not require
authentication to retrieve Free Busy information. However, the principal guest
must exist (but you can disable the login):

Free Busy URL (without authentication, requires openCRX principal guest):
http://<crxServer>: <Port>/opencrx-ical-<Provider>/freebusy
?id=<Provider>/<Segment>/<Calendar Selector>

Example:
http://localhost:8080/opencrx-ical-CRX/freebusy?id=CRX/Standard/userhome/guest

Please note that free busy information is provided by the openCRX server in a
read-only fashion (i.e. free busy clients cannot update such information).

Instead of the user name you can also provide the e-mail of the
respective user, for example

Tip http://localhost:8080/opencrx-ical-CRX/freebusy?
id=CRX/Standard/userhome/guest@opencrx.org

If you prefer authentication for Free Busy clients you can add the
url-pattern /freebusy to the web-resource-collection (in the file

o web.xml of the ical servlet).

openCRX calculates/derives the free busy information for each activity on the
fly based on the following algorithm:



http://en.wikipedia.org/wiki/ICalendar#Free.2Fbusy_time_.28VFREEBUSY.29
http://en.wikipedia.org/wiki/Calendar
http://tools.ietf.org/html/rfc2445
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If the requesting user has at least one resource assignment with
workingUnitPercentage > 0 then TRANSP=0OPAQUE, otherwise
TRANSP=TRANSPARENT.

TRANSP is managed by the CalDAYV, ICS and FREEBUSY servlets. The attribute
TRANSP TRANSP is mapped to the activity's assigned resources.

See http://www.opencrx.org/faq.htm#FreeBusyClients for a list of clients
tested with openCRX.

9.4.5.1 Free Busy Configuration of Thunderbird/Lightning

Thunderbird supports free busy if the following add-ons are installed:
e Lightning (at least v1.0)
e Free/Busy (at least v2.0)

For detailed information on how to configure Thunderbird's Free/Busy add-on,
please refer to the information provided by the respective developer. With
version 2.0 of this add-on one can specify a pattern for both e-mail addresses
and URLs to retrieve the free busy data from:

Example:
e-mail address pattern: *@opencrx.org
URL pattern: http://demo.opencrx.org/opencrx-ical-CRX/freebusy?id=CRX/Standard/userhome/*

When contact email matches | Si@opencra.org | FE URLis | http://demo.opencrx. orgfopencri-ical-

Logaing
[] Enable logging  Log file path

[ K l [ Cancel

Figure 58: Configuration of Thunderbird's FreeBusy Add-on



mailto:username@opencrx.org
https://addons.mozilla.org/en-us/thunderbird/addon/freebusy/
http://www.mozilla.org/projects/calendar/lightning/download.html
http://www.mozillamessaging.com/
http://www.opencrx.org/faq.htm#FreeBusyClients
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Once the Free/Busy add-on is configured, it will retrieve free busy information
directly from your openCRX server whenever you invite attendees:

-

Invite Attendees

Suggest time slot: 49 Next slot & Zoom: =3 | 100% hdl

Thursday, September 23, 2010 Friday, September 24
07:0008:0009:0010:0012:0012:00 13:00 14:00 15:00 16:00 17:0018:00 1900 20:0007:0003:0009:00 10:00 1
9 s 7R 520 v 7 P
A guesti@opencrx.org
E|
< o
?,  Required Attendee Free Mo Information [] all day Event
#,  Optional Attendee M Tentative
u%n Chair BN Eusy From |23-09-2010 hdl 18:00
Man Participanit I Cut of Office To 23-09-2010 | 13:30
Previous hour ] [ Mext hour

[ QK l [ Cancel

Figure 59: Inviting Attendees with Thunderbird using free busy information

9.4.5.2 Free Busy Configuration of MS Outlook

See http://support.microsoft.com/kb/291621. Please note that Outlook does
not support SSL with free busy.

9.4.5.3 Free Busy Information as an ICS calendar

It is also possible to view the free busy information in the form of an ICS
calendar. This may be useful for users who frequently plan events on behalf of
another user without access to the full calendar of that person. Given a free
busy URL you simply add &type=ics to retrieve the respective ICS calendar:
Free Busy URL as an ICS calendar:
http://<crxServer>:<Port>/opencrx-ical-<Provider>/freebusy
?id=<Provider>/<Segment>/<Calendar Selector>&type=ics

Example:
http://localhost:8080/opencrx-ical-CRX/freebusy?id=CRX/Standard/userhome/guest&type=ics

The free busy ICS calendar is read-only and the title of events is set to ***,
description and location are not available for privacy reasons.
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9.4.6 Calendaring / iCalendar (ICS)

iCalendar is implemented/supported by a large number of products (see

RFC 2445 or Wikipedia for information about the iCalendar standard,
sometimes referred to as “iCal”). openCRX can derive iCalendar information
on-the-fly from the respective activities. iCal clients must authenticate to read
and/or write iCalendar data.

ICS URL (with authentication):

http://<crxServer>:<Port>/opencrx-ical-<Provider>/activities
?id=<Provider>/<Segment>/<Calendar Selector>&type=ics

Example:
http://localhost:8080/opencrx-ical-CRX/activities?id=CRX/Standard/tracker/main&type=ics

See chapter 9.4.2 Calendar Selectors (ICS and CalDAV) for

. information on how to construct calendaring URLs.

n

Please note that calendars without “"C” (create) in the table provided
in chapter 9.4.2 Calendar Selectors (ICS and CalDAV) do not support
creation of new events/tasks with external ICS clients. The reason
being that without a well-defined ActivityCreator associated with the
respective calendar selector it is not possible to create an activity and
assign it to the appropriate activity groups.

Important

While the mapping of most of openCRX's activity attributes to iCal attributes is
obvious, the following hints might still be helpful:

VEVENT:

o Activity.disabled==true --> STATUS:CANCELLED

o Activity.percentComplete== --> STATUS:TENTATIVE

e percentComplete>0 --> STATUS:CONFIRMED
VTODO:

o Activity.disabled==true --> STATUS:CANCELLED

o Activity.percentComplete== --> STATUS:NEEDS-ACTION

e Activity.percentComplete>0 --> STATUS:IN-PROCESS

e Activity.percentComplete==100 --> STATUS:COMPLETED

Please note that Activity.percentComplete cannot be changed upon import of a
vCard as openCRX activities are managed by activity processes. Hence,
changing the status of an activity outside of openCRX does not change the
status of this activity in openCRX (even if it is reimported).
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9.4.6.1 ICS Configuration of Thunderbird/Lightning and Sunbird

Thunderbird with the Lightning add-on (or Sunbird, the stand-alone client) is a
fully-fledged calendar client. Creating a remote calendar (hosted on your
openCRX server) is rather straightforward:

start Thunderbird/Lightning or Sunbird

select the menu File > New Calendar

in the dialog window Create New Calendar you select On the Network
then you select iCalendar (ICS)

enter an ICS URL into the field Location;

example: the user guest would connect to this openCRX homepage with the URL
http://127.0.0.1:8080/0opencrx-ical-CRX/activities?id=CRX/Standard/userhome/guest&type=ics

See chapter 9.4.2 Calendar Selectors (ICS and CalDAV) for information
on ICS URLs

give your calendar a name and pick a color of your choice

That's it. You are connected to openCRX:

esentation %YZ Jf
00100

Title: Presentation ¥YZ jf #1000100
Location: corx Headguarter
Date: Thursday, March 06, 2008 21:00 - 23:0

new widget

ﬁﬁﬁﬁﬁ |
Thunderbird/Lightning and Sunbird require a life connection to openCRX (i.e.
no support for offline viewing/editing) unless you enable the experimental
Cache of Ligthning/Sunbird.

9.4.6.2 ICS Configuration of MS Outlook

Out of the box Redmond's “flagship” MS Outlook does not offer you much
choice with ICS calendars. You are stuck with one of the following 2 options:
e Published Calendars
are local calendars published to a remote location, but there is no sync
with that remote calendar (i.e. changes to the remote calendar will never
automatically make it back into your Outlook)
e Internet Calendar Subscription
These calendars are striclty read-only in Outlook, i.e. not very useful...
Not to leave you out in the rain, we put together a bunch of VBA scripts that
teach your Outlook a few new tricks. The scripts and detailed instructions for
both MS Outlook 2003 and MS Outlook 2007 are available from
http://www.opencrx.org/opencrx/2.4/0utlook_ICS_VCF_adapter.htm
i~ Calendar - Microsoft Qutlook

File Edit Wiew Go Tools Acions Help Funambol Adobe PDF

HH New - = | = B | [ Searchaddressbocks - | (@ _ &Ics.getCalt%dars & ICS. putCalendars =
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9.4.6.3 ICS Configuration of Zimbra

Zimbra (v7.1) does not offer you much choice with remote ICS calendars. It is
possible to subscribe to a remote calendar, but in read-only mode and https
does not seem to be supported; furthermore, only a minimal set of iCal
attributes is actually visible in the Zimbra calendar. Nevertheless, here is how
to subscribe:

e connect to your Zimbra server and login

e click on the tab [Calendar]

e click the button [New Calendar] and then populate the dialog as follows:
Create New Calendar

Name: | openCRY Test Cal

Color: | Blue =

[ ] Exdude this calendar when reporting free /busy times

Synchronize appointments from remote calendar

JRL: | http:/juser:password @demo, opencrx. org opencrx-ical-CF

K. | Cancel |

Please note that the ICS URL in the field URL must also include
your openCRX user name and password because Zimbra does

Important 1\t really manage your remote credentials.

9.4.6.4 ICS Configuration of iPhone

With iPhone 0S3.0+ you can connect to any remote ICS calendar (read-only)
as follows:

on your iPhone home screen, tap the icon Settings
tap on Mail, Contacts, Calendars

tap on Add Account...

tap on Other

tap on Add Subscribed Calendar

enter or paste the ICS URL into the field Server

tap [Next] to verify the account information

If you get a message “Cannot Connect Using SSL"” tap [No] to
move on to the next screen where you can enter the connection
o details.
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e verify/complete your subscription information as follows:

_ .-.I“ = . —

Server

Description

Username
Password
Use SSL

verify the ICS URL

My openCRX calendar

. | Account '
any text you like - o )
(defaUIt is the ICS URL) Subscribed Calendar Information

your openCRX user name Server 'RO1&resource=activities.icq |
your OpenCRX paSSWOrd | Description My openCRX calendar |

if you use SSL, set to [ON],

otherwise [OFF]

Remove Alarms as you prefer

e tap [Next]
if you use SSL in combination with a self-signed certificate, you will get a
message Unable to Verify Certificate --> tap Accept

if everything works out, you can tap Save to store the settings and your
calendar will be available in the Calendar App from the iPhone's home

g3

screen

a|wle|r|T|v|u|i]o]r
Als|ojrfafulJfk]L

QEEEIENNG

return

This ICS calendar feature is particularly useful to connect your iPhone
to a birthday calendar generated by openCRX (use the wizard
“Connection Helper” to calculate the URL (server name respectively)
for any desired Account Filter:

Role of regource:
Baszed on:
Account Filer

CHEAANT Optins.

CGenerate:

iCal type:
Categories:
Summany prefoc
Wax FAccounts:
Year Y

FrE o e BRIV AMAC L

Calendar

il OrangeCH o 14:14 B5 % [

Account Filter / Birth Date
Al Accounts

Birthdays [from Contacts)
VEVENT
Birthday
BOAY

£ e Conponen-Corfiguration of e 1Al

Subscribed Calendar Information

Server iday&summaryPrefix=BDAY

Description BDAY

Username guest

Password esessssss

URL: hitp:fdemo.opencrocorgfopencre-ical- LR bdays ¥id=CRXStand ard/ filerfAll+vAccounis Bsummary Prefucs BOAY
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9.4.6.5 Deleting Events

The openCRX ICS Adapter does not support deleting events (because deleting
objects is typically not an acceptable operation in an enterprise environment).
openCRX does support disabling of objects, however. If there is a need to
disable events directly from your ICS Client, here is how to do it:

e Assuming you have a remote calendar CAL with the URL <U> defined in
your ICS client, define a new remote calendar CAL-trash with the URL
<U>&disabled=true (i.e. append the string “&disabled=true” to the
URL); the name of the calendar is not important, we just call it
“CAL-trash” to indicate that it contains disabled activities.

example:
existing calendar CAL (showing only events that are not disabled) with the URL

http://127.0.0.1:8080/0opencrx-ical-CRX/activities?id=CRX/Standard/userhome/guest&type=ics

the URL of the calendar CAL-trash showing events that are disabled is
http://127.0.0.1:8080/0opencrx-ical-CRX/activities?id=CRX/Standard/userhome/guest&type=ics&disabled=true

e to delete an event of your calendar CAL, move the event from the
calendar CAL to the calendar CAL-trash

9.4.6.6 iCalender Guard Event

If you retrieve an iCalender from the openCRX ICS Adapter, the very first event
is a so-called Guard Event:

e the Guard Event is always the first event delivered by the ICS Adapter

e the attribute SUMMARY corresponds to the Calendar-ID (UID of the
Guard Event)

e the attribute DTSTART is set to 19000101T000000Z

The openCRX ICS Adapter supports the creation of new events/tasks as long as
a calendar's Guard Event is posted to the adapter together with the new
event/task. The openCRX ICS Adapter also verifies the UID of the Guard Event.
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9.4.7 Calendaring / CalDAV

CalDAV is implemented/supported by a growing number of products (see
http://caldav.calconnect.org/ or Wikipedia for information about the CalDAV
standard). openCRX is a fully-fledged CalDAV server; the functionality is
implemented by a native CalDAV servlet. CalDAV clients must authenticate to
read and/or write CalDAV data.

CalDAV URL for individual calendar:

http://<crxServer>: <Port>/opencrx-caldav-<Provider>/<Provider>/<Segmen
t>/<Calendar Selector>

Example:
http://localhost:8080/opencrx-caldav-CRX/CRX/Standard/tracker/main

CalDAV URL for CalDAV calendar collection:

http://<crxServer>:<Port>/opencrx-caldav-<Provider>/<Provider>/
<Segment>/user/<principal name>/profile/<Calendar Profile>

Example:
http://localhost:8080/opencrx-caldav-CRX/CRX/Standard/user/guest/profile/MyCals

See chapter 9.4.2 Calendar Selectors (ICS and CalDAV) for
information on how to construct calendaring URLs. The easiest way to

L construct CalDAV URLs is to use the openCRX Wizard “"Connection
Helper” from your Homepage.

Please note that calendars without “C” (create) in the table provided
in chapter 9.4.2 Calendar Selectors (ICS and CalDAV) do not support
creation of new events/tasks with external CalDAV clients. The reason
being that without a well-defined ActivityCreator associated with the
respective calendar selector it is not possible to create an activity and
assign it to the appropriate activity groups.

In the case of calendar collections/profiles, it depends on the feed
whether the respective calendar supports activity creation or not. If
openCRX can determine a well-defined ActivityCreator, activity
creation is supported, otherwise not.

Important

Beware of CalDAV clients that do not provide feedback if a write
) operation did not succeed (the iPhone is unfortunately not very
Waminu  ,ser-friendly in that respect). If you create a new event (or change an
existing one) with your CalDAV client and the write operation does not
succeed, you might still see your new event (or the changes to the
existing event respectively) in your CalDAV client but such data is not
available on the server!



http://en.wikipedia.org/wiki/Caldav
http://caldav.calconnect.org/
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9.4.7.1 CalDAYV Collections

Some CalDAV clients (e.g. Apple's iPhone, CalDAV-Sync for Android) support
CalDAV collections. With openCRX you can define CalDAV collections as
follows:

e nhavigate to a user's homepage

e click on the tab [Sync Profiles] and select New > Calendar Profile:

M Home A1 Manage Accounts b Manage Activities ) Sales 3% Products Depots \ Folders & Documents =

1
1
y M User Homepages = Guest, joa 0 - Home

File Edit Find View Actions Security Wizards

1

1

1

1

:'Corlt.ud: Seneral || Options || System | ¢

: 11 Manage accounts

| = AOgounts Cantact: Guest, Joe O

1 = Account Groups

1= A Acoounts

: = Becounts (disabled) Aderts | | Reminders || Subscriptions || Servioe Acoounts | | Pending | Completed Workfiows | | History | | Faworibes | Media || Dbject Finders | | Sync Profiles

:'Supplort - Q, BLHEONE Mew Edit Actions View

: 2 Bugs + Faatures ¥ Hame = B Sync Pralie DesLription =
s B Bty

' New Aclivity BArSync ‘El.ﬁ.'i"l:': anl Pralie

| ol Beiers 4+ Faabiis

U e - features " MyCais " Catendar Prafie k

1 i - rd Prafille ¥

L - -

e enter at least a name for your new collection, e.g. MyCals, and then
click [Save]

e navigate to this new calendar profile and then add the desired feed(s),
e.g. an Activity Tracker or an Activity Filter, as follows:

e select New > Activity Group Calendar Feed as shown below:
M Home 01 Manage Accounts & Manage Activities ®) Sales %5 Products Depots - Folders
) " User Homepages = Guest, joe O = MyCals - Calendar Profile

Edit Wiew Security Wizards

SpacerDashlet M
General || System |

Marme: MyCals

Des.evip it

i
% Bugs + Feabures

= A tivities

Sync Feeds |Actiee and Assigned] || A0 Sync Fesds ||

*Workspaces W = OEOmEE Mew Edit Actions View
Defaul ¥l Active = Hame = tiow adel [ debete | A1 Cantacts Fesd
o v- Bugs and Featurnes e ah Activity Group Feed
o v- quest—Private v T Feed Saved Seanch At MNTes

) Docurment Feed
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e select an activity group and enter at least a name for this feed and
mark it as active (some CalDAV clients support coloring, i.e. you
can optionally also enter color information):

Untitled - Activity Group Calendar Feed

General | System *

Mame: Bugs and Features Active:

Desoription:

Color font: Color badkground: #I:I:F.d.EI:Il

Activity group: Bugs + Features [Bugs + Features] -
Save| | Cancel

e click [Save]
e optionally, add more feeds (you can also add additional feeds later)

9.4.7.2 CalDAV Configuration of Thunderbird/Lightning and Sunbird

Thunderbird 10.x with the Lightning add-on (at least version 1.2.1) is a
fully-fledged calendar client. Creating a remote calendar (hosted on your
openCRX server) is rather straightforward:

start Thunderbird/Lightning

select the menu File > New Calendar

in the dialog window Create New Calendar you select On the Network
then you select CalDAV

enter a CalDAV URL into the field Location;

example: the user guest would connect to this openCRX homepage with the URL
http://127.0.0.1:8080/0opencrx-caldav-CRX/CRX/Standard/userhome/guest

See chapter 9.4.2 Calendar Selectors (ICS and CalDAV) for information
on CalDAV URLs

Note: Lightning does not support CalDAV Collections, i.e. you must
create a new Lightning calendar for each openCRX calendar...

give your calendar a name and pick a color of your choice
that's it — you are connected to openCRX

9.4.7.3 CalDAV Configuration of MS Outlook

MS Outlook does not support CalDAV. There are third-party extensions you
might want to try. Some of them are listed at
http://wiki.davical.org/w/CalDAV_Clients/Outlook.

See also http://www.opencrx.org/opencrx/2.4/0Outlook_ICS_VCF_adapter.htm



http://www.opencrx.org/opencrx/2.4/Outlook_ICS_VCF_adapter.htm
http://www.opencrx.org/opencrx/2.0/Outlook_ICS_adapter.htm
http://wiki.davical.org/w/CalDAV_Clients/Outlook
http://www.mozilla.org/projects/calendar/lightning/download.html
http://www.mozilla.com/en-US/thunderbird/
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9.4.7.4 CalDAV Configuration of iPhone (0S3.0+, i0S4+, i0S5+)

Connect to any openCRX calendar collection as follows with your iPhone:

connect to openCRX and navigate to the desired calendar collection
start the wizard Connection Helper: AirSync / Calendar / vCard from
your openCRX homepage:

Home Accounts Activities Pipeline Products Depots »

W User Homepages = Guest, - Home

k

File Edit Find View Actions Security Wizards

*Explore Create W
Work/Expense Report...
i S ; Search Gonnection Helper: A { Galendar / wCard
All Accounts = per: AirSyns / riw
Acoounts Timeline. .. %
T Search Diashboard. ..

Al Addrezzez  *

this wizard “calculates” the CalDAV URL required to connect:

Role of resource: Calendar [V]
Based on: CalDAV Calendar Profile [V]
Calendar Profile: MyCals {Calendar} [Guest, Joe O /guest] [V]
Calendar Options

Generate: activities (from Activities) [V]
Type: CalDAV [""]
Hint: you can set MaXACtivVities in the Component-Configuration of the ICalServiet (default is 500)

ﬂJRL: hitp:f'demo.opencre.orglopencri-caldav-CRYCREX/StandardiuserfguestiprofileMyCals ]

copy the above URL (you'll need to paste it later)
on your iPhone home screen, tap the icon Settings
tap on Mail, Contacts, Calendars _allOrangeCH = 13:14 E2LES,
tap on Add Account...
tap on Other

tap on Add CalDAV Account P s i

and then enter or paste the CalDAV URL into User Name guesf|
the field Server and populate the fields User
Name and Password as shown below:

tap [Next] to verify the account information

Enter your CalDAV account information

“cancel CalDAV

Password eeese

Description demo.opencrx.org

If you get a message “Cannot Connect Using SSL” tap [No] to
move on to the next screen where you can enter the connection
T details.
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e verify/complete your subscription information as follows:

_ | = — N . - m

Server verify the server name
User Name your openCRX user name Account o
Password your openCRX password Wi e B e
Description any text you like e A
Use SSL if you use SSL, set to [ON], | serhame ouest

otherwise [OFF] Password eeese
Port port number (Tomcat) Description demo.opencrx.org
Account URL the CalDAV URL

Advanced Settings >
_allOrangeCH = 13:29 64%

.demo.opencrx.'.,. Ad

Use SSL | OFF
Port 80

Account URL nttpy/demo.opencrx.org...

e if you use SSL in combination with a self-signed certificate, you will get a
message Unable to Verify Certificate --> tap Accept

e if everything works out, you can tap Save to store the settings and your
calendar will be available in the Calendar App from the iPhone's home
screen

Unfortunately, neiter iPhone OS3.0+ nor iOS 4.0+ supports Tasks
over CalDAYV, i.e. you will only see openCRX Activities of type VEVENT

Important i\ vour iPhone calendar. Tasks are supported since iOS5.

9.4.7.5 CalDAV Configuration of Android devices

Android does not support CalDAV out of the box, but there are applications
available from the Android Market (search for “"CalDAV” in the Android Market
to locate them). We have tested “"CalDAV-Sync” and it works reliably. It even
supports CalDAV collections, so it's fairly easy to configure (see 9.4.7.1 CalDAV
Collections for more information).



https://market.android.com/details?id=org.dmfs.caldav.lib
https://market.android.com/
https://market.android.com/
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9.4.7.6 Deleting Events

The CalDAV protocol supports deletion of events/tasks. openCRX honors such
requests, although the respective activity is disabled and not deleted. If you
absolutely want to delete an activity you can do so with the openCRX standard
GUI.
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9.4.8 Calendaring / Timeline

Timeline is an extremely interesting DHTML-based AJAX widget for visualizing
time-based events. It is like Google Maps for time-based information. A live
example is available at http://www.simile-widgets.org/timeline/

®» STMILE. * Timeline

Timeline

Timeline iz a DHTML-bazed AJAXv widget for visualizing
time-baszed events. It iz like Google Maps for time-based
information, Below iz a live example that vou can play with, Pan
the timeline by dragging it herizontally.,

@ man with seizure in front of TSED @ wita
sising motorcade area @ Kennedy shot
y wan with rifle seen in TSED @ Washington D.C's
¥ TSED sixth floor empty @ Cswald leaves 1
) Oswald s=2an having lunch @J

@ Police radio for ambulance
@ williams left sth floor
@ Officers ordered to ™

Timedine

11:00 12:00 1300

Simile

LIMKS
® |ive Examgples
# Documentstion

O The Basics
0 How to Create Timelines
0 Mor=...

® Brows== the Cod=
® [ssum Tracksr
RELATED PROIECTS

® Time=plot
®  Echibit

Figure 60: Timeline visualizes time-based events

CrxObjects with sets of activities (e.g. Userhome, Activity Groups, Activity
Filters, etc.) typically feature the wizard Timeline. Simply call that wizard to
construct a timeline to visualize activities right in your browser:

& guest, - My Homepage

File Edit Find View  Actions Security  Wizards

Timeline. [

General | Charts | Optiens | System
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9.5 Mailstore / IMAP

Instead of offering platform specific plugins for a multitude of mail clients like
MS Outlook, MS Outlook Express, Thunderbird, Evolution, Eudora, EIm, etc.
openCRX features a platform neutral IMAP adapter (get more information
about IMAP or read what Wikipedia is saying about IMAP). The advantages of
such a standardized IMAP adapter are:

e works with any IMAP client (including your favorite one)

e no clumsy installation of plugins, i.e. you can get this to work on your
company's laptop regardless of how “hardened” and locked down the
system is

e supports single message import and bulk import

imports headers, body, and attachments
e automatically creates references to sender and recipient(s) if the
respective e-mail addresses are present in openCRX

In a nutshell this means that you can use any IMAP client to connect to
openCRX and view openCRX EMailActivities. openCRX activity groups are
mapped to IMAP folders. The folders contain openCRX EMailActivities.

Viewing/exporting of EmailActivities is always possible, creating/updating of
EmailActivities requires that an E-Mail Activity Creator is defined for the
respective Activity Group, and deleting of EmailActivities is not supported.
Please refer to chapter 8.3.1 Inbound E-mail with IMAP Adapter for details.

If you move an e-mail message from a non-openCRX IMAP folder to
) an openCRX IMAP folder and the target folder does not have a valid

Waminu  F_Mail Activity Creator defined, openCRX will not be able to create an
EMailActivitiy in that folder. Due to the move operation the message
is deleted from the source folder and your e-mail message is lost.
Hence, it is good practice to copy (and not move) e-mails to openCRX
IMAP folders. Only after verifying that the EMailActivitiy was actually
created by openCRX in the target folder should you delete (if
necessary) the message from the source folder.

E-mail addresses should be unique!

mporiam 1T YOu import e-mails into openCRX with the IMAP Adapter, openCRX
tries to match sender and recipients based on e-mail addresses. For
obvious reasons, this will produce unexpected (if not undesired)
results if e-mail addresses in openCRX are not unique.

You can test your openCRX database for duplicate e-mail addresses
with the following query:

SELECT email_address, count(*)
FROM OOCKE1_ADDRESS
GROUP BY email_address HAVING count(*) > 1

— 100 —
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Since openCRX v2.9.1, unknown e-mail addresses are created as
composites of the segment administrator, e.g. admin-Standard.

The following information is required to connect an IMAP client to openCRX:

Host IP address or host name of openCRX Server
Examples: localhost, 127.0.0.1, myCrxServer.myCompany.com, etc.
Port 1143 (note that the IMAP standard port is 143)

User name <login principal name>@<Segment>
Example: guest@Standard

Password | principal's openCRX password

The openCRX IMAP adapter supports SSL. It is probably a good idea
to make use of that feature and connect your IMAP client securely to

o openCRX. See chapter 9.5.3 Enabling SSL Support for IMAP for more
information.

9.5.1 Configuring the openCRX IMAP Port

The openCRX IMAP port is by default set to 1143 (to avoid conflicts with other
IMAP daemons listening on the IMAP standard port 143). You can change this
configuration in the file web.xml located in the directory
opencrx-core-CRX\opencrx-imap-CRX\WEB-INF\

Look for the the param-name port.

If you build your own EARs you can change the openCRX LDAP port in your
project's file build.properties (imap.listenPort) or directly in your build.xml.

— 101 —
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9.5.2 Configuring the IMAP Maildir Cache

For increased performance the openCRX IMAP Adapter works with a cache. The
location of this cache, the so-called Maildir, can be set as a JAVA_OPTS.

You can reset the cache by deleting it. The openCRX IMAP Adapter

will recreate the cache automatically.
Tin

9.5.2.1 Maildir Configuration with Apache Tomcat

Add the option -Dorg.opencrx.maildir="%CATALINA_HOME®%\maildir" to the
JAVA_OPTS in your Tomcat start batch file (e.g. tomcat.bat, run.sh, etc.).

9.5.3 Enabling SSL Support for IMAP
With the following steps you can enable SSL support for IMAP:
» Create cert and key with OpenSSL (e.g. server.key, server.crt)

o Convert cert and key to PEM format using OpenSSL.:
Key: openssl rsa -in server.key -out server-key.pem -outform PEM
Cert: openssl x509 -in server.crt -out server-cert.pem -outform PEM

e Use a Java Keytool which allows you to a) create a keystore, b) import a
certificate, c) import a private key. The following tools allow you to easily
manage Java keystores:

- Portecle: http://sourceforge.net/projects/portecle/
KeyTool IUI: http://yellowcatl.free.fr/keytool_iui.html

e Add the following init-param tags to the web.xml of the IMAPServlet
(but don't forget to adapt the values according to your environment):

Listing 24: init-param tags required to enable IMAP SSL

<init-param>
<param-name>sslKeystoreFile</param-name>
<param-value>/var/ssl/keystore. jks</param-value>

</init-param>

<init-param>
<param-name>sslKeystoreType</param-name>
<param-value>JKS</param-value>

</init-param>

<init-param>
<param-name>sslKeystorePass</param-name>
<param-value>changeit</param-value>

</init-param>

<init-param>
<param-name>sslKeyPass</param-name>
<param-value>changeit</param-value>

</init-param>

to avoid confusion, you might also want to change the port from 1143
(IMAP for openCRX) to 1443 (IMAPS for openCRX) - see chapter 9.5.1
Configuring the openCRX IMAP Port for information on how to do that.
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9.5.4 IMAP Configuration of Thunderbird

The following information is required to configure an IMAP account:

Email account

<login principal name>@<Segment>
Example: guest@Standard

Password

openCRX password of the respective principal

Your name

<login principal name>@<Segment>
Example: guest@Standard

Email Address

your e-mail address
Example: guest@mycompany.com

Type of server

IMAP

Incoming Server
Outgoing Server

name or IP address of your openCRX server
Example: 127.0.0.1

Port

1143

Incoming User Name

<login principal name>@<Segment>
Example: guest@Standard

= guest@Standard

Account Settings
== Inbox
=k i = gljlest@Standard e Server Sett'llgs
=[]} Standara --Server Settings
S0 tracke - Copies & Folders Server Type:  IMAP Mail Server
| admin-Standard~Private Composition & Addressing Server Mame: | 127.0.0.1 Port: | 1143 | Def
| guest~Private Offfine & Disk Space T Quest@Standard
| shared Junk Settings
OpenPGP Security Security Settings
Return Receipts Use secure connection:
Security &) Mever (O TS, ifavailable (TS () ssL
bl |:| IUse secure authentication
[ Add Account... ]

Figure 61: Thunderbird IMAP Configuration

If you move an e-mail message from a non-openCRX IMAP folder to
~} an openCRX IMAP folder and the target folder does not have a valid

Waminu  F_Mail Activity Creator defined, openCRX will not be able to create an

EMailActivitiy in that folder. Due to the move operation the message

is deleted from the source folder in your IMAP client and your e-mail

message will be lost.

Hence, it is good practice to copy (and not move) e-mails to openCRX
IMAP folders. Only after verifying that the EMailActivitiy was actually

created by openCRX in the target folder should you delete (if

necessary) the message from the source folder.
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9.5.5 IMAP Configuration of MS Outlook
The following steps are required to configure MS Outlook 2007 for LDAP:

Email account

<login principal name>@<Segment>

User Name Example: guest@Standard
Password openCRX password of the respective principal
Your Name <login principal name>@<Segment>

Example: guest@Standard

E-mail Address

your e-mail address
Example: guest@mycompany.com

Account type

IMAP

Incoming mail server
Outgoing mail server

name or IP address of your openCRX server
Example: 127.0.0.1

Incoming Port

1143

Incoming User Name

<login principal name>@<Segment>
Example: guest@Standard

Mail Folders
2] All Mail Items

=] ‘E‘-ﬁ Personal Folders
@ Deleted Items
L.# Drafts [1]
L] Inbox
L@ Junk E-mail
= Cutbox
L= sent Items
4 LA Search Folders
= &4 guest@mycompany.com
= [ Inbox
= 3 crx
=l [_J Standard
= [ tracker

b

E-mail Accounts

of New... ‘3 Repair... ESF Change...

Mame Type
guest@mycompany.com

X Remove

‘You can add or remove an account, You can select an account and change its settings.

E-mail | Data Files | RSS Feeds | SharePaint Lists || Internet Calendars || Published Calendars | Address Books

IMAP/SMTP (send from this account by default)

Change E-mail Account

Internet E-mail Settings
Each of these settings are required to get your e-mail account working.

|1 admin-Standard~Private

|1 guest~Private
3 shared
4 L& Search Folders

User Information
Your MName:

E-mail Address:

quest@standard

guest@mycompany.com

Test Account Settings

After filing out the information on this screen, we
recommend you test your account by dicking the
button below. (Requires network connection)

Server Information
Test Account Settings ... ]
Account Type:
Incoming mail server: 127.0.0.1
Outgoing mail server (SMTP): |127.0.0.1
Logon Information
""" User Name: guest@Standard
_*1 Mail
Password: e
| Calendar Remember password
8=| Contacts []Reguire logon using Secure Password Authentication (SPA) More Settings ...
ey
Sd Tasks
[ Mext = l [ Cancel

o | Ca (8] ~

]

Figure 62: MS Outlook IMAP Configuration
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10 openCRX AirSync Server (ActiveSync compatible)

openCRX AirSync allows you to connect your ActiveSync-enabled PDAs and

mobile phones (e.g. Apple's iPhone, Android-based devices, RIM's BlackBerry,
Windows Mobile devices, etc.) with openCRX to synchronize e-mails, contacts,
events and tasks, including push functionality:

AirSync Client AirSync Server

openCRX

openCRX DB
[MS SQL, Postgresal, .]

Figure 63: openCRX AirSync Server — Over The Air (OTA) Synchronization

Even though openCRX AirSync aims to be compatible with Microsoft's
ActiveSync (see what Wikipedia has to say about ActiveSync), we are
"o probably not quite there. Feel free to provide feedback, good or bad.

10.1 Configuring the AirSync Directory

The openCRX AirSync Adapter stores information about the “Folders to be
monitored” in a directory on the server (one .ser file per ActiveSync client).
The location of this AirSync directory can be set as a JAVA_OPTS (e.g. in a
batch file like tomcat.bat, run.bat, run.sh, etc.):

Listing 25: Set org.opencrx.airsyncdir for Apache Tomcat

set JAVA OPTS=%JAVA OPTS$% -Dorg.opencrx.airsyncdir="%$CATALINA HOME$\airsyncdir"

If the content of the AirSync directory gets lost, ActiveSync clients
must renew the ping information (which recreates the respective .ser

T file). The iPhone, for example, does this if you enter/exit the
respective Exchange Account settings.
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10.2 Mapping of openCRX Objects to AirSync Objects

The openCRX AirSync servlet maps openCRX objects to ActiveSync objects
(Contacts, Events, Tasks, Mails) as follows based on the openCRX object class
and additional information at hand:

openCRX Object Class Additional Requirement(s) Mapped to R=read
U=update
C=create

AccountGroup referenced by ContactsFeed Contact Folder

ActivityGroup referenced by CalendarFeed and with Calendar Folder

assigned ActivityCreator for Meetings

referenced by CalendarFeed and with Task Folder
assigned ActivityCreator for Tasks

referenced by CalendarFeed and with E-Mail Folder
assigned ActivityCreator for E-Mails

ActivityFilter referenced by CalendarFeed Calendar Folder
Task Folder
E-Mail Folder

Account referenced by member of Contact
AccountGroup
that is mapped to Contact Folder

assigned to ActivityGroup
that is mapped to Calendar Folder

Meeting

Incident, SalesVisit, assigned to ActivityGroup Event
PhoneCall, Mailing, that is mapped to Calendar Folder
Absence, ExternalActivity

Task assigned to ActivityGroup Task
that is mapped to Task Folder

EMailActivity assigned to ActivityGroup E-Mail
that is mapped to E-Mail Folder

Meeting, Incident, filtered by ActivityFilter Event RU
SalesVisit, PhoneCall, that is mapped to Calendar Folder
Mailing, Absence,
ExternalActivity

Task filtered by ActivityFilter Task RU
that is mapped to Task Folder
EMailActivity filtered by ActivityFilter E-Mail RU

that is mapped to E-Mail Folder

The openCRX ical and caldav Adapters use a different mapping for
activities (see chapter 9.4.4 Mapping of Activities to Calendar Events

Imporiant 5,4 Tasks for details).

there is no ambiguity about the object class of the openCRX object to
create and in the case of Activities an ActivityCreator must exist.
That's the reason why it is not possible to create openCRX incidents
or sales visits (Events are always mapped to openCRX Meetings).

Creation of openCRX objects by an ActiveSync client requires that
n
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10.3 A User's AirSync Profile

10.3.1 Creation of a User's AirSync Profile

openCRX users can create a personal AirSync profile as follows:

Tin

Tin

I User Homepages = Guest, joa O - Home
File Edit Find WView Actions Security Wizards

1
1

1

E 1

Edit 1

User Setting o - o | — v :
Acoounts I

1

*Contac

AirSync; you can verify this by clicking [Cancel] in the wizard and then
navigating to the Grid [Sync Profiles] of your homepage:

W Home 41 Manage Accounts & Manage Activities Sales 99 Products Depots Folders & Documents =

M User Homepages = Guest, joe O - Home
’ File Edit Find View Actions Security Wizards

“Contacts Seneral | | Ot

Cantact: Guest, |oe O

Aty bescd Abarte | | R Sub 5 e Acoounts || P oo L ows || Histo F t Mied Cibjesct Find ers || 5ynd Profiles
“Support + S, [Ziel==]+]=] Mew Edit Actions View

¥ Bugs + Features ¥l Kame = DussCription =

 esw Aty BarSync

navigate to the AirSync profile - the wizard User Settings created two
Sync Feeds, a Calendar Feed and a Contacts Feed (both named with your
username):

If the name of a feed does not end with the string “~Private” such a
feed is considered a “user created” feed for ActiveSync purposes.
Depending on your phone (or the implementation of the respective
ActiveSync client) you will not be able to synchronize such feeds.
Hence, if synchronizing with your device does not work, ensure that
your feeds name ends with “~Private”.

If you prefer device-specific profiles, you can create such profiles by
naming them “AirSync~<Device ID>".
Examples: AirSync~HTCANd922379b0, AirSync~Appl88922G1B3NA

Note: Stock Android (up to and including ICS) does not support
device-specific profiles because the Android code is broken (during
the signup negotiation a bad device id is sent to the server...).
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10.3.2 Creating/Configuring an AirSync Calendar Feed

openCRX users have a private Activity Tracker <username>~Private (e.g.
guest~Private for the user named guest) and several private Activity Creators:

<username>~Private (to create Incidents)
<username>~Private E-Mails (to create E-Mail Activities)
<username>~Private Meetings (to create Meetings)
<username>~Private Tasks (to create Tasks)

If the name of a feed does not end with “~Private” such a feed is
considered a “user created” feed for ActiveSync purposes. Depending
on your phone (or the implementation of the respective ActiveSync
client) you will not be able to synchronize such feeds.

Activities created with one of the above Activity Creators are automatically
assigned to the respective user's Activity Tracker <username>~Private and
security is set such that only the respective user can read/write such activities.

If you only need one private “calendar” to manage your activities, the wizard
User Settings does all the work for you, i.e. there is nothing more to configure.

You can, however, add more calendar feeds (activity group calendar feeds or
activity filter calendar feeds) to your AirSync profile just as you would add
calendar feeds to a calendar profile (see chapter 9.4.7.1 CalDAV Collections).

10.3.3 Creating/Configuring an AirSync Contacts Feed

openCRX users have a private Account Group called <username>~Private
(e.g. guest~Private for the user named guest). Any openCRX Account that is a
referenced by a member of this Account Group is synchronized through your
AirSync Contacts Feed. Think of a Contacts Feed as an Address Book.

The private Account Group created by the wizard “User Settings” is empty
initially, i.e. there are no members defined. You can add members to your
private Account Group as follows:

e nhavigate to your private Account Group, e.g. guest~Private (or any other
Account Group referenced in the Contacts Feed you want to configure)

e start the wizard Wizard > Manage Members:
M Home 11 Manage Accounts B Manage Activities Sales 94 Products
B {1 Manage Accounts > guest~Private - Group

File Edit Wiew Tools Actions Security Wizards
Man

*Contacts General || D

“Workspaces
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e the wizard Manage Members allows you to select Accounts to be added
(or removed) as members from various predefined sets:

e all accounts (* Accounts)
e members of the respective Account Group (Member)
e filtered accounts of any Account Filter (Account Filter name)

in addition, you can also restrict the choice to Contacts, Legal Entities,
Groups, or Unspecified Accounts only:

Manage Members of "guest~Private"”

Select | = Accounts V O * G} Contact O Legal Entity O Group {:} Unspeci
4| 181,200 v k 20 v |:| Detect Duplicates |:| Duplicates Cnly [REl[}EIEI] [ Frint] [Exp-:}rt] [EanDEI]
(=] =] [x]
41 # F Account E-mail [A] Postal Address [A] Membership Roles Valid from
181 | Huber, Monika ooi@huber.de |
182 i Huber, Zipfel zipfel. huber@guschdl-gmbh.ch  Zug x 11-Aug-2010 14
182 | Hfib, Zdensk zdenek. hribi@seznam.cz [l
184 | |gittigitt, Ingo 12345 Musterstadt |
185 | lksinski, Jas Wi 62-800 Kalisz K 11-Aug-2010 14

e You can add individual accounts as members (click the respective
checkbox) or all the accounts that are visible on the current page (click
the button [+] followed by [OK]; similarly you can disable (or delete)
members individually or all members that are visible on the current page

e the wizard can also detect duplicates based on the following criteria
(check the respective option to enable duplicate detection): a particular
e-mail address is shared by more than one account or more than one
member references a particular account:

Manage Members of "guest~Private”

Select | * Accountzs v O+ @ contact O Legal Entity
<[ 161.180[s| » [ 20[w] Detect Duplicates | Reload || Print || cancel |
=
1 # ¢ Account E-mail [A] Postal Address [A] Membership
] tM4@home.net L 7
161 1 Jones-014, Jim T. jit4@opencxorg 2005 Zurich x
% | Adams-Meadows, Patel-Bagel S jt014@opencrx.org

ft015@home. net
1@ opencre.org

==
[=r]
(=]

1 Jones-015, JimT. 2005 Zirich Fl

. jti&@home.net .
163 1 Jones-016, Jim T. jitE@opencorg 8005 Zurich [+#] )(
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e once you're done with adding the desired accounts as members to your
Account Group you can leave the wizard - in the grid [Members] you
should see all the active members pointing to accounts that you will be
able to synchronize with your AirSync Contacts Feed:

My Homepage | Accounts | Activities Pipeline Products Depots Folders
Il Accounts = guest~Private - Group
File Edit WView Tools Actions Security Wizards
General | Account | System
Group name: guest~Private
Alias name:
Addresses |  Adresses (disabled
| aQ, FOENE New Edit View
L] |:| Address Usage
Relationships : Memberships
L] <, HONOaME Mew Edit View
L D Member Phone business Phone mobile  E-mail business
Jones-014 JimT, 41 (44) +41(79) t014@opencror
SIS AN 555 014 444-5014 LopenerLor
Jones-016, Jim T +41 (44) +41(79) tl16@opencrx.on
ERIB M cee 1018 444-5016 SiEopencrx.org

Seeing an account (and being able to retrieve it through AirSync)
does not imply that you can also update such an account. Whether

you have update access to a particular account depends on the

security settings of the respective account. Please note that certain
ActiveSync clients do not notify the user when an update fails (the

not tell you that an update request failed).

Deleting an account through AirSync does not really delete the
account in openCRX, only the respective member of your Account

Group (referenced in the respective Contacts Feed) is disabled. If

required, you can reactive such a member, e.g. with the wizard

Please note that accounts in your private AirSync Contacts Feed are
not necessarily private. Whether other openCRX users can see,

Imgortant
iPhone, for example, does
Imgortant
Manage Members.
Imgortant

the respective account.

update and delete such accounts depends on the security settings of
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10.3.4 Configuration of AirSync E-Mail

openCRX users have a private Activity Tracker called <username>~Private
(e.g. guest~Private for the user named guest). E-Mail Activities assigned to
this Activity Tracker will be synchronized with a corresponding E-Mail folder
<username> - Mails (e.g. guest - Mails) in your ActiveSync client.

Furthermore, all the alerts on your homepage are mapped to E-Mails that are
also synchronized with an E-Mail folder named <username> - Alerts (e.g.
guest — Alerts):

F A OFCGEOE =155 & A T O B X &= 15:15

Iﬂl Exchange ActiveSync : 0
E From: joeguest@opencrL.org

761 guest - Alerts

jue.guest@upencrx.nrg [CRX:5tandard]: HD Channel 101
[CRXAtandard]: Adams-Meadows, Pat... 4:38 LOB2010 14:44 |.
jneiguest@npencrxinrg

[CRX:Standard]: Harpenters, Melodia

jue.guest@upencrx.arg . )

[CR¥:Standard]; Hohls, 14:38 Event: Lo N/A

: ' j  Subscription Id: N/A
f?ﬁ‘_iﬂffﬂ_]_njﬂ?'}ﬁ:x‘urg wos  Object Invoked: "http://
e hi demo.opencrx.org/opencrx-core-
jae.guest@upencrxjurg + CRX/ObjectlnspectorServiet?
[CR¥:Standard]: Duong, Hai Thuy 14:38 EUEI‘It=E&Darameterﬂri*ixri:@upen
joe.guest@opencrx.org ! provider/CRX/segment/Standard/
[CR¥:Standard]: HCL 1438 account/

[CRX:Atandard]; Formelaci 14:38 Wﬂl‘kflﬂw MIA
joeguestoopencrcorg 1 SUbsptons WA
[CRXStandard]: Infermaticka podrska P

10.3.5 AirSync Security - Deleting Data on Devices

Some devices (like the iPhone, for example) feature built-in security (e.qg.
deletion of data if the pin or access codes is not entered correctly) and it is
also possible to force deletion of data on the device as soon as the device
synchronizes with openCRX. All you have to do is to deactivate all the Sync
Feeds of the respective device-specific AirSync Profile (see the tip at the
end of chapter 10.3.1 Creation of a User's AirSync Profile for details on how to
create a device-specific profile).

Unfortunately, as long as the device does not connect to openCRX
there is not much that openCRX can do to force deletion of the data

Important 1 the device...
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10.4 Connecting ActiveSync Clients to an AirSync Profile

In principle, any ActiveSync client should be able to connect to an openCRX
AirSync Profile. The following clients have been tested and confirmed to work:

« iPhone (i0S 3.0+, i0S4.0+, i0S5+)

e HTC Desire (Android 2.2 - Froyo)
e« Google Nexus S (Android 4.0.3 - ICS)

10.4.1 iPhone (iOS 3.0+, i0S4.0+, i0OS5+)

Steps to configure your iPhone to connect to an openCRX AirSync Profile:

Please note that with i0S3.0+ the number of Exchange Accounts is
limited to 1, i.e. if you want to connect to more than 1 account you

Imporiant 1\ eod to upgrade your iPhone to i0S4 (or Jail Break your iOS3).

10.4.1.1 Setting up an Exchange Account on the iPhone

e connect to openCRX and login

e start the wizard Connection Helper: AirSync / Calendar / vCard from
your openCRX homepage:

Home Accounts Activities Pipeline Products Depots »
W User Homepages = Guest, - Home

File Edit Find View Actions Security Wizards

Explore N
WorkyExpense Report
T AN Accounts . SEarch Connection Helper: AirSync | Calendar / wCard. ..
Accounts Timeline. . %
® All Addrezzes = ?EE'T Dashbozard. .
e let the wizard “calculate” server and domain of your AirSync profile:

Role of resource: AirSync
ARSI Opf

URL: hitp://demo.opencrx.orgl/opencrx-airsync-CRX/Microzo ft-Server-ActiveSync/

SEerver: demo.opencrx.org:édiopencrx-airsync-CRX  [S5L no]
Domain: Standard
Username: guest

e copy the server info (you'll need to paste it later)
e on your iPhone home screen, tap the icon Settings
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tap on Mail, Contacts, Calendars

“Cancel Exchange

tap on Add Account...
tap on Microsoft Exchange

and then enter your e-mail address (e.g.
guest@opencrx.org) into the field Email and
populate the fields Domain, Username and Username  guest
Password as shown to the right:

Email guest@opencrx.org

Domain Standard

_| Password eeeesl

tap [Next] to verify the account information

If you get a message “Cannot Connect Using SSL” tap [No] to
[1]

move on to the next screen where you can enter the connection
details.

verify/complete your subscription information (enter or copy the server
info as calculated by the wizard “Connection Helper”) as follows:

. guest@opencrx.demo

Email your (openCRX) e-mail
. Email t@ .
Server server info as calculated by me grestEopencneorg
the wizard “Connection
He|per" e g Server demo.opencrx.org:80/ope...
, e.g.
demo.opencrx.org:80/openc
rx-airsync-CRX Domain Standard
Domain openCRX domain as Username guest

calculated by the wizard
“Connection Helper”, e.q.

Password eeesse

Standard -
Description
User Name your openCRX user name
Password your openCRX password Use SSL s il
Description leave this empty (and let
the iPhone calculate it)
Use SSL if you use SSL, set to [ON],

otherwise [OFF]

if you use SSL in combination with a self-signed certificate, you will get a
message Unable to Verify Certificate --> tap Accept

if everything works out, you can tap Save to store the settings
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10.4.1.2 Setting up Synchronization for Contacts
e tap on Mail, Contacts, Calendars

e tap on the Exchange Account, e.g.
guest@opencrx.org

e enable synchronization of contacts by setting
the ON/OFF button of Contacts to ON

e Yyou are asked whether you want to keep your
existing local contacts on your iPhone; that's B2 :
?I;‘(r)'li); b;y a good idea, i.e. tap on Keep on My it “"“ﬂiﬁiﬁé?ﬁ.‘ﬁfﬁ IR s =

e Yyou are warned about duplicate entries, but

just tap on Keep on My iPhone again Delete

Cancel

e now your Exchange Account settings should =~ sfommeect e foiz oo B
look similar to the screen shot on the right:  [SEES L iC et

Exchange ActiveSync

" Account Info > |
Mail | OFF |
Calendars | OFF |
Mail Days to Sync 3 Days »

Delete Account
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Tin

Tin

Tin

16:17 100% =6

leave the Exchange Account settings (e.g. by =#o=naect =

pressing your iPhone home button) and start ”3“
your Contacts app; you should see the

following contacts groups of your Exchange All Contacts g
a_cchotunt, similar to the screen shot on the On My iPhone
right:
° guest — Contacts All on My iPhone >
e Global Address List Contacts (Exchange)
-C >
Search in the Global Address List is not guest - Contacts
implemented yet as of openCRX v2.9.1
Global Address List >
tap on guest — Contacts to open your "'9‘*" = L= J00% 3
openCRX Contact group; you should see all |SEESEEEES L0
the accounts referenced by members of your HURLLTIIHS!
Account Group in openCRX Vice President - VCP
tap on one of the Contacts to see the details ]
as shown on the right work +41 44 555 10 16

home +41 62 333 40 16

mobile +41 79 444 50 16

ringtone Default >

email jt016@opencrx.org

email jt016@home.net

wark Mr _limm T _lanaec.Nif

You can synchronize multiple iPhone Contact Groups by defining
multiple AirSync Contacts Feeds in openCRX (each of them will be
mapped to an iPhone Contacts Group).

openCRX address information supports multiple lines (separated by
EOL or CR LF) - the iPhone maps this to two consecutive blanks (i.e.
a blank immediately followed by another blank).

If you don't have update rights in openCRX for a particular openCRX
account, you will not be able to update this contact with the iPhone

Imporiat  oither, Unfortunately, the iPhone does not tell you about failed update

requests (the update fails “silently”), i.e. make sure that your updates
actually make it to openCRX before spend too much time correcting
data...
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10.4.1.3 Setting up Synchronization for Calendars

e tap on Mail, Contacts, Calendars gllconnecho_le:a 100% =

e tap on the Exchange Account, e.g. hanttansaslssinsh
guest@opencrx_org Exchange ActiveSync

e enable synchronization of calendars by setting Account info >
the ON/OFF button of Calendars to ON

e you are asked whether you want to keep your  mail T oFF)
existing local calendars on your iPhone; that's = —
probably a good idea, i.e. tap on Keep on My entacts ml_
iPhone Calendars m

e Yyou are warned about duplicate entries, but
just tap on Keep on My iPhone again Mail Days to Sync 3 Days >

e nhow your Exchange Account settings should _
look similar to the screen shot on the right:

e leave the Exchange Account settings (e.g. by :fiomnsect o 9:09 g

Fad e

pressing your iPhone home button) and start | siiaen

your Calendar app; you should see an entry
corresponding to your iPhone Exchange
Account settings with subcalendars for each On My iPhone
active calendar feed in your AirSync Profile
(openCRX demo in the screen shot).

All Calendars >

@ All on My iPhone >

openCRX demo (Exchange)

Sync Feeds [Active and Assigned]  Sync Feeds [Other] *
All openCRX demo >

L] SN EHOENE
M[] Hame = Description = Active = @ AirSync Demo - Calendar >
" Airsync Demo Calendar Feed v @ guest - Calendar b3
" guest Calendar Feed v"

Subscribed
0] guest Contacts Feed v T

& BDAY >

Neither iPhone OS 3.0+ nor i0S4.0+ synchronizes tasks through
Exchange Account settings, i.e. you will see Events only (see also
Imporiat  -hapter 10.2 Mapping of openCRX Objects to AirSync Objects).

If your Calendar Feed references an Activity Group without a
corresponding Activity Creator for the required activity type (you
can verify this by navigating to the Activity Group and checking the
grid [Activity Creators]) you will not see a calendar corresponding to
your Calendar Feed.

See also 10.2 Mapping of openCRX Objects to AirSync Objects).
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10.4.1.4 Setting up Synchronization for Mail

e tap on Mail, Contacts, Calendars '--"'°"='"'=°" Camaldi28 s,

e tap on the Exchange Account, e.g. ' ———
guest@opencrx.org Exchange ActiveSync

e enable synchronization of mail by setting the = account info s
ON/OFF button of Mail to ON

e nhow your Exchange Account settings should Mail _on._
look similar to the screen shot on the right: — m-

| Calendars m |

Mail Days to Sync 3 Days >

Mail Folders to Push Inbox +1 »

' Delete Account

e to enable push mail you can tap on Mail [ T )
Folders to Push and then select the desired SSRGS Sl &l

folders by tapping; the screen shot on the

right shows a push subscription for openCRX [Z guest - Alerts ¥
alerts sent to the user guest: [ guest - Mails
e leave the Exchange Account settings (e.g. by =iemnsect o : ‘4_:33 ’ 100% =

pressing your iPhone home button) and start
your Mail app; you should see an entry
corresponding to your iPhone Exchange
Account settings. If you open up the
respective account you will see your mail ilOrangeCH o 14:36 100% =&
folders provided by openCRX: ' op! lemo

= Inbox >
[~ guest - Alerts ab >
E guest - Mails >

appropriate Activity Creator for E-Mails is available. By default, the
user's private E-Mail Activity Creator <username>~E-Mails will be
used.

E-Mails sent through this account will be created in openCRX if an
n
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10.4.2 HTC Desire (Android 2.2 - Froyo)

Here are the steps to configure your HTC Desire to connect to an openCRX
AirSync Profile:

Please note that the HTC mail client can only handle 1 Exchange

; account even though Android could actually handle multiple accounts.
mporiant

If you installed the plain vanilla Google mail client for Android 2.2,
you will run into another problem: the server field does not accept
URLs with port numbers or special characters like '/', i.e. you must
front openCRX with an Apache server so that Android can connect to
openCRX with a simple URL like demo.opencrx.org.

10.4.2.1 Setting up an Exchange Account on the HTC Desire

e connect to openCRX and login

e start the wizard Connection Helper: AirSync / Calendar / vCard from
your openCRX homepage:

Home Accounts Activities Pipeline Products Depots »
W User Homepages = Guest, - Home
File Edit Find WView Actions Security

*Explore

T Al Accounts . SEarch Connection Helper: AirSync | Calendar / wCard. ..
Acocounts Timeline. %
O mbn —

e let the wizard “calculate” server and domain of your AirSync profile:

Role of resource: AirSync
Alrsme Opllons

URL: hitp:/idemo.opencrx.org/opencre-girsync-CRX/Microzoft-Server-ActiveSync/

SErver: demo.opencri.orgiédiopencrx-airsync-CRX  [S5L no]
Domain: Standard
U=zername: guest

copy the server address (you'll need to paste it later)
on your HTC Desire, tap the [MENU] button and select Settings
select Accounts & sync and tap the button

-
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e select Exchange ActiveSync

e and then enter your e-mail address (e.g.
guest@opencrx.org) and your password

e tap [Next] to continue

F A

Add an account

ra
Ld

Corporate

f Facebook

AW

Set up Exchange ActiveSync account

72 B X 5= 10:40

guest@opencrx.org

Show password

—_
Manual setup Next

e verify/complete your account information (enter or copy the server info
as calculated by the wizard “Connection Helper”) as follows and then tap
[Next] to continue:

Email

Server

Domain

User Name
Password
Use SSL

your (openCRX) e-mail

server info as calculated by
the wizard “Connection
Helper”, e.q.
demo.opencrx.org:80/openc
rx-airsync-CRX

openCRX domain as
calculated by the wizard
“Connection Helper”, e.q.
Standard

your openCRX user name
your openCRX password

if you use SSL, check it

Set up Exchange ActiveSync account

Email address

guest@opencrx.org

Server address
demo.opencrx.org:80/opencrx-airs
Domain

Standard

Username

guest
Password

This server requires an encrypted
SSL connection

Back Next
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e if you use SSL in combination with a P A 7 B % =110:52
self-signed certificate, you will get a warning Exchange ActiveSync settings
--> tap Continue

. . .. Select the data to synchronize with
e if everything works out, you can tap [Finish i xchange server

setup] to store the settings

Mail -

Contacts -

Calendar ¥
D——

Back Finish setup

10.4.2.2 Setting up Synchronization

on your HTC Desire, tap the [MENU] button and select Settings

select Accounts & sync 2 B X =110:16
Settings
1 - ] I.IIJI.JIuy

e enable Auto-sync and then tap on Exchange RS 20 B X =113:29
ActiveSync to configure the details oo i

General sync settings

Background data

A d, an

Manage accounts

@ Exchange ActiveSync
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Tin

Tin

Important

Important

Tin

in order to verify that synchronization actually ReaSey = QB X =13:56
works, tap on [Sync now] and verify that the @
time-stamps of the selected collections (mail, R
contacts, calendar) are updated General settings

detailed configuration of the synchronization Rl
schedule is pOSSib|e by tapp|ng on Size limit, format and server
[SChedlﬂe:I Data and synchronization

very hour

Sync mail
12/08/2010 13:26

Sync contacts
12/08/2010 12:41

Sync calendar
12/08/2010 12:41

Sync now Remove account

HTC Desire supports push for the folder Inbox only (which is not
mapped to openCRX). Hence, you might as well save the battery and
disable push until Android/HTC get their act together.

Search in the Global Address List is not implemented yet as of
openCRX v2.9.1

HTC Desire / Android 2.2 do not support synchronization of tasks
through Exchange Account settings. Hence, you will only be able to
see Events.

If your Calendar Feed references an Activity Group without a
corresponding Activity Creator for the required activity type (you
can verify this by navigating to the Activity Group and checking the
grid [Activity Creators]) you will not see a calendar corresponding to
your Calendar Feed.

See also 10.2 Mapping of openCRX Objects to AirSync Objects).

E-Mails sent through this account will be created in openCRX if an
appropriate Activity Creator for E-Mails is available. By default, the
user's private E-Mail Activity Creator <username>~E-Mails will be
used.
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10.4.3 Google Nexus S (Android 4.0.3 - ICS)

Here are the steps to configure your Google Nexus S to connect to an openCRX
AirSync Profile:

Important

The stock Android ActiveSync client is quite limited: the server field
does not accept URLs with port humbers or special characters like '/,
i.e. you must front openCRX with an Apache server so that Android
can connect to openCRX with a simple URL like airsync.opencrx.org.

In your Apache config file (httpd.conf) you can do something like this:
Listing 26: Apache config file httpd.conf / fronting Tomat

<VirtualHost *:80>
ServerName airsync.opencrx.org
DocumentRoot /var/www/html
ServerAdmin admin@opencrx.org
ErrorDocument 404 http://demo.opencrx.org/
ProxyRequests Off
ProxyPreserveHost On
<Proxy *>
Order deny,allow
Allow from all
</Proxy>
ProxyPass / http://demo.opencrx.org:8080/opencrx-airsync-CRX/
ProxyPassReverse / http://demo.opencrx.org:8080/opencrx-airsync-CRX/
ProxyHTMLURLMap / /opencrx-core-CRX/
<Location />
Order allow,deny
Allow from all
</Location>
</VirtualHost>

10.4.3.1 Setting up an Exchange Account on the Google Nexus S

once you have the fronting Apache (see " o
above) configured, you're ready to setup your fies
Google Nexus S device (we assume that the
virtual host airsync.opencrx.org is fronting W Battery
the openCRX AirSync servlet)

on your device, tap the [MENU] button and
select System Settings ERECIRAL

select Accounts & sync and tap the button 7 Accounts & sync
[Add account]

Settings

Apps

select Corporate Add an Exchange account
and then enter your e-mail address (e.g.
guest@opencrx.org) and your password You can set up an Exchange

. account in just a few steps.
tap [Next] to continue : :

guest@opencrx.org

uuuuu

Send email from this account by
default.

MNext
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e verify/complete your account information as follows and then tap [Next]

to continue:

Domain openCRX domain as ABILIESEHY
calculated by the wizard —
“Connection Helper”, Standard\guest
e.g. Standard BRGNS

User Name your openCRX user name,
e.g. guest <

airsync.opencrx.org
Password your openCRX password

Use secure connection (35L)

Server name (or IP address) of the | MebieDevicelD
fronting Apache server,
e.g. airsync.opencrx.org

Use SSL if you use SSL, check it

Previous Mext

e if you use SSL in combination with a self-signed certificate, you will get a
warning --> accept the certificate

e if everything works out, you'll get a screen as EEEIIEGEGEEEENE

shown on the right - select the options you Account settings

like and then tap [Next] to continue .
Inbox checking frequency

Automatic (Push)
Days to sync
Automatic 4

Send email from this account by
default.

Notify me when email arrives,
Sync contacts from this account

Sync calendar from this account.

& § §

Sync email from this account,

Automatically download
attachments when connected to
Wi-Fi

LY

Previous Mext
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e finally, name your account and then tap
[Next] to finish :

Important

Important

Account setup

I
' Your account is set up, and email is |
. I

on its way!
Give this account a name {optional)

quest@opencrx.org

Google Nexus S supports push for the folder Inbox only (which is not
mapped to openCRX). Hence, you might as well save the battery and
disable push until Google get their act together.

Search in the Global Address List is not implemented yet as of
openCRX v2.9.1

Google Nexus S / Android 4.0.3 do not support synchronization of
tasks through Exchange Account settings. Hence, you will only be
able to see Events.

If your Calendar Feed references an Activity Group without a
corresponding Activity Creator for the required activity type (you
can verify this by navigating to the Activity Group and checking the
grid [Activity Creators]) you will not see a calendar corresponding to
your Calendar Feed.

See also 10.2 Mapping of openCRX Objects to AirSync Objects).

E-Mails sent through this account will be created in openCRX if an
appropriate Activity Creator for E-Mails is available. By default, the
user's private E-Mail Activity Creator <username>~E-Mails will be
used.
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11 openCRX AirSync Client (ActiveSync compatible)

The openCRX AirSync Client enables backend-synchronization of contacts and
calendars between openCRX and MS Exchange. Thus, MS Outlook and PDAs
connecting to MS Exchange get easy access to contacts and calendars that are
managed in openCRX, without the need to install any additional software or
changing the configuration:

WIRE (LAN, etc.
MS Exchange
Server

AirSync Client AirSync Server

openCRX

openCRX DB
[MS 5QL, Postaresal, .

Figure 64: openCRX AirSync Client — backend-sync with Exchange

Even though openCRX AirSync aims to be compatible with Microsoft's

ActiveSync (see what Wikipedia has to say about ActiveSync), we are
L probably not quite there (we have tested with MS Exchange 2003 and

MS Exchange 2007), so feel free to provide feedback, good or bad.

Due to the fact that Microsoft prevents the creation of E-Mails on the
Exchange server through ActiveSync (unless you want to actually
send e-mail) it is not possible to really synchronize e-mails between
MS Exchange and openCRX.

Imporiant

We recommend IMAP to access openCRX E-Mails (see chapter 9.5
Mailstore / IMAP for more information).
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11.1 AirSync Client Profile

Each MS Exchange account that should be synchronized with openCRX requires
an AirSync Client Profile.

11.1.1 Creation of an AirSync Client Profile

openCRX users can create an AirSync Client profile as follows:

e nhavigate to Home > Sync Profiles; select New > Air Sync Client Profile:

i
1| Manage Accounts

*Support
1 Bugs + Features
= New ACtivity

i
1 Bugs 4 Festures

» Actities

:'Wnrkspa:es

| Default

» Acopunts [disabled)

L Home (11 Manage Accounts

File Edit Find ‘View Actions

General

Contact:

dlerts |Reminders Subscriptions Service Accounts

A Manage Activities *1| Sales &5 products Depots 2 Folders & Dncument!:

M User Homepages > admin-Standard, - Home

Security Wizards

Uptions  System

admin-Standard,

=, HOEGEE
Name =
guest@mycompany.com
AlrSync
admin-Standard ~Contacts
admin-5tandard ~Documents

Pending / Completed Workflows History F

Mew Edit Actions
Air Sync Profile
A Air Sync Client Profile

K

View

e populate the fields as shown below (name and description are for
informational purposes only, but Server URL, Username, Password and
Domain must be adapted to your own environment):

=

General | | System

Mame:

Description:

Server URL:
Usernamse:
Fassword:

Demain:

The string Microsoft-Server-ActiveSync is fixed (referring to a

GRS e

guest@mycompany.com

M5 Exchange AirSyng Client Profile

HTHE R LR

https://owa mycompany.com' Vi crosoft- Server-Active Sync

guest

COMP

virtual directory on the Exchange server).

I
I
|
|
|
|
|
|
|
|
|
|
|
I
:
|
|
1
|
|
I

Descripti
Tl chld
M5 E:-t..ll1

|

|
- 1
Contacts

|
Documen
|
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If you intend to use SSL to secure the connection to your Exchange

server you must import the server's certificate into the keystore.
Tin

Listing 27: Importing Certificate

cd $JAVA HOME/lib/security
keytool -import -alias <dom> -file <name>.cer -keystore cacerts

Replace <dom> with the name and domain of the mail server (e.g.
owa.my.company.com) and <name> with the name of the certificate
file.

11.1.2 ActiveSync Provisioning

ActiveySync Provisioning (see
http://msdn.microsoft.com/en-us/library/dd299443(v=EXCHG.80).aspx)
specifies an XML-based format to communicate security policy settings to client
devices (in this case openCRX, acting as an ActiveySync client). Depending on
the settings/configuration of your account on the MS Exchange server you
might have to run the provisioning wizard to enable synchronization. You can
fetch the provisioning information from the MS Exchange server by navigating

0 Home (1 Manage Accounts + Manage Activities | sales 33 products Depats:
1
4 User Homepages > admin-Standard, = guest@mycompany.com - Air Sync Clier

Edit WView Security Wizards
AirSync - Synchronize fte

AT - 3y

= \ \ onize Folders...
Lontacts AirSync - Provision... A
I Manage Accounts 1
Az - Name: guest@mycompany.com
- Description: M5 Exchange AirSync Client Profile |

11.1.3 Synchronizing Folders

You can retrieve a list of all the synchronizable folders, converted to openCRX
Sync Feeds, from the MS Exchange Server by navigating to your AirSync Client
Profile and running the wizard AirSync — Synchronize Folders. Sync Feeds
created by this wizard are initially set to inactive and the reference to Account
group (for Contact Feeds), Activity group (for Activity Group Feeds) or Activity
filter (for Activity Filter Feeds) respectively are not set. You will find such feeds
in the tab [All Sync Feeds].
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11.1.3.1 Prepare your MS Exchange Account

In principle you can synchronize any Exchange folder with openCRX. It might
make sense, however, to create a set of special folders, i.e. prepare your
Exchange account as follows (use your own openCRX username instead of
guest):

o start MS Outlook (and connect to your Exchange server)

« create a folder for Mail and Post Items named openCRX:
Create New Folder

Mame:
DpenCR}d

Eolder contains:

Mail and Post Ttems W

o select the folder openCRX and then create a subfolder for Contact
Items named Contacts (guest~Private):

Create Mew Folder

Mame:

Contacts (guestrPrivate)

Folder contains:

Contact Items b

Select where to place the folder:

(1 lopenCRi A

« similarly you create the folder Tasks (guest~Private) for Task Items:
and the folder Calendar (guest~Private) for Calendar Items

e your folder openCRX should now contain three subfolders, Calendar
(guest~Private), Contacts (guest~Private) and Tasks (guest~Private) as

follows:

= [ openCRX
:ﬁ Calendar (guest~Private)
=] Contacts (guest~Private)
=] Tasks (guest~Private)

e synchronize Outlook with your MS Exchange server so that these new
folders are available on the server as well before you proceed
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11.1.3.2 Retrieve Synchronizable Folders / Sync Feeds

Now that your Exchange account is prepared you can navigate to your AirSync
Client Profile and run the wizard AirSync — Synchronize Folders to retrieve
the Sync Feeds:

Home HKontakte Activities Pipeline Products Depots »
] D User Homepages = admin-Standard, joe = guest@

Edit View Security Wizards

AirSync - Synchronize ltems. ..

t Bt J
General | | System | | * AirSync - Synchronize Folders...
AirSync - Provision. .. %
AirSync - Synchronize [tems {Incognite].
Mame: Dashboard. ..

In the tab [All Sync Feeds] you should now see various Sync Feeds including
the following ones corresponding to the folders you created with MS Outlook:

Sync Feeds [Active and Assigned] |All Syne Feeds
L Q ENEEEE Mew Edit View
1M [] Active = Mame = Allow add / delete = Allow change = Description =
#Calendar (guest~Private)
#Fri Sep 17 11:12:11 CEST 2010
1 Calendar [guest~FPrivate) L4 Farentld=eab5838bfacd 284281845248 78 2fc8 ca-5447 20
CREATED _CALENDAR_FCOLDER
Serverld=eabS93Ebfacdt264eD18d5248 TE2fobca-B44 732
#Contacts (guest~Private)
#Fri Sep 17 11:12:11 CEST 2010
il Contacts {guest-Private) o Parentld=e 18bfacd 284201845248 T8 oBoa-544720
ATED _COMTACTS_FOLDER

bS93Ebfacd 26491845248 TE2fobca-54472c

[ =]
oo
m

#Taszks (guest~Private)

#Fri Sep 17 11:12:11 CEST 2010
1 Tasks (guest~Private) e L Parentld=eab8938bfacd 284251845248 782fc8ca-54472b
CREATED_TASKS_FOLDER

b8938bfacd 204291845248 78 2fcB0a-54472d

11.1.3.3 Synchronization with MS Exchange Contact Folders

In order to configure synchronization between an MS Exchange contact
folder and an openCRX Account Group (see also 10.2 Mapping of openCRX
Objects to AirSync Objects) follow these steps:
e navigate to the Contacts Feed corresponding to the desired MS Exchange
Contact Folder; the folder name is contained in the description of the
Sync Feed, usually on the first line, e.g. #Contacts (guest~Private)
e change to edit mode
o set Active to true and set the reference for the Account Group (use the
auto-completer or the lookup inspector)
« optionally you can allow/prevent adding/removing/changing contacts
e save your changes

With the next execution of the wizard Synchronizing Items the synchronization
will be initiated.
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11.1.3.4 Synchronization with MS Exchange Calendar Folders

In order to configure synchronization between an MS Exchange calendar
folder and an openCRX Activity Group (see also 10.2 Mapping of openCRX
Objects to AirSync Objects) follow these steps:

e navigate to the Activity Group Feed corresponding to the desired MS
Exchange Calendar Folder; the folder name is contained in the
description of the Sync Feed, usually on the first line, e.g. #Calendar
(guest~Private)

e change to edit mode

« set Active to true and set the reference for the Activity Group (use the
auto-completer or the lookup inspector)

o optionally you can allow/prevent adding/removing/changing activities

e Ssave your changes

In case you want to synchronize with an openCRX Activity Filter instead of an
openCRX Activity Group, follow these steps:

e navigate to the Activity Group Feed corresponding to the desired MS
Exchange Calendar Folder; the folder name is contained in the
description of the Sync Feed, usually on the first line, e.g. #Calendar
(guest~Private)

« change to edit mode and copy the content of the field description into
your clipboard

e click [Cancel] to leave edit mode and navigate one level higher to the Air
Sync Client Profile

« select New > Activity Filter Feed as shown below:

Sync Feeds [Active and Assigned] | All Sync Feeds || *
e Q DEOME New Edit View
IM [] Active = Hame = Allow add / de] Il Contacts Feed

i Activity Group Feed
T\ Activity Fiter Feed

« paste the description from the clipboard to the field description and then
enter a name for this feed (you can use the same name that was used
for the Activity Filter Group if you wish)

« set Active to true and set the reference for the Activity Group (use the
auto-completer or the lookup inspector)

« optionally you can allow/prevent adding/removing/changing activities

e save this newly created feed

» delete the Activity Group Feed that was created by the wizard AirSync -
Synchronize Folders

With the next execution of the wizard Synchronizing Items the synchronization
will be initiated.
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11.1.3.5 Synchronization with MS Exchange Task Folders

In order to configure synchronization between an MS Exchange task folder
folder and an openCRX Activity Group or an openCRX Activity Filter (see
also 10.2 Mapping of openCRX Objects to AirSync Objects) follow these steps:

e navigate to the Activity Group Feed corresponding to the desired MS
Exchange Calendar Folder; the folder name is contained in the
description of the Sync Feed, usually on the first line, e.g. #Tasks
(guest~Private)

e change to edit mode

« set Active to true and set the reference for the Activity Group (use the
auto-completer or the lookup inspector)

o optionally you can allow/prevent adding/removing/changing activities

e Ssave your changes

In case you want to synchronize with an openCRX Activity Filter instead of an
openCRX Activity Group, follow these steps:

e nhavigate to the Activity Group Feed corresponding to the desired MS
Exchange Calendar Folder; the folder name is contained in the
description of the Sync Feed, usually on the first line, e.g. #Calendar
(guest~Private)

« change to edit mode and copy the content of the field description into
your clipboard

o click [Cancel] to leave edit mode and navigate one level higher to the Air
Sync Client Profile

o select New > Activity Filter Feed as shown below:

sync Feeds [Active and Assigned] | All 3ync Feeds || *
4 Q NEOME New Edit View
M [] Active = Hame - Allow add | de] Al Contacts Feed

i Activity Group Feed
T\ Activity Fiter Feed

o paste the description from the clipboard to the field description and then
enter a name for this feed (you can use the same name that was used
for the Activity Filter Group if you wish)

e set Active to true and set the reference for the Activity Group (use the
auto-completer or the lookup inspector)

« optionally you can allow/prevent adding/removing/changing activities

e save this newly created feed

o delete the Activity Group Feed that was created by the wizard AirSync -
Synchronize Folders

With the next execution of the wizard Synchronizing Items the synchronization
will be initiated.
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11.1.3.6 Synchronization with MS Exchange E-Mail Folders

MS Exchange servers do not support pushing e-Mails from an ActiveSync client
to a folder on the MS Exchange server (which is one of the reasons why you
cannot store draft e-mails written on your iPhone to the MS Exchange server,
for example). The only way to transfer e-mails from an ActiveSync client to an
MS Exchange server is by actually sending the e-mail (which is not exactly
what you want in order to synchronize).

On an experimental basis the import of e-mails from MS Exchange into
openCRX using AirSync is implemented, but we actually recommend the use of
the openCRX IMAP Adapter (see 9.5 Mailstore / IMAP for more information).

11.1.4 Synchronizing Items

The wizard AirSync - Synchronize Items synchronizes active Sync Feeds.
Please note that per sync call up to 50 items are synchronized per feed, i.e.
you might have to call this wizard multiple times for a full synchronization if
there are a lot of changes.

11.1.5 Resync - Clear all items of a feed on server

Increasing the value of a feed's Generation by 1 leads to the removal of all
items of that feed on the MS Exchange server. The wizard Resync — Clear all
items on the server automates this task.

11.1.6 Resync - Replace all items of a feed on server

Increasing the value of a feed's Generation by 1 and setting the value of a
feed's SyncKey.Client to 0 leads to the replacement of all items of that feed
on the MS Exchange server followed by the removal of items on the MS
Exchange server that are no longer included in the feed. The wizard Resync -
Replace all items on the server automates this task.

11.1.7 Automating Synchronization

One way of automating synchronization is by setting up a cron job and have
curl call the wizard WizardInvoker.jsp with the appropriate parameters, e.g.

curl "http://localhost:8080/opencrx-core-CRX/WizardInvoker.jsp
?wizard=/wizards/en_US/AirSyncSyncWizard.jsp&provider=CRX
&segment=Standard&xri=xri://@openmdx*org.opencrx.kernel.homel/
provider/OB/segment/Standard/userHome/guest/syncProfile/
9QF54GOKYPT5RD77BOUAW34NB&user=guest&password=guest" &> /dev/null
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12 Social Media

12.1 Twitter

openCRX features to support/connect to Twitter:
e OAuth (see http://oauth.net/ for more information)
Support for consumer key and consumer secret; a wizard to create
access token and access key. The openCRX implementation is based on
the library twitter4j (see http://twitter4j.org for more information).
« Wi.izards to send direct messages and status updates
« Workflow to send alert notifications via Twitter

12.1.1 Register with Twitter

1. Before openCRX can invoke the Twitter API, you need to register your
instance of openCRX at http://twitter.com/oauth_clients/new to acquire a
consumer key and a consumer secret. Register your openCRX instance as
follows:

o Application Name: name of your openCRX instance, e.g. 'openCRX
of MyCompany'

o Application Website: the URL users can access the openCRX
instance, e.g. https://crm.mycompany.com/opencrx-core-CRX

o Application Type: Client

o Default Access type: Read/Write

o Use Twitter for login: false

If registration is successful you should get a 'Consumer Key' and a
'Consumer Secret' for your application.

2. Login as admin-Root and navigate to Administration > Configuration.

o Create a new component configuration with
Name: Twitter
Qualifier: Twitter

« Navigate to the newly created component configuration and add
the following string properties:
CRX.OAuth.ConsumerKey: Twitter consumer key
CRX.OAuth.ConsumerSecret: Twitter consumer secret
3. Logout (Users are now able to setup Twitter accounts).

NOTE: segment-specific tokens are configured using the pattern
e <provider name>.<segment name>.0OAuth.ConsumerKey

L e <provider name>.<segment name>.0Auth.ConsumerSecret
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12.1.2 Create Twitter Account

1.

Login as user, e.g. guest

2. Twitter accounts are configured on a user's home in the tab [Service

Accounts]. A Twitter account is created as follows:
« Name: Twitter user display name
e Active: true
o Default: true

3. Invoke the wizard '"Twitter - Create access token'. The wizard shows an

URL and a field to enter a PIN code. Open the URL in a new browser
window. This redirects you to Twitter asking to grant access for the
openCRX instance. If you grant access a PIN code will be displayed. Enter
the PIN code and click OK. If all goes well, the fields 'Access token key'
and 'Access token secret' are set now.

12.1.3 Using openCRX Wizards

On most objects the following two wizards are available:

Twitter — Send Message

This wizard allows to send a message to a list of Twitter users. In
addition the message text is attached as note and if you are invoking the
wizard on an activity a follow up is created. Note that the message is
only visible to the recipients.

Twitter — Update Status

This wizard allows to for one of the configured Twitter accounts. Status
updates are visible to all followers of the selected Twitter account.

12.1.4 Using the SendDirectMessageWorkflow

The SendDirectMessageWorkflow works much the same way as the
SendMailNotificationWorkflow. However, instead of sending an e-mail to the
user in case of alert updates, the alert title including a tiny url pointing to the
underlying openCRX object is sent as direct message to the default Twitter
account of the subscribing user. The SegmentSetupWizard (can be executed by
the segment administrator, e.g. admin-Standard) creates the required entries
for the workflow and topic. Users simply need to subscribe to the topic Alert
Modifications (Twitter).
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13 openCRX is a REST Service (Web Service)

The openCRX REST servlet allows easy 3rd party integration with openCRX.
The full functionality of the openCRX API can be accessed via REST requests,
i.e. you can use openCRX as a REST Service.

See http://code.google.com/p/rest-client/ for a REST client.

Sample REST requests are available from
http://www.opencrx.org/opencrx/2.3/new.htm#REST

You might also want to look at the following Wiki page:
https://sourceforge.net/p/opencrx/wiki/Sdk211.Rest/
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14 Data Import/Export

There are many ways of importing data (from other systems into openCRX)
and exporting data (from openCRX to other systems). Generally speaking,
there is no best way of doing imports/exports because depending on how much
weight you put on the pros and cons of the various methods you may come to
a different conclusion. Some issues to consider are:

e one-time import/export vs. multiple imports/exports
e file-based/batched vs. connection-based/real-time
e allow manual process steps vs. fully automated

In this chapter we will cover some of the basic options you can choose from,
but there are obviously other (and sometimes better) options to consider.

While it may be tempting to connect to the openCRX database for
“quick and dirty” imports/exports, you should really consider using

T the openCRX API. On the one hand, importers/exporters accessing
the database directly are bypassing openCRX security (this is
actually more of a warning than a tip...). On the other hand, the
openCRX database schema is subject to change (whereas the
API is stable).

14.1 Importing Data into openCRX

The task of importing data is handled by importers. In principle, you can
import almost anything into openCRYX, it's really only a matter of writing an
appropriate importer.

You must ensure that (legal) values are assigned to all mandatory
(i.e. non-optional) attributes of openCRX objects created/updated
Waminu  4uring the import; in particular, all code attributes are mandatory!

The Open Source distribution of openCRX includes importers for vCard (see
Importing vCard Files)and iCalendar files (see Error: Reference source not
found) in addition to the XML importer.

14.2 Importing XML Files

You can import virtually any data into openCRX as long as you provide it in the
form of schema-compliant XML files. The openCRX schema files can be found
in the file opencrx-kernel.jar (unzip and look for xmi subdirectories).
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Alternatively, you can export example objects as XML files and look at the
produced XML files (although the generated XML file also contains all the
derived and optional attributes; hence, you will have to prune the generated
XML file before you can use it as a template).

Some of the configuration information and data provided with openCRX are
also provided in the form of XML files and imported during system setup (e.g.
units of measurement are loaded from
opencrx-core-CRX\opencrx-core-CRX\WEB-INF\config\data\
Root\101_uoms.xml).

An XML import from a third party system might typically involve the following
steps:

3'd party
System
|
XML Files XSLT XML Files
t—| Processor . (compliant with
{e.g. Xalan) openCRX schema)
openCRX

Figure 65: XML import from 3™ party system — overview

You can import schema-compliant XML files with the following methods:
e Interactive / on-demand

Navigate to your user home and execute the operation File > Import:

guest@Standard

opencrx

en LIS

My Homepage | Accounts  Activities Pipeline »
| ¥ User Homepages = Guest, Joe O - My Homepage

File Edit Find WView Actions Security Wizards

Irpsort. ..
Save Azsigned Activities Q iCal...

em

Contact: Guest, Joe O
Figure 66: Interactive import of XML Files
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Click on the button [ Browse..  and navigate to XML file to be imported.
Next you click OK to to start the import. Please note that this method is
very suitable for small XML files and on-the-fly imports. If you are
dealing with larger XML files, however, you should consider the bulk
import described below.

e Bulk Import

Use the bulk import for large XML files or if you need to import multiple
XML files in an automated fashion. Put your XML file(s) into the following
directory (you might have to expand the EAR file to do so):

opencrx-core-CRX\opencrx-core-CRX\WEB-INF\config\data\<SegmentName>

where <SegmentName> can be Root, Standard, or whatever your
Segment is named.

Next you login as openCRX Root administrator (admin-Root) and execute
the operation View > Reload. Click Yes to start the operation.

OpenCF}{ admin-Root@Root Root

en LS

Administration | UOMs Codes  Security Realm  Security Policies  Security Subjects

.| =@ Administration

Edit WView Actions Wizards

Confi{ pejpad . P ‘

] v = New Edit View

Figure 67: Interactive import of XML Files

Once the import is started you can close the browser, i.e. there
is no need to keep the session alive until the import is

Tin completed. Some information regarding the progress of the
import is written to the console.

In case you have data dependencies between/among your XML
files (e.g. some files contain Contact data while others contain

Tin address data which is composite to Contact data) you should
make sure that parent data are imported before child data
gets imported. This should be relatively easy to achieve as XML
files are imported in alphabetical order.
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14.2.1 Importing Excel Files (- openCRX Accounts)

You can directly import Excel Sheets that contain field names in the first row
and then data in the rows 2, 3, .... An example sheet is shown below:

@ Microsoft Excel - acct.xls

iE] Fle Edit view Insert Format Tools Data  Window Help  Adobe PDF
HRNEA" RERE N YA AR N fmv | @ = - 8] | | i [43] 100%
i M5 Sans Serif -0 - B I U|E=EZ=EME¥ o, ¢ S0 OL00 | E= 5E | i . Ty
515 - &
K| L | bl | M | 0] =

1 |Title FirstName MiddleName LastName SuffixBusinessStreet

2 |Mr. |Tim Thunderhird Jones Jr. b Tim J. Thunderbird654 California Awe.
3 Aaron Thunderhird Aaronsen

4 [Mr. |Roger Thunderhird Fabhbit

5 |br | Jeff Thunderhird Dude

B Rabhitts Clock Shop AG

Figure 68: Import Accounts from Excel Sheet — Sample Excel Sheet

The following field attributes are supported by the importer wizard:

Field Name openCRX Attribute / Description

XRI (optionally) provide XRI of openCRX account to be updated; if
there is no match with an existing account, a new one will be
created

DTYPE (optionally) provide the type of openCRX account; values are:
CONTACT, LEGALENTITY, GROUP, and UNSPECIFIEDACCOUNT

TITLE mapped to Contact.salutationCode (if the text can be located

as a code value), otherwise mapped to Contact.salutation

SALUTATION mapped to Contact.salutation (a text field)

FIRSTNAME Contact.firstName

MIDDLENAME Contact.middleName

LASTNAME Contact.lastName

ALIASNAME Contact.aliasName (multi-locale support)

NICKNAME Contact.nickName

SUFFIX Contact.suffix

COMPANY based on the type of imported Account, the value is mapped to

or COMPANY.en_US
or COMPANY.de_CH
etc.

one of the following attributes (multi-locale support):

- Contact.organization

- LegalEntity.name

- Group.name

- UnspecifiedAccount.name

if the imported account is of type Contact and a matching
account with name equal to COMPANY is found, then the
imported Contact is made a member of the matching account;
furthermore, COMPANYROLE is mapped to Member.member-
Role and JOBTITLE is mapped to Member.description
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JOBTITLE Contact.jobTitle
DEPARTMENT Contact.department
BIRTHDAY Contact.birthdate
the following formats are recognized:
dd-MM-yyyy, dd-MM-yy, MM/dd/yyyy, MM/dd/yy
HOMEPHONE Account.PhoneNumber.fullNumber (with usage = home)
HOMEPHONE2 Account.PhoneNumber.fullNumber (with usage = other)
HOMEFAX Account.PhoneNumber.fullNumber (with usage = fax home)
HOMEADDRESSLINE Account.PostalAddress.postalAddressLine (usage = home)
by default, this is the main address; change the column header
to HomeAddressLine?isMain=(boolean)false if this is not the
main address
HOMESTREET Account.PostalAddress.postalStreet (usage = home)
HOMECITY Account.PostalAddress.postalCity (usage = home)
HOMEPOSTALCODE Account.PostalAddress.postalCode (usage = home)
HOMESTATE Account.PostalAddress.postalState (usage = home)
HOMECOUNTRY or Account.PostalAddress.postalCountry (usage = home)
HOMECOUNTRYREGION
BUSINESSPHONE Account.PhoneNumber.fullNumber (with usage = business)
BUSINESSPHONE2 Account.PhoneNumber.fullNumber (with usage = other)
BUSINESSFAX Account.PhoneNumber.fullNumber (with usage = fax business)
BUSINESSADDRESSLINE Account.PostalAddress.postalAddressLine (usage = business)
by default, this is the main address; change the column header
to BusinessAddresslLine?isMain=(boolean)false if this is not the
main address
BUSINESSSTREET Account.PostalAddress.postalStreet (usage = business)
BUSINESSCITY Account.PostalAddress.postalCity (usage = business)
BUSINESSPOSTALCODE Account.PostalAddress.postalCode (usage = business)
BUSINESSSTATE Account.PostalAddress.postalState (usage = business)

BUSINESSCOUNTRY or
BUSINESSCOUNTRYREGION

Account.PostalAddress.postalCountry (usage = business)

MOBILEPHONE Account.PhoneNumber.fullNumber (usage = mobile)
EMAILADDRESS Account.EMailAddress.emailAddress (usage = business)
EMAIL2ADDRESS Account.EMailAddress.emailAddress (usage = home)
EMAIL3ADDRESS Account.EMailAddress.emailAddress (usage = other)
X500ADDRESS Account.EMailAddress.emailAddress (usage = N/A, type X.500)
WEBPAGE Account.WebAddress.webUrl (usage = business)
ASSISTANTSNAME if a matching account with full name equal to

ASSISTANTSNAME is found, then the matching account is
made a member of the imported account; furthermore,
ASSISTANTSNAMEROLE is mapped to Member.memberRole
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MANAGERSNAME

if a matching account with full name equal to MANAGERSNAME
is found, then the imported account is made a member of the
matching account; furthermore, MANAGERSROLE is mapped to
Member.memberRole

BUSINESSTYPE

Account.businessType
you can provide a list of business types (each business type on
a separate line) - see drop down / code table for valid values

NOTES

Account.description

<address>_ AUTHORITY

the authority attribute allows you to define an “owner” of an
address; this can be useful - for example - to designate the
employer as the “owner” of an employee's addresses (e.g.
while joe.doe@greatcompany.com is Joe's business e-mail
address, the true “owner” is Joe's employer “great company”
which also “owns” the domain greatcompany.com)

the following column headers are supported:
e HOMEPHONE_AUTHORITY

e HOMEPHONE2_AUTHORITY
e HOMEFAX_AUTHORITY
e BUSINESSPHONE_AUTHORITY
e BUSINESSPHONE2_AUTHORITY
e BUSINESSFAX_AUTHORITY
e MOBILEPHONE_AUTHORITY
e EMAILADDRESS_AUTHORITY
e EMAIL2ADDRESS_AUTHORITY
e EMAIL3ADDRESS_AUTHORITY
e X500ADDRESS_AUTHORITY
e WEBPAGE_AUTHORITY
¢ HOMEPOSTAL_AUTHORITY
e BUSINESSPOSTAL_AUTHORTY
MEMBEROF if @ matching account with full name equal to MEMBEROF is
found, then the imported account is made a member of the
matching account; furthermore, MEMBERROLE is mapped to
Member.memberRole (you can provide a semicolon-separated
list of member roles (e.g. founder;owner;Board of Directors)
note: with this powerful feature you can establish relationships
between accounts right at the time of importing accounts
it is possible to identify the parent account by specifying that
account's extString0 content - simply prepend reference with
the string “"@#”, for example @#443
MEMBERROLE Member.memberRole (see MEMBEROF for more details)
CATEGORIES Account.category
you can provide a semicolon-separated list of categories (e.g.
Business;Birthday;Xmas) and the importer will add all missing
items to the list of categories contained in Account.category
NOTECREATEDAT date when note was created (format YYYYMMDD)
NOTETITLE creates or updates (if a note with the given title already exists)

a note attached to the imported account; furthermore,
NOTETEXT is mapped to the text attribute of the note
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NOTETEXT

see NOTETITLE

generic / model-driven
e String
e Boolean
e Short
e BigDecimal

the importer can also handle single-valued attributes of the
types listed in the left-hand column in a generic / model-driven
fashion; examples are:

e userString0, userStringl, ..., userString3
userBooleanO, userBooleanl, ..., userBoolean3
userCode0, userCodel, ..., userCode3
userNumber0, userNumberl, ..., userNumber3
extString0, extStringl, ...
extBooleanO, extBooleanl, ...
extCode0, extCodel, ...

e extNumberQ, extNumberl, ...
the importer also handles multi-valued code attributes:

o extCode20, extCode21, ...
individual values for multi-valued attributes can be separated
by a semicolon (%;”), e.g. 2;29;113;468
consult the openCRX UML Model for information on which
attributes are available:
http://www.opencrx.org/documents.htm#Doclatestuml

Properties

the importer can also handle properties; the syntax for column
headers is as follows:

<PropertyType>:<Name of PropertySet>!<Name of Property>
where PropertyType is one of the following: BooleanProperty,
IntegerProperty, DecimalProperty, StringProperty, UriProperty,
DateProperty, DateTimeProperty or ReferenceProperty and

both Name of PropertySet and Name of Property are strings

Example: StringProperty:DOCSYS!FileNumber

Field names supported by MS Outlook match the names produced
if you export Contacts from MS Outlook to an Excel Sheet:

Tin
Export to a File

Create a file of type:

Comma Separated Values (DOS)
Comma Separated Values (Windows)
Microsoft Access

Microsoft Excel

Personal Folder File [ pst)

Tab Separated Values (DOS)

Tab Separated Values (Windows)

[ < Back ” Next = ][ Cancel
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The Importer produces a detailed on-screen report with clickable links and a
summary report stating the total number of created/updated accounts:

UPDATED [Contact]: Aaronsen, Aaron Thunderbird [/ @openmdx org.opencn.kernel account/provider/ CRX 'segment/Stan

Rowr

0004 Contact

UPDATED [Contact]: Rabbit, Roger Thunderbird [i://{@openmdx®org. cpencnckernel. account/provider'CRX/'segment/Standar

Rowr
0005
UPDATED [Contact]: Dude, Jeff Thunderbird [xri://{@openmdx org. openox kermnel account1/providen' CRMUsegment'Standard /at

sl LegalEntity

Ditype created lupdated
Contact 1 3
Group a il
LegalEntity 1 ]
UnspecifiedAccountd 1

Figure 69: Import Accounts from Excel Sheet — Import Report

Before you launch an import of thousands of accounts, verify the
structure of your Excel sheet with a few lines/accounts only.
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14.2.2 Importing vCard Files (- openCRX Contacts)

vCard is file format standard for personal data interchange, specifically
electronic business cards (additional information is for example available from
http://en.wikipedia.org/wiki/VCard).

These are the steps to import a vCard file:

e click on the provider Accounts and navigate to an existing Contact (or
create a new one)
e select the operation File > Import vCard to unhide the import dialog:

My Homepage @ Accounts | Activities Pipeline »
1 Accounts = Guest, Joe O - Contact

File Edit View Tools Actions Security Wizards

Import wCard... Import wCard »

Sawve as vCard...

New Contact...

Export... Language: English (en_US5} A

Export Advanced... tem: [ Browse._
First Name:;
Middle Name:

La=st Name:

Figure 70: Operation vCard Import

e select the appropriate language
e click the Browse button and navigate to the vCard file you want to import
e click the OK button to start the import operation

14.2.3 Importing E-Mails

Please refer to the Chapter 8 E-mail Services, in particular chapter Error:
Reference source not found Error: Reference source not found.

14.2.4 Other Options

There are various other options to consider. You could for example develop a
custom-tailored JSP Wizard to import data on demand or on a regular basis
(e.g. controlled by the openCRX WorkflowController).

Sometimes it is more appropriate to develop a specific openCRX client to
handle imports, and in a typical enterprise class environment you will probably
consider developing adapters to connect/integrate openCRX with 3™ party
systems on a real-time basis.
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14.3 Exporting Data from openCRX

The task of exporting data is handled by exporters. The Open Source
distribution of openCRX includes exporters for vCard and iCalendar files in
addition to the XML exporter.

This allows you to export contacts and meetings/sales visits or any other
object from openCRX. vCard and iCalendar files can be imported by a large
variety of other applications, including Microsoft Outlook. This chapter shows
how to export data.

14.3.1 Exporting XML Files

Navigate to the object to be exported as XML file and execute the operation
File > Export Advanced as shown below:

Export Advanced b
Reference filter: customer;position;zalesRepjaddress
MIME type: textixml W

Figure 71: Exporting SalesOrder as XML File

In order to better control which additional objects (composites, referenced
objects, ...) the XLM exporter should export together with the object loaded in
the Inspector, you can (optionally) provide a reference filter (optionally with
a navigation level). By default, only the current object will be exported. If
you provide - for example when exporting a sales order - customer;address
as a reference filter, the customer and all referenced addresses will be
exported together with the main object. If you export a contact and provide
the reference filter member[1] you will get direct members of this contact.

If the export is successful the exporter will terminate with status OK and you
will be provided with a link to the file Export.zip containing the raw data:

-
2 WinZip - Export.zip g@
File Actions Options Help

& @ LS i &2 = >
Mew Open Favorites Add Extract Encrypt View CheckOut  Wizard
Mame Type Modified Size | Ratin | Packed | Path

[Edata-0.xml; XML Document  10-Jul-2008 12:34 13,600  85% 2,090

[@hdata-1.xml ¥MLDocument 10-Jul-2008 12:34 7,166 80% 1,424
[mhdata-2xml ¥MLDocument 10-Jul-2008 12:34 7,048 79% 1,498

Selected 0 files, 0 bytes Total 3 files, 28KEB f:') ';;l
Figure 72: XML Exporter provides XML data file and code tables as ZIP file
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The openCRX ICS Adapter can also export iCalendars in XML format:

ICS URL (to get XML file with authentication):
http://<crxServer>:<Port>/opencrx-ical-<Provider>/activities
?id=<Provider>/<Segment>/<Calendar Selector>&type=xml

Example:
http://localhost:8080/opencrx-ical-CRX/activities?id=CRX/Standard/tracker/main&type=xml

See chapter 9.4.2 Calendar Selectors (ICS and CalDAV) for

e information on how to construct calendaring URLs.
[i]

You can also export the data contained in an openCRX grid to an XML file by
executing Actions > Export --> XML on any grid.

14.3.2 Exporting Data to MS Excel / Open Office Calc Files

Navigate to the object to be exported as spreadsheet file and execute the
operation File > Export Advanced as shown below:

Reference filter: customenr;position;salesRep;salesRep/:*laddress
MIME type: application/'x-excel v

| K I I Cancel I

Figure 73: Exporting SalesOrder as Spreadsheet File

In order to better control which additional objects (composites, referenced
objects, ...) the XLM exporter should export together with the object loaded in
the Inspector, you can (optionally) provide a reference filter. By default, only
the current object will be exported. If you provide - for example - :*¥/:* as a
reference filter, all composites up to 2 levels deep will be exported together
with the main object (this should be sufficient for most use cases). You can
also provide a reference filter to dereference and export referenced objects like
the customer or the salesRep of a sales order.

If the export is successful the exporter will terminate with status OK and you
will be provided with a link to the file Export.xls containing the raw data:
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= Export - OpenOffice.org Calc [Z]@
File Edit View Insert Format Tools Data Window Help
T e o — - B >
B-cHe R RSR Y i bR -dio-0- BUL O ]
3 W P i (] B 7 U|=E===H|b2%355™ B
ALIV1 v fm = = |

1 |Risd

2 [xrtxno@openmd+1 0 org-opencrckernelcontract1:SalesOrder 3 2

3 |xi-mxr@openmd+1k 1

4 |xritxi-@openmae+1r 2 =
] \Saleg{)rderfpusiﬁun { Account / U(_ )_I .
Sheet 1/3 || PageStyle_SalesOrder || 100% STD = Sum=0

Figure 74: Exported Spreadsheet File

Based on such spreadsheet files end-users can easily create reports or do
some ad-hoc data analysis without the need to know anything about Java or
writing JSPs. The standard distribution of openCRX includes various example
reports based on this technology.

You can also export the data contained in an openCRX grid to an Excel file by
executing Actions > Export --> XLS on any grid.

14.3.3 Exporting openCRX Contacts (> MS Excel Files)

These are the steps to manually export group of contacts to an Excel file:
e navigate to the account group you want to export
e start the wizard Wizards > Manage Members
e click the button [Export]
e click on the spreadsheet icon to download the Excel file containing the
exported accounts

The exported MS Excel file can be imported again. Hence, if you want
to make bulk changes (e.g. change to domain of an e-mail address,

L etc.) you can first export the relevant accounts to an Excel file, make
the desired changes in Excel and then reimport the Excel file with the
Importer wizard (see 14.2.1 Importing Excel Files (I openCRX
Accounts)).
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14.3.4 Exporting openCRX Contacts (- vCard Files)

These are the steps to manually export a contact to a vCard file:

navigate to the contact you want to export

click on the tab Account

select the contents of the field vCard and copy it to an empty text file
save the text file with any name and extension “vcf”, e.g. contact.vcf:
vizard: BEGIN:VCARD

Figure 75: Manually Export Contact as vCard

There is also a wizard vCard.jsp available which allows you to export
individual accounts or batches of accounts as vCards.

Navigate to an Account and select File > Save as vCard to start the export:

My Homepage @ Accounts Activities Pipeline »
1 Accounts = Rabbit, Roger Thunderbird - Contact

File Edit View Tools Actions Security Wizards

Import vCard...

Save as vCard... seount
Mew Contact... %

Export. .. M.
Export Advanced...

Figure 76: Export individual Contact as vCard with Wizard

In order to export multiple accounts as vCards, create an Account Filter that
selects the desired accounts and then navigate to this Account Filter. Select File
> Save Filtered Accounts as vCard:

My Homepage | Accounts | Activities Pipeline »
% Accounts = TB - Account Filter

File Edit WView Tools Actions Security Wizards
Save Filtered Accounts as vCard..

Export. ..

Export Advanced...

Name: TB

Dezcription: te=t fiter for Thunderbird Add-on

Figure 77: Export multiple Contacts as vCards with Wizard
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14.3.5 Exporting openCRX Meetings (2 iCalendar Files)

These are the steps to export an individual activity (e.g. a meeting or a sales
visit) to an iCalendar file:

navigate to the meeting (or sales visit) you want to export

click on the tab Details

select the contents of the field iCal and copy it to an empty text file
save the text file with any name and extension “ics”, e.g. meeting.ics:

iCal: BEGINVCALENDAR
PRODID-/OPENCRX/NONSGML Version 1/EN
VERSION:2.0
BEGINVEWVEN

u-.[-.-i F‘ 200807107102
RIPTIOMN:new wic

Figure 78: Exporting Meeting / Sales Visit as iCalendar File

There is also a wizard iCal.jsp available which allows you to export individual
activities or batches of activities as iCals.

Navigate to an Activity and select File > Save as iCal to start the export:

My Homepage  Accounts | Activities Pipeline »
¥ Activities = 1000120: Time test - Task

File Edit View Actions Security Wizards
Import iCal...
Save as iCal...

Export. .. %

Export Advanced... Time test

Figure 79: Export individual Activity as iCal with Wizard

In order to export multiple activities as iCals, navigate to an Activity Group
(Activity Tracker, Category, Milestone), to an Activity Filter (or to any other
object that features a list of assigned activities like Userhome, Account) and
then select File > Save Filtered Activities as iCal (Save Assigned Activities as
iCal).
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14.3.6 Exporting E-Mails

Please refer to the Chapter 8 E-mail Services, in particular chapter 8.2.3
Export E-mails.

14.3.7 Exporting openCRX Grids

Any openCRX Grid can be exported to an XML or an XLS file. The exporters are
accessible through Actions > Export - xxx:

Activities

L L = EODEONEE Actions  View

It | == Activity# - Mame - Assig E;EEE _: i:w‘ ing contact
& ®m 1001248 RE:(Fwd: RE: 161180X) Gue Export+ > L Joe O
7 1001242 DEMO ACTIVITY Guest, Joe O Guest, Joe O
+ ] 1001247 checkmate Guest, jJoe O  Guest, joe O
+ ] 1001245 mememe Guest, Joe O Guest, Joe O

14.3.8 Other Options

There are various other options to consider. You could for example develop a
custom-tailored JSP Wizard to export data on demand or on a regular basis
(e.g. controlled by the openCRX WorkflowController).

Sometimes it is more appropriate to develop a specific openCRX client to
handle exports, and in a typical enterprise class environment you will probably
consider developing adapters to connect/integrate openCRX with 3rd party
systems on a real-time basis.

If you have a REST client available, then exporting via REST is also a very
viable option.
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15 Customizing openCRX

Please refer to the guides available at http://www.opencrx.org/documents.htm
for detailed information regarding UI customization and localization.

15.1 Managing Locales

The default installation of openCRX activates all locales that are included in the
Open Source distribution. The openCRX administrator may wish to deactivate
certain locales from the locale list. This chapter shows how you can achieve
this.

The locale list is contained in the file
opencrx-core-CRX\opencrx-core-CRX\WEB-INF\web.xml

Look for the section <!-- locales --> to find a list of available locales:

Listing 28: Locales in web.xml

<!-- locales -->

<init-param>
<param-name>locale[0]</param-name>
<param-value>en US</param-value>

</init-param>

<init-param>
<param-name>locale[l]</param-name>
<param-value>de CH</param-value>

</init-param>

<init-param>
<param-name>locale[2]</param-name>
<param-value>es MX</param-value>

</init-param>

You can deactivate locales by simply commenting them out. The following
example shows how to deactivate the locale de_CH.

Listing 29: Activating/Deactivating Locales in web.xml

<!-- locales -->

<init-param>
<param-name>locale[0]</param-name>
<param-value>en US</param-value>

</init-param>

<[ ==

<init-param>
<param-name>locale[l]</param-name>
<param-value>de CH</param-value>

</init-param>

>

<init-param>

Please note that you must not deactivate the base locale (that is the
locale with the id O, typically en_US) as the base locale contains a lot
of customizing information not present in other locales.
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15.2 Managing Packages

The default installation of openCRX activates all packages that are included in
the Open Source distribution. The openCRX administrator may wish to
deactivate certain packages if they are not used. This chapter shows how you
can achieve this.

The package list is contained in the file
opencrx-core-CRX\opencrx-core-CRX\WEB-INF\web.xml

Look for the section <!-- Admin --> to find a list of available packages:

Listing 30: Packages in web.xml

<!-- Admin -->

<init-param>

<param-name>rootObject [0]</param-name>
<param-value>xri:Q@openmdx:org.opencrx.kernel.adminl/provider/CRX/segment/${SEGMENT }</param-value>
</init-param>

<!-- Home -->

<init-param>

<param-name>rootObject [1l]</param-name>
<param-value>xri:Q@openmdx:org.opencrx.kernel.homel/provider/CRX/segment/${SEGMENT}/userHome/$ {USER}</param-value>
</init-param>

<!-- Accounts -->

<init-param>

<param-name>rootObject [2]</param-name>
<param-value>xri:Q@openmdx:org.opencrx.kernel.accountl/provider/CRX/segment/${SEGMENT}</param-value>
</init-param>

You can deactivate packages by simply commenting them out. The following
example shows how to deactivate the package depotl:

Listing 31: Activating/Deactivating Packages in web.xm/

</init-param>
<!-- Depots -->
<l--
<init-param>
<param-name>rootObject [6]</param-name>
<param-value>xri:Qopenmdx:org.opencrx.kernel.depotl/provider/CRX/segment/${SEGMENT}</param-value>
</init-param>
==}
<!-- Documents -->
<init-param>
<param-name>rootObject [6]</param-name>
<param-value>xri:@openmdx:org.opencrx.kernel.documentl/provider/CRX/segment/${SEGMENT}</param-value>
</init-param>
<!-- Buildings -->

Please note that you must renumber all the packages listed after the
package you deactivated so that the package numbering does not
have any gaps (i.e. package numbering starts at 0 and it must
be consecutive).

It is also possible to change the order of the active packages by
renumbering them. However, you must still ensure both that the
Tin numbering starts at 0 and that the numbering is consecutive.
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15.2.1 Enabling/Disabling Root Menu Entries

Individual user can enable/disable root menu entries with the wizard User
Settings (available on a user's Homage):

N Home (1 Manage Accounts £ Manage Activities | sales % products
% User Homepages > Guest, Joe O - Home

File Edit Find View Actions Security Wizards

1

1

I

]

]

1

1

! User Setting ..
:"Cnnta = : General | Options  System
1

1

1

1

1

i Manage Accounts

Accounts Contact: Guest, joe O

Figure 80: Launch Wizard User Settings

Once the wizard has loaded, uncheck entries you don't need (note that the
settings can be different for different perspectives):

Root Menu
Root Advanced Simple

Manage Accounts:
Manage Activities:
Sales:

Products:

Depots:

Folders & Documents:

LA LA LA A L L Y

Buildings:

Budgets & Targets:
UOMs:

UOMs (Root):
Codes:

Waorkflows:

User Homepages:

Security Realm:
Security Policy:

Figure 81: Wizard User Settings — enable/disable Root Menu Entries

LA VL L VR Y VL S VL Y VL L VL A N L
LA N VL A VL N A VL L N Y

Please note that entries corresponding to packages disabled by the
openCRX administrator cannot be enabled with this wizard. Packages

Important  ;sabled in web.xml are not available at all!

Depending on the width of your screen you can adjust the number of
items shown as tabs in the top-level navigation in the same wizard by

o changing the value of Show max items in top navigation (fewer
items for narrow screens, more items for wider screens).

If you uncheck Show top navigation sub-levels the top-level tabs
will not contain menus for sub-levels.
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15.3 Role-based GUI / GUI Permissions

15.3.1 Activating GUI Permissions

With the following steps you can active GUI permissions:
e login as admin-Root
e click on the tab [Security Policy]

e in the bread-crum title, click on Security Policies as shown below:

# Administration Codes UoMs  wF Security Realm Security Policy Security Subjects
Security Pni::ies = Root - Security Policy

Edit WView Wizards

*Workspaces General | System| |

Default Poicy
Marme: Root
Parent:

o select New > Security Policy:

+* Administration Codes UoMs  «F Security Realm Security Policy Security Subjects
Security Policies

Edit WView Wizards

*Workspaces Policies
Default W Q, HOME Mew Edit Actions View
L] Mame = Description = Eim‘:{ Policy | Parent =
Default Default Palicy ;
Roaot Root Palicy

« set both the name and the qualifier to Standard and enter Standard
Policy as description as shown below - then click the button [Save]:

Untitled - Security Policy

General System

Palicy

Name: Standard Description: Standard Policy
Parent: /\

P
Qu alifier: {must beunique, Le. leave unchanged unbess you knaw what you ane daing
Standard
5:3'-"'* Cancel

logoff and login as admin-Standard

click on the tab [Security Policy]
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e in the grid [Roles], select New > Role:
Security Policies = Standard - Security Policy

[
Edit View Wizards

General System

Pabcy

Name: Standard Description: Standard Policy

Parent:

Roles

W a, AORYEE Mew Edit Actions View i
1] Name = Disabled = Description = ! Roﬂdified at = Modified by = Created at =

o set both the name and the qualifier to Admin and enter Admin Role as
description as shown below - then click the button [Save]:

P e I I T e il el e T T e

Untitled - Role

1 |
1 |
1 |
1 |
1 |
1 |
1 |
: General System :
1 |
1 | Rala 1
1 n 1
1| Name: Admin Description: Admin Role I
1 |
1 Disabled: :
: .
1 |
: Qu alifier: {must beunique, Le. leave unchanged unbess you know what you ane daing :

|
: .
1 |
1 |
1 |

Admin

Savg Cancel

e in the grid [Roles], select New > Role again set both the name and the
qualifier to Public and enter Public Role as description as shown below
- then click the button [Save]:

Untitled - Role

General System

Rz
Name: Public Dwescription: Public Role
Disabled: -
P
Qrualifier: {must be unique, Le. leave unchanged unkss you know what you ane daing
Public
EHu* Cancel

e your default Security Policy Standard should now contain the 2 roles
Admin and Public; this concludes the base configuration of GUI element
security
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15.3.2 Managing GUI Permissions

Only segment administrators (e.g. admin-Standard) can manage GUI
permissions.

15.3.2.1 Granting a role to an openCRX user

With the following steps you can grant a role to an openCRX user:
« login as segment administrator (e.g. admin-Standard)
» select the top-level tab [Security Realm]

e click on the tab [Principals] and locate and then navigate to the principal
whom you want to grant a new role.

o the grid [Granted Roles] contains the (ordered) list of roles currently
granted to the respective principal

o start typing the name of the role to be granted into the input box just
below the menu Edit (as show below) and then select the desired role,

______________________

Granted Roles
Edit
publ 2]

‘Ll—| Name
_ 1 Public [Reabliell. - __________

« select the menu Edit > Add object to grant the role:

Granted Roles Granted Roles

Edit Edit

Add object ) - - ,

‘F.Em:-.--: :t-j-::th ] [~ Public [Public] <]

Move up object

Name L]

Move down obiect - I & L

| Public

If permissions granted to roles contradict each other, the last role in
the list of granted roles “wins”, i.e. the order in which roles are
Tin granted to a principal matters!

You can use Edit > Move up object and Edit > Move down object
to change the order of roles in the grid [Granted Roles].

Grant the role Public to all users (including segment administrators),
but grant the role Admin to segment administrator only, to make it
o easy to disable certain GUI elements for normal users.
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15.3.2.2 Revoking a role previously granted to an openCRX user

With the following steps you can revoke a role previously granted to an
openCRX user:

login as segment administrator (e.g. admin-Standard)
select the top-level tab [Security Realm]

click on the tab [Principals] and locate and then navigate to the principal
whom you want to grant a new role.

the grid [Granted Roles] contains the (ordered) list of roles currently
granted to the respective principal:

Granted Roles

Edit
Public [Public] ]
I+ Name
| Public

click on the line of the role to be revoked to select it (the selected line
turns grey) and then select the menu Edit > Remove object to revoke

1 1
1 1
1 1
. Edit :
"1 Add ohied 1
: Add object . & :
\ | Remowve object .
! e y e 1
: Move up utjc_F Name 1
. | Move down object ) 1
1T Public '
1 1
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15.3.2.3 Enabling/Disabling GUI elements

With the following steps you can disable a GUI element:

Tin

login as segment administrator (e.g. admin-Standard)
navigate to the screen that contains the GUI element you want to disable

start the wizard Wizards > Manage GUI Permissions:
\l Home | 1
11 Manage Accounts = GROUP WEST COAST - Group

Manage Accounts N Manage Activities ¥ Sales =

File Edit WView Tools Actions Security Wizards

*Contacts

Manage GUI permissions

Role: | Public v
View: O gperations @ Fields ) Grids
Generic permissions:
Available: Current:
‘L Bugs 4 Festures
) _‘I’ . :"‘ = org: opencrx: kermel : accoael: Abstractbroup: name | -sheow
J' e ALY org:epencrx: kernel :accountl:Abstractbroup: name | +shew
1 Bugs + Features arg:opencrs:kermel taccomtl:Abstracteroup: name | -edit
- Activities org: opencry:kermel accountl:Abstractrroup: name | +edit
- l org: opencrx:kernel accotl:Accowot: aliasHame | -show
'Wnrkspaces org: opencry:kernel accoovtl:Accowt: aliasHame | +shosw
wrg: opencrx: kernel :accoavel:Acconrt: aliasHame | -edit hl
Default
Permissions for org: opencrx: kernel: accountl: Group:
Available: Current:
org: opencry:kernel accotl: broup:Pane (Attr:Tab: 0 broup: 0 | -show
wrg: opencrx: kernel : acconavel: broup:Pane :Attr:Tab: 0: froup: 0 | +show
org: opencrx: kemmel : accoavel: broup:name | -sheow
org:opencrx: kernel :accountl: froup:name | -edit
org:opencrx: kernel :accountl: froup:name | +shes
org: opencry:kernel accountl: broup:name | +edit
org: opencry:kernelaccoatl: broup: aliasHame | -show il

Reload Cancel

select the role you want to manage permissions for (e.g. Public)

select the type of GUI element you want to enable/disable (e.q.

Operations, Fields, Grids)
use the buttons [>] and [<] to add/remove permissions

once you're done, click the button [Apply] to persist your changes

It usually takes a few seconds before the new permissions are applied
by the GUI rendering engine.
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15.4 Custom Layout JSPs

openCRX is distributed with 2 default layout JSPs located in the directory
opencrx-core-CRX\opencrx-core-CRX\WEB-INF\config\layout\en_US:

« show-Default.jsp

This layout JSP renders all pages that show information (typically an
Inspector containing information about the current object and all the
grids containing associated information). This layout JSP is generic (it is
provided by openMDX/portal) and it can handle any object.

o edit-Default.jsp
Similarly, this layout JSP renders all pages that are used to edit objects.

If you have a need for specialized screens for a particular object in edit and/or
show mode, you can write your own layout JSP and deploy it to the
above-mentioned directory. The file name of your custom layout JSP
determines which objects (or rather: objects of which class) will be handled by
your custom layout JSP.

Example:

Let's assume you want to replace the default edit screen for openCRX Contacts
(i.e. class org.opencrx.kernel.accountl.Contact) with a custom layout JSP.
Name your file

edit-org.opencrx.kernel.accountl.Contact.jsp

and deploy it to the directory ...\WEB-INF\config\layout\en_US. After restarting
Tomcat or your application server your new layout JSP will be active.

If you develop localized JSPs you can create new directories for the
respective locales and then deploy your localized JSPs there. The

Tin fallback algorithms are comparable to those in ui customization.
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16 Integration with Office Application

openCRX provides various technologies that enable you to easily integrate
common office suites like Open Office or Microsoft Office.

16.1 MS Word, LibreOffice Writer, OpenOffice Writer, etc.

openCRX supports the JSP-wizard-based generation of RTF documents. You can
generate RTF documents from scratch or merge data with existing RTF
templates. The RTF documents are generated on the fly and can be opened
with any RTF-compatible word processor including OpenOffice Writer and

MS Word.

You can test this feature on our demo server (or on your own installation if you
installed the openCRX Server) with the following steps:

- connect and login as user guest

- navigate to any contact and execute the operation
Tools > Mail Merge --> RTF Document

- the wizard will provide a list of suitable templates and then generate the
RTF document on the fly

[~ CRX_Standard_000001_Guest%2C (read-only) - OpenOffice.org Writer M=l

File Edit Yiew Insert Format Table Tools Window Help

L = —~ — — o

R =22 B S _: o .
.

openCRX Sample Wizard — Mail Merge to RTF Document

Fienams CRE_Standad DT GuestEICT.rif
Cualifier NITEwEIBEEASS el v oA

Name Guest,

Mail Merge Counter | TRRHNFN

Timestamp Z00807-10T13: 2034 MW1Z

Mailing Address | WARHNING: no postal addressavailable

Figure 82: RTF Document generated by merging live data with template
If you installed the openCRX SDK you will find the templates and the JSP
wizard in the following locations:

e <SDK_Install_Dir>\opencrx-2.9.1\core\src\data\org.opencrx\documents
® <SDK_Install_Dir>\opencrx-2.9.1\core\src\data\org.opencrx\wizards\en_US\MailMerge.jsp

With this approach it is quite easy to generate all kinds of documents, including
letters, invoices, purchase orders, etc.
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17 Reporting

openCRX provides various technologies that enable you to create reports of a
wide variety, anything from simple ad-hoc reports to large scale bulk reports.

17.1 Large Scale Reporting

If your task is to produce a large humber of reports (e.g. monthly reporting for
all your clients) or reports based on large amounts of data, spreadsheet-based
reporting is probably not the way to go. Maybe you want to generate reports in
a format other than XLS. On the one hand, openCRX already includes libraries
to generate reports and documents in various formats, on the other hand you
can easily add additional libraries to openCRX.

Format |Library / Additional Information

XLS Apache POI / http://poi.apache.org/

PDF iText / http://www.lowagie.com/iText/

RTF Simple RTF Writer / org.opencrx.kernel.utils.rtf

Obviously, there are many more possibilities, like for example exporting data in
XML format and then doing some kind of fancy transformation.

In terms of how to generate your reports, there are also various options
available depending on your preferences:

e JSP-Based Reporting
This approach is typically recommended if you need on-demand
reporting and the generation of the report does not put an undue burden
on the server. The following screen shot shows an example HTML-report:

Kundsnbszibgs Kundsn-hr 105341 [Fogiistalisr 05§ Tho Jul 10 14:43:00 CEST 2005 vier bz

tomat] || meuoereoren || neu perowen mrsmvezen || Drosen || Fensersciesse |
[ o etes Sezlge anzeigen
Prroduid oA, LFA

Taeal Dlscoutt  Venauwsprels 2

E] Mangs Pochon LEEPRES o e Faitur Datum
[

11210 Diessloz] UN 1202 41z 00 3 24121 CHF — o CHF 2085 5 E2MEM R 13-05-200E
11120 Blelnzl 25 UM 1233 11505 00_N 2 115051 CHF — o CHF 17258 5 2 R 13-05-2003
11120 Blelnzl 25 UM 1203 13907 00_H 2 139071 CHF — o CHF 16400 35 21350 R 0e-0s-200E
11210 Diessloz] UN 1202 4283 001 3 42831 CHF — o CHF 18420 35 213382 R -05-200E

e Java Program

Large-scale batch reporting can be done with a Java Program (basically
an openCRX client programmed in Java that prepares the desired
reports).
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e BI-Reporting Suite
If you plan to use a BI-Reporting Suite (e.g. Crystal Reports, Pentaho,
BIRT, etc.), you should keep in mind that directly accessing the
openCRX database is not a very good idea. We strongly recommend
you either retrieve data through the openCRX API (e.g. with REST) or set
up a dedicated reporting DB (the process to populate such a reporting
DB should retrieve data from the openCRX DB through the openCRX
API). The reason for not accessing the openCRX database directly is the
following one: while the openCRX API is stable, the OO-to-relational
mapping is not and hence the schema of the openCRX DB is subject to
change over time. Hence, if you access the openCRX DB directly you will
have to adapt your reports if the DB schema changes, a potentially
expensive proposition. Furthermore, whenever you access the openCRX
DB directly there is no access control...
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18 Miscellaneous Topics

18.1 Configuration of AutoCompleter

The AutoCompleter works by default with objects in the current segment. To
determine the so called 'lookup object' it also considers the 'root objects'
configured in web.xml. By default, web.xml has two configured UOM
segments:

e Xxri:@openmdx:org.opencrx.kernel.uom1l/provider/CRX/segment/${SEGMENT}

e Xxri:@openmdx:org.opencrx.kernel.uom1l/provider/CRX/segment/Root

If there are multiple root objects of the same type, the AutoCompleter takes
the first (see org.openmdx.portal.servlet.DefaultPortalExtension.getLookupObject() for
details).

Hence, if you want to give the root UOMs priority you can switch the orders of
the UOM XRIs in the web.xml. If you want to have some more sophisticated
logic you can override the method getLookupObject() or getAutoCompleter().
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18.2 Extended Service for openCRX/Tomcat Management

18.2.1 Multiple Instances of Tomcat

Extended Service is a Tomcat extension which allows to start multiple Tomcat
instances with the same configuration and allows to stop / start the connectors
of these instances individually.

The class org.openmdx.catalina.core.ExtendedService allows to handle the
requested scenario. Adapt the server.xml as follows:

<Server port="${tomcat.server.port}" shutdown="SHUTDOWN">

<Service name="Catalina" port="${tomcat.service.port}" className="org.openmdx.catalina.core.ExtendedService">

The system properties are set per Tomcat instance, e.g.

Instance A:

° -Dtomcat.server.port=8005

® _Dtomcat.service.port=8006

Instance B:

° -Dtomcat.server.port=8105

® _Dtomcat.service.port=8106

If instance A and instance B have to run with different versions of

" EARs/WARs, create a Tomcat directory for each instance.
n

* Start instance A. The connectors are started.
* Start instance B. The connectors can not be started because of port conflicts.

Switch from instance A to B as follows:
* telnet localhost 8006 and enter command stopConnectors
* telnet localhost 8106 and enter command startConnectors

If the property org.openmdx.catalina.core.ExtendedService.autostartConnectors is
unset or the property is set to true then the connectors will be started at
startup of Tomcat. Otherwise the connectors are not started.

18.2.2 IMAPServer: pause / resume

The IMAPServlet (opencrx-imap-CRX/IMAPServlet) provides a GUI which allows
to pause and resume the IMAPServer. The Wizard IMAPServer.jsp available as
admin-Root redirects to the IMAPServilet. The IMAPServlet accepts the system
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property org.openmdx.catalina.core.ExtendedService.autostartConnectors. If unset
or set to true, the IMAPServer is started at startup. If set to false, then the
IMAPServer has to be started manually.

18.2.3 WorkflowController: pause / resume

The WorkflowControllerServlet accepts the hew commands pause and resume.
Pause stops pinging the controlled WorkflowServlets. The new commands are
available via the GUI. The WorkflowControllerServlet accepts the system
property org.openmdx.catalina.core.ExtendedService.autostartConnectors. If it is
unset or set to true the WorkflowController is activated on startup. If set to
false the WorkflowController has to be started/resumed manually.
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18.3 SNMP Monitoring (with Sun JVM)

The SNMP agent for the Sun JVM can be enabled as described at
http://java.sun.com/j2se/1.5.0/docs/guide/management/SNMP.html and
http://www.ilikespam.com/blog/monitoring-the-jvm-with-snmp.

1) Put snmp.acl in TOMCAT_LWC_HOME/bin and give read access to the file
for the owner only.

#The communities public and private are allowed access from the local host.
acl = {
{
communities = public, private
access = read-only
managers = localhost
}
}
# Traps are sent to localhost only
trap = {
{
trap-community = public
hosts = localhost
}
}

2) Add the following options to tomcat.sh
-Dcom. sun.management.snmp.port=8161
-Dcom. sun.management.snmp.acl.file=TOMCAT LWC HOME/bin/snmp.acl

3) After startup the variables can be retrieved with
snmpwalk -c public -v2c localhost:8161 .1.3.6.1.4.1.42.2.145.3.163.1.1.4.1.

See
http://support.ipmonitor.com/mibs/JVM-MANAGEMENT-MIB/oids.aspx for
a list of all OIDs supported by the JVM.

A simple cron-based monitoring environment can invoke snmpwalk periodically
and send mail if a monitored parameter violates a predefined constraint. Use
gkrellm with the snmp extension (see http://trig.net/gkrellm_snmp.html) or
OpenNMS (see http://www.opennms.org/) for more advanced monitoring.

This approach only works for the Sun JVM.
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18.4 Tomcat w/ openCRX and LDAP-based Authentication

You can connect Tomcat w/ openCRX with OpenLDAP as follows:

e replace the JDBC Realm entry in the file

opencrx-core-CRX\opencrx-core-CRX\META-INF\context.xml with the

following entry:

<Realm
className="org.apache.catalina.realm.JNDIRealm"
debug="99"

connectionName="cn=Manager, dc=opencrx,dc=org"
connectionPassword="secret"
connectionURL="1dap://localhost:389"
userPassword="userPassword"
userPattern="cn={0}, ou=people, dc=opencrx,dc=org"
roleBase="ou=groups, dc=opencrx,dc=org"
roleName="cn"

roleSearch=" (uniqueMember={0})"

/>

e Users must be entered into your LDAP server as follows (userPattern):

# Users

dn: cn=guest,ou=people,dc=opencrx,dc=org
objectClass: organizationalPerson

sn: guest

cn: guest

userPassword: opencrx

dn: cn=admin-Root, ou=people,dc=opencrx,dc=org
objectClass: organizationalPerson

sn: admin-Root

cn: admin-Root

userPassword: opencrx

dn: cn=admin-Standard, ou=people,dc=opencrx,dc=org
objectClass: organizationalPerson

sn: admin-Standard

cn: admin-Standard

userPassword: opencrx

e Groups must be entered into your LDAP server as follows (roleBase,
roleName, and roleSearch):

# Groups

dn: ou=groups, dc=opencrx,dc=org
objectClass: organizationalUnit
ou: groups

dn: cn=OpenCrxRoot, ou=groups,dc=opencrx,dc=org
objectClass: groupOfUniqueNames

cn: OpenCrxRoot

uniqueMember: cn=admin-Root,ou=people, dc=opencrx,dc=org

dn: cn=OpenCrxAdministrator,ou=groups, dc=opencrx, dc=org
objectClass: groupOfUniqueNames

cn: OpenCrxAdministrator

uniqueMember: cn=admin-Standard, ou=people,dc=opencrx,dc=org

dn: cn=OpenCrxUser, ou=groups,dc=opencrx,dc=org
objectClass: groupOfUniqueNames

cn: OpenCrxUser

uniqueMember: cn=guest,ou=people,dc=opencrx,dc=org

— 167 —



openCRX Admin Guide - Version 2.12.0 Miscellaneous Topics

18.5 OpenEJB / Reestablishing dropped DB Connection

Add the 3 highlighted lines (TimeBetweenEvictionRunsMillis, ValidationQuery,
TestWhileldle) to the datasource definition in the file openejb.xml (or
tomee.xml) so that dropped database connections are reestablished
automatically:

<?xml version="1.0" encoding="UTF-8"?>
<openejb>

<!-- openCRX with PostgreSQL, DB: CRX CRX -->
<Resource id="jdbc opencrx CRX" type="DataSource">

ValidationQuery select object id from oockel_segment where dtype = 'org:opencrx:kernel:accountl:Segment'
TestWhileIdle true

TimeBetweenEvictionRunsMillis 10000

</Resource>

;}épenejb>
More information is available from
http://openejb.apache.org/3.0/containers-and-resources.html.

18.6 Running openCRX as a service on Redhat/CentOS

Follow these steps to run openCRX as a service on a Redhat/CentOS box (it is
assumed that openCRX already runs from a shell, i.e. openCRX is properly
installed and it is possible to start/stop openCRX with the scripts provided):

e create a new text file opencrx in the directory /etc/init.d/ with the
following content (adapt TOMCAT_USER, BASEDIR, TOMCAT_LOG,
DB_HOST and DB_PORT to your environment):
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#!/bin/bash
#
# chkconfig: - 80 20

### BEGIN INIT INFO

# Provides: opencrx

# Required-Start: $local fs Sremote fs $syslog Snetwork
# Required-Stop: $local fs Sremote fs $syslog Snetwork

# Default-Start: 345

# Default-Stop: 0 1 2 6

# Description: opencrx start stop status

# Short-Description: opencrx start stop restart status

### END INIT INFO

## Source function library.
#. /etc/rc.d/init.d/functions
# Source LSB function library.
if [ -r /lib/lsb/init-functions ]; then
/lib/1lsb/init-functions
else
exit 1
fi

DISTRIB_ID="lsb release -i -s 2>/dev/null’

NAME="$ (basename $0)"
unset ISBOOT

if [ "S{NAME:0:1}" = "S" -0 "${NAME:0:1}" = "K" ]; then
NAME="$ {NAME: 3} "
ISBOOT="1"

fi

# For SELinux we need to use 'runuser' not 'su'
f [ -x "/sbin/runuser" ]; then
SU="/sbin/runuser -s /bin/sh"
else
SU="/bin/su -s /bin/sh"
fi

# Get instance specific config file

if [ -r "/etc/sysconfig/${NAME}" ]; then
/etc/sysconfig/$ {NAME }

fi

# Set Tomcat environment.

TOMCAT_USER=crx

export BASEDIR=/home/crx/opencrxServer/apache-tomee-webprofile-1.6.1/
export TOMCATiHOME:$BASEDIR

# Path to the tomcat launch script
TOMCAT SCRIPT="${TOMCAT HOME}/bin/catalina.sh"

# Tomcat program name
TOMCAT PROG="S$ {NAME}"

# Define the tomcat log file
TOMCAT LOG="/home/crx/opencrxServer/apache-tomee-webprofile-1.6.1/logs/catalina.out”

DB_HOST=dbserver.mydomain.com # 10.10.10.30
DB_PORT=5432 # postgreSQL

SHUTDOWN_WAIT=5
RETVAL="0"

function version() {
#$SU - STOMCAT_USER -c "${TOMCATiSCRIPT} version" >> ${TOMCAT_LOG} 2>&l1 || RETVAL="4"
SSU - $TOMCAT_USER -c "S${TOMCAT_ SCRIPT} version"

}

# See how we were called.
function start() {

echo -n "Starting ${TOMCAT PROG}: "

if [ "SRETVAL" != "0" ]; then
log_failure msg
return

fi

if [ -f "/var/lock/subsys/${NAME}" ]; then

if [ -f "/var/run/S${NAME}.pid" ]; then
read kpid < /var/run/${NAME}.pid
# if checkpid S$kpid 2>&l; then

— 169 —



openCRX Admin Guide - Version 2.12.0 Miscellaneous Topics

if [ -d "/proc/${kpid}" ]; then
log_success_msg
if [ "$DISTRIB_ID" = "MandrivaLinux" ]; then
echo
fi
RETVAL="0"
return
fi

fi
fi

# test whether pg running
DB UP="nmap -sT -p$DB PORT $DB HOST|grep open|wc -1°

if [ $SDB UP -ne 1 ]; then
echo "waiting for database to come up..." >> S$STOMCAT LOG
sleep 30
DB_UP="nmap -sT -pSDB_PORT $DB_HOST|grep open|wc -1°

fi

if [ $DB_UP -ne 1 ]; then
echo "waiting for database to come up..." >> $TOMCAT_LOG
sleep 30
DB _UP="nmap -sT -p$SDB_PORT $DB HOST|grep open|wc -1°

fi

if [ $DB UP -ne 1 ]; then
echo "waiting for database to come up..." >> STOMCAT_LOG
sleep 60
DB_UP="nmap -sT -p$DB_PORT $DB HOST|grep open|wc -1°

fi

if [ $DB UP -ne 1 ]; then
echo "database not available at $DB _HOST:$DB_PORT - cannot start openCRX..." > $TOMCAT_LOG
RETVAL="1"
log_failure msg "no database at $DB_HOST:S$DB_PORT"
echo "database not available at S$DB_HOST port $DB_PORT - cannot start openCRX..."|/bin/mail -s "openCRX

not started / database error" root
else

cd STOMCAT_ HOME

rm -Rf temp

mkdir temp

chown S$TOMCAT USER:S$TOMCAT USER temp
rm -Rf work

# fix permissions on the log and pid files
export CATALINA PID="/var/run/${NAME}.pid"

touch $CATALINA_PID 2>&1 || RETVAL="4"
if [ "$RETVAL" -eq "O0" -a "$?" -eq "O" ]; then
chown ${TOMCAT USER}:${TOMCAT USER} S$CATALINA PID
fi
[ "SRETVAL" -eq "O" ] && touch $TOMCAT LOG 2>&l || RETVAL="4"
if [ "SRETVAL" -eq "O0" -a "$?" -eq "O" ]; then
chown ${TOMCAT USER}:${TOMCAT USER} $TOMCAT LOG
fi
echo " " >> $TOMCAT_LOG
@ChO M/ F o m +" >> S$STOMCAT LOG
echo "| database running at $DB _HOST:$DB PORT" >> $TOMCAT LOG
echo "| starting openCRX..." >> STOMCAT_ LOG
BENE W\ ¥ o e e e e e e e e e e e e e e D S DS S Dmm +" >> STOMCAT LOG
echo " " >> $TOMCAT7LOG

mount /home/crx/pebble
mount /home/crx/music
mount /var/supersonic

$SU -p -s /bin/sh $TOMCAT_USER -c "S${TOMCAT_SCRIPT} start" > /dev/null || RETVAL="4"
if [ "SRETVAL" -eq "O" ]; then

log_success_msg

touch /var/lock/subsys/${NAME}
else

log_failure msg "Error code ${RETVAL}"

fi
fi
}
function stop() {
echo -n "Stopping ${TOMCAT PROG}: "
if [ -f "/var/lock/subsys/${NAME}" ]; then
touch /var/lock/subsys/${NAME} 2>&l || RETVAL="4"
[ "SRETVAL" -eq "0" ] && $SU - $TOMCAT USER -c "${TOMCAT SCRIPT} stop" >> ${TOMCAT LOG} 2>&l || RETVAL="4"
count="0"
if [ -f "/var/run/S${NAME}.pid" ]; then

read kpid < /var/run/${NAME}.pid
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until [ "$(ps --pid S$kpid grep -c Skpid)" -eq "0" ] || \
[ "$count" -gt "$SHUTDOWN_WAIT" ]; do
if [ "$SHUTDOWN7VERBOSE" = "true" ]; then
echo "waiting for processes $kpid to exit"
fi
sleep 1
let count="${count}+1"
done
if [ "Scount" -gt "S$SSHUTDOWN WAIT" ]; then
if [ "$SHUTDOWN_VERBOSE" = "true" ]; then
log _warning msg "killing processes which did not stop after ${SHUTDOWN WAIT} seconds"
fi
kill -9 S$kpid
fi
log_success_msg
fi
rm -f /var/lock/subsys/S${NAME} /var/run/S${NAME}.pid
else
log failure msg
RETVAL="4"
fi
umount /home/crx/pebble
umount /home/crx/music
umount /var/supersonic
}
function status()
{
checkpidfile
if [ "SRETVAL" -eq "O" ]; then
log success msg "${NAME} (pid ${kpid}) is running..."
elif [ "S$RETVAL" -eq "1" ]; then
log_failure msg "PID file exists, but process is not running"
else
checklockfile
if [ "SRETVAL" -eq "2" ]; then
log failure msg "S${NAME} lockfile exists but process is not running"
else
pid="$ (/usr/bin/pgrep -d , -u ${TOMCAT USER} -G ${TOMCAT USER} java)"
if [ -z "$pid" 1; then
log_success_msg "S{NAME} is stopped"
RETVAL="3"
else
log_success_msg "${NAME} (pid $pid) is running..."
RETVAL="0"
fi
fi
fi
}
function checklockfile ()
{
if [ -f /var/lock/subsys/${NAME} ]; then

pid="$ (/usr/bin/pgrep -d , -u ${TOMCAT USER} -G ${TOMCAT USER} java)"
# The lockfile exists but the process is not running
if [ -z "S$pid" 1; then
RETVAL="2"
fi
fi
}

function checkpidfile ()
{

if [ -f "/var/run/${NAME}.pid" ]; then
read kpid < /var/run/${NAME}.pid
if [ -d "/proc/${kpid}" ]; then
# The pid file exists and the process is running
RETVAL="0"
else
# The pid file exists but the process is not running
RETVAL="1"
return
fi
fi
# pid file does not exist and program is not running
RETVAL="3"

}

function usage ()

{

echo "Usage: $0 {start|stop|restart|condrestart|try-restart|reload|force-reload|status|version}"
RETVAL="2"

— 171 —



openCRX Admin Guide - Version 2.12.0

Miscellaneous Topics

# See how we were called.
RETVAL="0"
case "S$1" in
start)
start
stop)
stop
i
restart)
stop
start

condrestart|try-restart)

if [ -f "/var/run/${NAME}.pid"
stop
start
fi
reload)
RETVAL="3"

force-reload)
if [ -f "/var/run/S${NAME}.pid"
stop
start
fi
status)
status
version)
version
# ${TOMCAT_SCRIPT} version

i

exit SRETVAL

1; then

1; then

« make the file executable

e try to start the service with
service opencrx start

Service Configuration

Program Service Help

Disable

Name
SES
@ &| portreserve
@ =4 postfix
@ &| psacct
® &| quota_nid

[P [x] e @l

Customize Stop Restart Help

Remarks [~] The opencrx service is started once, usually when the system
is booted, runs in the background and wakes up when needed.

) This service is enabled.
4| This service is running.
Description

Port reservation utility
start and stop postfix
Starts and stops process at

. . opencrx start stop status
Disk guota netlink messag p p

you may want to add logrotation: create a new text file opencrx in the
directory /etc/logrotate.d/ with the following content (adapt paths to

your environment):

/home/crx/opencrxServer/apache-tomee-webprofile-1.0.0/logs/*1log
/home/crx/opencrxServer/apache-tomee-webprofile-1.0.0/logs/*out {

daily

rotate 14
compress
delaycompress
copytruncate
ifempty
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19 Next Steps

You might want to have a look at some of the additional documentation
published at http://www.opencrx.org/documents.htm.
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